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1 Introduction

PracticeBuilder 1-2-3™ is an picture archive and communication system (PACS) and teleradiology system
used to receive DICOM images, scheduling information and text reports, organize and store them in an
internal format, and make that information available across a network via web and customized user
interfaces. PracticeBuilder 1-2-3 is for hospitals, imaging centers, radiologist reading practices and any
user who requires and is granted access to patient image, demographic and report information.
PracticeBuilder 1-2-3 provides information management and distribution services. The system is
comprised of acquisition components, a central system manager component, diagnostic and review
workstation components and an archiving component.

The sections that follow provide instructions on installing, configuring and using the PracticeBuilder 1-2-3
Viewer. Operator instructions for all versions of the viewing application are contained in this document.

1.1 General Safety Information
PracticeBuilder 1-2-3 system components are not approved for direct patient contact applications.

The PracticeBuilder 1-2-3 PACS system components and associated cables must not be operated in the
presence of moisture.

To avoid excessive product leakage and maintain product compliance to medical protective guidance
requirements, the PACS and workstations power cords shall be connected directly to hardwired AC
receptacles.

Federal law prohibits this device to sale or use by anyone other than a medical professional.
The PracticeBuilder 1-2-3 PACS system components must not be carried by the connecting cables.

Follow all safety labels on the equipment.

1.2 Indications of Use

The PracticeBuilder 1-2-3 PACS system acquires image and patient information from any one of several
types of medical imaging modalities. The PACS’ open software architecture enables hospital network
users to enter, review, archive and print patient demographic and radiographic study information received
from imaging modalities, a hospital information system (HIS) and/or a radiology information system (RIS).
The patient demographics and order information can be routed through the hospital network structures
and sent along with the diagnostic images to remote hosts for viewing and printers for hard copy imaging.
The open system architecture allows for the adoption of changes in technology so that hardware can be
switched while maintaining consistent workflow.

1.3 Patient Contact

The PACS system components are not approved for direct patient contact applications. The user must
follow hospital cleaning and decontamination policies and procedures.

1.4 Product Safety

The PracticeBuilder 1-2-3 PACS system has been classified as an acceptable application of use in
accordance with Medical Device regulations. The use of accessory equipment and/or hardware not
complying with the equivalent product safety and EMC requirements of this product may lead to a
reduced level of safety and/or EMC performance of the resulting system.
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1.5 Contact Information

For more information concerning PracticeBuilder 1-2-3, or to report a problem with this manual or the
software, contact eRAD/ImageMedical technical support.

eRAD/ImageMedical Technical Support

United States/North America
103 S Venture Drive
Greenville, SC 29615-3571
Voice: 1.866.760.2119
FAX: 1.864.234.7412

Europe
Maros u. 12
Budapest H-1122, Hungary
Voice: +36.1.489.4700
FAX: +36.1.489.4709

1.6 Abbreviations
The following abbreviations are used throughout this document.

DICOM...... Digital Imaging Communications in Medicine
EIM........... eRAD/Image Medical Corporation

HL7 ........... Health Level 7

PB123....... PracticeBuilder 1-2-3

1.7 References

The information contained in this manual references information from other sources, including
PracticeBuilder 1-2-3’s online help and other paper documents. Refer to the following sources of
information for additional details on PracticeBuilder 1-2-3 viewer and server components.

e Operator's Manual for PracticeBuilder 1-2-3

e PracticeBuilder 1-2-3 browser’s online help
e PracticeBuilder 1-2-3 viewer’s online help
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2 Getting Started

The PracticeBuilder 1-2-3 Viewer is an application that displays diagnostic quality medical images for
review by radiologists, clinicians and other healthcare personnel. Access to the data generated during an
imaging procedure requires a validated user session. The information in this section provides instructions
for setting up your workstation for PracticeBuilder 1-2-3 and initiating a user session. The instructions
that follow assume you have access to a workstation that satisfies the minimum required configuration.

PracticeBuilder 1-2-3 requires a web-enabled PC running Microsoft Windows 98, NT, 2000 or XP. The
viewing application does not require any additional resource (memory, disk, etc.) than the operating
system on which it runs requires, although performance will be negatively affected if there is limited
memory. The recommended minimum amount of memory for displaying most average-sized image sets
is 256MBs.

The dedicated and active-X viewers require a network connection to the PracticeBuilder 1-2-3 server.
PracticeBuilder 1-2-3 supports Microsoft Internet Explorer version 5.0 and later, and Netscape Navigator
version 5.0 and later.

PracticeBuilder 1-2-3 consists of three unique viewing applications. They are the dedicated viewer, the
active-X viewer and the standalone viewer. The dedicated viewer application is explicitly tied to a
workstation, and restricts access to other applications running on the same machine. The active-X viewer
is a more accommodating viewing application that a user downloads and installs on any compliant
workstation. The active-X workstation executes along side other applications running on the same
workstation. The standalone viewer is design to operate without communicating with a PracticeBuilder 1-
2-3 server. This version of the viewing application is used almost exclusively from a removable CD or
DVD, and displays only the study information contained on the CD/DVD media.

All three viewing applications share the same graphical user interface and offer similar toolsets. With few
exceptions, the instructions for setting up and controlling each of these viewing applications are the same.
When the instructions for one differ from the norm, this manual makes note of the exception and provides
specific details concerning the feature.

2.1 Workstation Setup

Before starting, the workstation must be removed from its shipping package, assembled according to the
manufacturer’s instructions, powered on, and configured to boot up and allow a user to log on.
Furthermore, this manual assumes the workstation has access to the local area network, or the Internet,
whichever is required. If the workstation does not meet these minimum requirements, contact your
system administrator, computer manufacturer or your ISP provider for further assistance preparing your
workstation for PracticeBuilder 1-2-3.

The PracticeBuilder 1-2-3 viewer executes on any supported Microsoft Windows platform. The default
workstation configuration is often suitable. The area that most often requires modification is the monitor
and display controller setting. PracticeBuilder 1-2-3 supports single and multiple monitor configurations,
and a variety of bit depths and resolutions. The instructions in this section describe how to set up
Microsoft Windows monitors to run PracticeBuilder 1-2-3.

The information provided in this section assumes the workstation is running a version of Microsoft
Windows PracticeBuilder 1-2-3 supports. There are differences between Microsoft Windows 98, NT,
2000 and XP that may impact the information contained in this manual. By default, all Windows
operations are shown for Windows 2000.

2.1.1 ADJUSTING MONITOR CONFIGURATION

Before initiating PracticeBuilder 1-2-3, make sure your Microsoft Windows monitor settings are configured
for the best results. Your workstation should be configured for a 32-bit color map, or the highest possible
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color map if 32-bit is not available. For a single landscape monitor, it is best to set the screen resolution
for each monitor to at least 1280 by 1024. Smaller resolutions are supported if necessary.
Display Propertics T d | . .
Backgrournd | Screen Saver | Appesrance | Wb | Effects | Setings | To check or change the resolution on your Windows
computer:

» Open the display settings panel from the desktop by
right clickihng on a blank area and selecting
B Properties. You can also open the display setting
| window from the Windows Control Panel.
> Select the Settings tab.
oS B » Adjust the resolution with the slider bar under Screen
Area. The recommended screen resolution is 1280

Coloes Sereen aea

(ECTET—— ] | |l — | o by 1024 pixels.
| W DO | | vib e > Set the Colors drop down to 32-bit color, or the
TR e T highest possible setting.
» Click Apply, then OK. When prompted to save the
D] | | settings, click OK.

If you are using a display controller with its own setup page, click on Advanced and then select the tab
that corresponds to the display controller. Follow the instructions in the display controller documentation
to set up the monitor.

2.1.2 CONFIGURING MULTIPLE MONITORS

The PracticeBuilder 1-2-3 viewer supports one through four monitors. Each monitor can run at different
resolutions. It is possible to mix color and grayscale monitors as well.

PracticeBuilder 1-2-3 uses the Microsoft Windows display settings to identify the monitors. In the Display
Properties window, when more than one monitor is available, Windows labels them, starting with ‘1° and
continuing up to the maximum number available. Use these numeric labels when configuring monitors in
PracticeBuilder 1-2-3 as described in section 4.1.1.

For multiple monitor configurations, you can set the display settings for a multiple, independent Microsoft
Windows environments on each monitor, or a single Windows environment that spans across all
monitors. If you select the single Windows environment, you will have to configure the PracticeBuilder 1-
2-3 viewer so it knows to split it's user interface properly across the monitors. See section 4.1.1 for
information on configuring monitors in PracticeBuilder 1-2-3.

2.2 Accessing PracticeBuilder 1-2-3 Server

PracticeBuilder 1-2-3 is a web-enabled system that the user accesses with a web browser. As a result,
many of the familiar conventions you find when visiting other web sites are available in PracticeBuilder 1-
2-3. There is the home page, which is usually the first page you encounter when you gain access to the
server. Most of the system’s information is collected in a hierarchy of other pages that you access by
clicking on hyperlinks. You can click on the browser’s Back button to return to the previous page. You
can save a particular page in your Favorites folder. You can even create a link to the PracticeBuilder 1-2-
3 on another web page.

The PracticeBuilder 1-2-3 server is organized by a set of tabs displayed across the top of the browser
window. The specific tabs that are available to you depend on the privileges your system administrator
assigned to your user account. The first row of tabs provides access to the general functional areas.
Examples include Worklist, Administration and Archive. The PracticeBuilder 1-2-3 viewer is available to
the information displayed on the Worklist page.
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2.2.1 INITIATING A BROWSER SESSION

To use the PracticeBuilder 1-2-3 dedicated or active-X viewer, you need a workstation connected to a
network with access to the PracticeBuilder 1-2-3 server, and a supported web browser. Launch the web
browser and enter the URL of the PracticeBuilder 1-2-3 server into the address line. The URL depends

on your facility’s configuration. If it is not R T i

configured as the browsers home | . @ 0 e e e oo s @4

address, ask your system administrator for =l =i d Jue®

the URL. The URL can be a hostname or |pguwg — racticeBuilder.® " y

an IP address. The following examples o BracticeBuilde _{I.l

are all acceptable PracticeBuilder 1-2-3 i

URLs: .,
pacs.eradimagemedical.com PracteaBude o1 : : :
http://pacs.eradimagemedical.com | iwe —— P b’;ﬂﬁﬂ"ﬁfj’.ﬂiﬁer@‘
https://192.168.0.1 - it

Transioeming image management lor heslthcane

When the browser reaches the [

PracticeBuilder 1-2-3 server, it displays the

Main page. Figure 2.2-1 shows : ' Avallable

PracticeBuilder 1-2-3’s default Main page. t 1 - Now

Note that your main page may appear L ' |

different due to customization. %

al L JL ]

Regardless of which URL you entered Figure 2.2-1 PracticeBuilder 1-2-3 Main Page

PracticeBuilder 1-2-3  forces  your

connection to use secure HTTP if the server is configured to provide secure communications to your
workstation. If HTTPS is required, you may be prompted to verify the digital certificate. You can find
instructions on how to accept the digital certificate and save it as a trusted key in your browser in the
PracticeBuilder 1-2-3 Operator’'s Manual.

2.2.2 SIGNING ON FROM THE BROWSER

To sign on to the PracticeBuilder 1-2-3 server, you must possess a unique user account, assigned by
your system administrator. The user account is used to identify you throughout the system. This allows
PracticeBuilder 1-2-3 to download your personal profile from the server, providing you with the same
custom interface regardless of your location. PracticeBuilder 1-2-3 also uses your account information to
tag your actions automatically, so you do not have to explicitly enter your identification information each
time you create, modify or delete data.

All versions of the Main page contain sign on fields on the left side of the page as well as a series of tabs
near the top and running the width of the page. The tabs are used to access different PracticeBuilder 1-
2-3 pages. Before you sign on, the only pages available are the Main page and the Info page.

Enter your User ID and password in the fields on PracticeBuilder 1-2-3’'s Main page.

EZZ;&@_,&:M— Note that both the User ID and password are case sensitive. By default, PracticeBuilder
wo ] 1-2-3 takes you to the Worklist page after it verifies your account information. If you

wish to go to a different page, chose your preferred starting point from the pull-down

l% menu just beneath the account ID and password fields. Click on Sign On, or press the

return key, to continue.

Instruction Summary — Signing On
» Launch Internet Explorer or Netscape Navigator.
» Enter your PracticeBuilder 1-2-3 server URL from your Favorites list, or typing the IP address into
the address textbox.
» Enter your User ID and password. Both are case sensitive.
» Click the Sign On Button.
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2.2.3 SIGNING ON FROM THE VIEWER
It is possible to log out of PracticeBuilder 1-2-3 while a study is displayed in the E

viewer. You can explicitly request to log out from the browser, or the |77
PracticeBuilder 1-2-3 can automatically log you out after a period of inactivity. Psundieaied

If the PracticeBuilder 1-2-3 viewer is open when this happens, a login prompt Hame: 12
appears on your screen. To log into PracticeBuilder 1-2-3, enter the password 2
for the account displayed in the Name field, and click Sign On. Note that both Carcel

the User ID and password are case sensitive.

If you want to change the user account, cancel the popup window, and log on from the browser, or use
the Sign On item in the File menu.

2.3 Installing The PracticeBuilder 1-2-3 Viewer

The different PracticeBuilder 1-2-3 viewer applications have slightly differing installation procedures. The
sections below provide instructions for downloading the viewer initially, and for upgrading to a new
version when one is available.

The dedicated and active-X viewers require specific PracticeBuilder 1-2-3 user privileges. The specific
privileges are defined in the respective section. Be aware that differences exist when downloading the
viewer setup package depending on the browser version or operating system you use. While the wording
or figures may be different than what is printed in this manual, the general procedure is the same.

To install an application on a Windows NT, 2000 or XP workstation, the Windows user account must have
Windows Administrator or Power User privileges. Sometimes it is easier to run the PracticeBuilder 1-2-3
viewer setup program as an administrator while logged on as the current user, rather than logging in as
an admin. For instructions on how to run the setup program as an administrator in Windows 2000 or XP,
see section 2.3.1.

2.3.1 ADMINISTRATOR ASSISTED VIEWER INSTALLATION

On Windows 2000 and XP systems, your Windows user account must have administrator or power user
privileges before you can install the PracticeBuilder 1-2-3 viewer. In most cases, the system
administrator will log into Windows using an account with these privileges to install the viewer.
Sometimes, it is easier to instruct Windows to install PracticeBuilder 1-2-3 viewer with an administrator
account’s privileges using the current account. Windows provides this function with the Run As
command.

To use the Run As command, you need to know the ID and password of an account with administrator
privileges, but you do not have to log out of Windows. Follow these instructions to install PracticeBuilder
1-2-3 using the Run As command.

Step 1. Download the PracticeBuilder 1-2-3 viewer by selecting the Download Viewer tab on
the worklist page, and select to save it to your workstation.

Step 2. Locate the file, pbsetup.exe unless you changed the name when saving it, using
Windows Explorer, the Microsoft Management Console (MMC), or the Control Panel.

Step 3. Press and hold down the SHIFT key as you right-click the file icon, and select Run As
from the popup menu.

Step 4. In the dialog box, select the option Run the program as the following user, and enter
the user name and password of a Windows account that has administrator privileges.

Step 5. Click OK to start the installation process.

The install process proceeds as described in the section detailing the installation procedure for the
specific viewer you are installing or upgrading.
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To download and install the PracticeBuilder 1-2-3 active-X viewer, your user account must possess Open
privileges, which your system administrator can assign to you. If you log into a workstation using an
account that has Open privileges, PracticeBuilder 1-2-3 checks for the viewer and attempts to install it
automatically if it is not found.

After you log on to the PracticeBuilder 1-2-3 server and go to the Worklist page, a popup notice may
appear on the screen. If you do not have Windows administrator rights, the notice simply informs you that
the viewer is unavailable and instructs you to contact the system administrator in order to download and
install a copy onto the workstation. If you have Windows administrator rights, the notice asks if you want
to download and install the latest viewer. When you consent to the upgrade, PracticeBuilder 1-2-3
downloads the viewer and invokes the installation wizard. Depending on your version of Windows, you
have the option to download and store the PracticeBuilder 1-2-3 setup file and activate it manually, or to
download and activate (Open) it when complete. There is no need to save the setup file to disk, so select
to Open the file when the download completes.

In some instances, PracticeBuilder 1-2-3 will initiate the viewer installation process without prompting the
user. This occurs when the workstation is running certain versions of Microsoft Windows and when using
certain versions of Microsoft Internet Explorer. When the download completes, the installation wizard
starts automatically.

To manually download and install a copy of the PracticeBuilder 1-2-3
viewer, click the Download Viewer tab in the second row of tabs under the
Workilist tab. PracticeBuilder 1-2-3 downloads the viewer and invokes the
installation wizard. As in the automatic install, there is no need to save the
setup file to disk, so chose to Open the file when the download completes.

- Admin

Corrections ownload Yiewsr

The PracticeBuilder 1-2-3 installation wizard takes you through the installation process step by step.
Figure 2.3-1 shows the initial screen of the installation wizard. The process is as follows:

Pata s

.fu.s:.-;.."..‘;i;llg PracticeBuilder 1-2-3®

Step 1. The InstallShield® Wizard launches. Read the
information, take any necessary actions and
click Next. Press the Cirl and Esc keys
simultaneously to view the task bar if you need
to quit any other applications. It is not required
to quit Internet Explorer or Netscape Navigator.
Read the License Agreement and click Yes if
you agree to the terms.

If the default location for PracticeBuilder 1-2-3
is acceptable, click Next. Otherwise select a
new location and click Next.

Step 4. Click Finish when the install is completed.

Step 2.

Step 3.

The viewer does not start automatically. Either open a
study or manually start the viewer by selecting it from
the Program Files menu under the Start button in the system tray. When PracticeBuilder 1-2-3 is
executing, it appears as an icon in the taskbar.

Figure 2.3-1 Install Wizard Screen

Instruction Summary — Downloading the Viewer
» Log on and go to the PracticeBuilder 1-2-3 worklist page.
» If you are prompted to download the viewer, click Yes.
Viewer tab.
> If asked to save or open, select Open. When the download completes, select Open to run
the setup program.

Otherwise, click the Download
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» InstallShield© Wizard will take you through the setup. Accept the defaults, click on the Next
button to advance, and click Finish to complete.

» You will return to the Work List. Single-click on a patient name to launch the viewer and
load the images.

2.3.3 INSTALLING DEDICATED VIEWER

The PracticeBuilder 1-2-3 dedicated viewer generally comes preinstalled on a workstation. When you
follow the workstation manufacturer’s instructions for unpacking and setting up the computer, and then
turn on power, you reach the Windows login prompt. Log in as using any user account that is not a
Windows administrator account. The dedicated viewer automatically starts, and prompts you for your
PracticeBuilder 1-2-3 account and password. For instructions on how to log onto the dedicated viewer
workstation, refer to section 2.2.3.

When you see the PracticeBuilder 1-2-3 login prompt, the software is ready for configuration. To
complete the configuration, you need to register the workstation at the PracticeBuilder 1-2-3 server, and
enter the URL of the server into the dedicated viewer. To register the workstation, it must be added to the
PracticeBuilder 1-2-3 table of devices. This table is available through the browser interface. For
instructions on adding the dedicated viewer workstation to the devices table, see the PracticeBuilder 1-2-
3 Operator’'s Manual.

—— When you start the PracticeBuilder 1-2-3 dedicated viewer for the first time, it

e pes prompts you for the URL of the PracticeBuilder 1-2-3 server. Enter the URL or

__________ el the server’s IP address into the Server field. Click on Check Server to verify

e o you entered the correct address, and the workstation can communicate with the

st 77T server. When you receive confirmation that the server was found, the

. . ? PracticeBuilder 1-2-3 dedicated workstation is ready for use. Click OK to save
the configuration.

2.3.4 INSTALLING STANDALONE VIEWER

The PracticeBuilder 1-2-3 standalone viewer is used most frequently to display images stored on a CD or
DVD. You can create a CD/DVD containing images and results stored in PracticeBuilder 1-2-3, and an
application to display them, a number of ways. To guarantee the viewer installed on a CD/DVD is the
PracticeBuilder 1-2-3 standalone viewer, follow the instructions in the PracticeBuilder 1-2-3 Operator’s
Manual for creating removable media. The information in this section assumes the CD/DVD was created
according to the instructions in that manual.

The PracticeBuilder 1-2-3 standalone viewer never gets installed on the workstation. Instead, it loads
directly from the CD/DVD. Insert the CD/DVD into the drive on your workstation and close the draw. If
you have the Windows auto play feature enabled, the standalone viewer automatically launches itself and
runs from the CD/DVD. If you prevent auto play from launching the standalone viewer, it does not start
automatically, or you need to start the standalone viewer manually for any reason, go to the Start menu,
select Run..., and browse through the CD/DVD for the file named pbcdview.exe. Click OK to start the
PracticeBuilder 1-2-3 standalone viewer.

The standalone viewer executes until you explicitly terminate it. If a copy of the PracticeBuilder 1-2-3
active-X or dedicated viewer resides on the same workstation, the PracticeBuilder 1-2-3 standalone
viewer does not affect it. In order for the standalone viewer to execute properly, the CD/DVD must
remain in the drive at all times.

Note: Removing the CD/DVD from the drive when running the PracticeBuilder 1-2-3 standalone viewer may
cause the application to lock up. While the application is loaded, the CD/DVD must remain in the drive at all
times.
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2.3.5 UPDATING THE VIEWER

Upgrades to PracticeBuilder 1-2-3 take place on the server. The workstation learns that an upgrade
occurred the next time a user uses it to communicate with the server. This communication takes place
when you log on to PracticeBuilder 1-2-3, or even in the middle of an existing user session.

The first time you refresh your worklist after a PracticeBuilder 1-2-3
upgrade, a popup notice may appear on the screen. If you do not A o o

have Windows administrator rights, the notice informs you that a new \‘z) :ﬁ“gﬁnp{;”‘m'iefp”ﬂﬂﬁja?: il
version of the viewer is available and instructs you to contact the
system administrator in order to download and install a copy onto the
workstation. If you have Windows administrator rights, the notice i Mo ]
asks if you want to download and install the latest viewer. The option
to skip an upgrade is available so you can download and install it
when convenient. You should always perform the upgrade as soon as possible. If you clear the notice
without installing the viewer, PracticeBuilder 1-2-3 will prompt you once each day until you do upgrade.

PracticeBuilder

Lpdate ta 4.0 (Bulld 02.3)7

When you consent to the upgrade, PracticeBuilder 1-2-3 downloads the viewer and invokes the
installation wizard. Depending on your version of Windows, you have the option to download and store
the PracticeBuilder 1-2-3 setup file and activate it manually, or to download and activate (Open) it when
complete. Select to Open the file when the download completes.

Upon occasion, a PracticeBuilder 1-2-3 viewer upgrade is mandatory in order for it to communicate with
the upgraded server. When this condition exists, the prompt to upgrade is not displayed. The download
and install process initiates immediately when you access the worklist the first time after the server has
been upgraded.
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3 Viewer Overview

All versions of the PracticeBuilder 1-2-3 viewer contain the same basic components. They consist of the
main screen workspace, which contains the area for displaying images, the menu bar, the docked
toolbars, the thumbnail panel and the status bar. Figure 3-1 illustrates the basic parts of the
PracticeBuilder 1-2-3 viewer.

Main screen menus

P4 ImageMedical PracticeBuilder 1-2-3

Toolbars
Main viewing
workspace

Thumbnail

Panel

Ready iz
Fiaure 3-1 PracticeBuilder 1-2-3 Viewer Overview
Status Bar

The sections in this chapter provide information on the many components and constructs that make up
the PracticeBuilder 1-2-3 viewer.

3.1 Toolbars

There is an assortment of toolbars in PracticeBuilder 1-2-3 viewer. Most of the toolbars are available
from the main viewer workspace. A few are specific to one or more popup windows that you can display
at various time when using the viewer. The toolbars are defined as follows:

Standard Basic study and file control tools
Toolbox Cursor modes and general viewer control tools
Orientation Image orientation tools
Window/Level Window width and center controls
Annotation Annotation modes

Grid layouts General grid layouts

Tile layouts Tile modes for each frame in a grid
Templates Hanging protocol template controls
Cine controls Cine display controls

Link controls Frame linking controls

Audio controls Audio controls for dictation tools
Status bar Dynamic status information
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From the View menu, select the Toolbars item to display a list of available toolbars. If a check appears
next to the label, the toolbar is displayed in the main workspace. The toolbar is either docked to the
workspace’s border, or floating as a detached window somewhere on the monitor. Display toolbars on a
more permanent basis by selecting them in the Settings panel in the Customize Settings window. (See
section 4.1.1 for more information.) To hide a toolbar, select the item from the Toolbar item in the View
menu to remove the check mark, or uncheck the setting on the Settings panel in the Customize Settings
window.

Some toolbars are also available in different PracticeBuilder 1-2-3 viewer panels. To display a toolbar in
the respective panel, select the toolbar from the View menu item in the panel. For more information, refer
to the section in the manual that discusses the specific panel.

To relocate a toolbar in the PracticeBuilder 1-2-3 viewer's main workspace, click the surrounding gray
area and drag the toolbar to the desired location. To dock a toolbar to the workspace border, click and
drag it back to any location outside the main image area. The toolbar snaps back into place.

Instruction Summary — Show/Hide Toolbars
To show/hide a toolbar for this session only:
» From the View menu, click on Toolbars, and select the toolbar you want to display. A
checkmark appears by the name when the toolbar is displayed on your screen.

To show/hide a toolbar for this and future sessions:
» Select Customize Settings from the Settings menu.
» Click the Settings tab to view the setting panel.
» In the Toolbars section, click the checkbox to insert a check mark for the toolbar(s) you
want to display.
» To hide a toolbar, click the checkbox to clear the check mark for the toolbar(s) you want
to hide.

3.1.1 STANDARD TOOLBAR

The Standard toolbar provides tools for opening and closing studies. It contains buttons to
| display a list of studies available for display, close a study, open the next and previous
studies, bookmark the current study, and restore a bookmarked study. By default, the
Eﬂ EE Standard toolbar is not displayed on the main screen. To display the Standard toolbar,
select Standard from the Toolbar item in the View menu at the top of the main screen. All
Eﬂ the functions controlled by the buttons on the Standard toolbar are also available from the
File menu, and in some cases via hot key sequences.

Function Button Menu ltem Hot Key Description

Show study list View->Study Panel’ F2! Display the list of available studies. In the
active-X viewer, this function displays the
browser’s worklist. In the dedicated and
standalone viewers, this function displays
the Study List.

Close study % File>Close study Close all the studies that are currently
loaded in the viewer.

Bookmark study E File>Bookmark Ctrl-Alt-B Save the display state of the current study

| or studies, and allow the user to open a new

study. Refer to section 5.1.4 for more
information. All works in progress, including
report, dictation, key images, and
annotations are preserved. Bookmarking is
recursive, using a last-in, first-out order.

Restore book- File>Restore Ctrl-Alt-R Close the current study and restore the last
marked study : bookmarked study.
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Function Button Menu Iltem Hot Key Description
Open next study EE File>Open next study Ctrl-Alt-Up Open_ the next study on the user’s default
worklist.
Open previous T=m| File>Open previous study Ctrl-Alt-Down Open the previous study on the user’s
study Eﬁ defaults worklist.

" The Show Study List appears as an independent panel in the PracticeBuilder 1-2-3 dedicated workstation and standalone
workstations only.

3.1.2 TooLBOX TOOLBAR

The Toolbox toolbar provides tools .
for setting the PracticeBuilder 1-2- || Ik @ 0|z~ ta]3¢|=)| PiF:a P——— FH o @| £|
3 viewer’s cursor mode, adjusting

the image magnification ratio, resetting the display characteristics of an image frame, and displaying the
report panel. The various buttons are grouped into two main groupings, the cursor modes and the display
characteristics. To display the Toolbox toolbar, select Toolbox from the Toolbar item in the View menu at
the top of the main screen. The functions available in the Toolbox toolbar are also available from the
Settings and Tools menus, and in some cases via hot key sequences.

+| #]e 0

Function Button Menu ltem Hot Key Description
Normal mode % | Settings>Cursor>Normal  Ctrl-N This is the general cursor mode, used to select an
image or object within the display. Refer to

section 3.9.1.1 for more information.

Magnify mode Q Settings>Cursor>Magnify  Ctrl-M Magnify the image. Left-click to apply an

automatic zoom factor. Right-click to define a
zoom region. Refer to section 3.9.1.2 for more
information.

Key image Settings>Cursor->Report Attach the selected image along with its current
mode attachment display settings and annotations to the report.
Refer to section 3.9.1.3 for more information.

Link mode Settings>Cursor->Cine link Link one or more image frames together. Double-
click the Link mode button to automatically link all
related frames. Single-click the Link mode button,
and then click and drag the cursor between two
frames to manually link the data. Refer to section

3.9.1.4 for more information.

|12

ROl with W/L
mode

Settings>Cursor->ROlI with Define a region of interest and apply the

WIL calculated window/level curve within it to the
image(s) in the frame. Click and drag the mouse
to define the region of interest. Drag the region
around to position it. Refer to section 3.9.1.5 for
more information.

ra

Settings>Cursor->Cropping Remove extraneous information from the viewable
image in the frame. Click and drag the mouse to
define the area to keep. Resize the area by
dragging the region’s borders. Double-click on the
image to restore the original image. Refer to
section 3.9.1.6 for more information.

Crop mode

Is§

Settings>Cursor->Magic X Locate a defined point in one image on all other
images that share the same frame of reference.
Refer to section 3.9.1.7 for more information.

Magic X mode

|

Magic glass View->Magic Glass Alt-M Display a floating magnifying glass for zooming in
mode on the image data behind it. Refer to section
3.9.1.8 for more information.

]

I

Zoom gauge oy Quickly zoom in and out of the selected image by
B dragging the gauge. The magnification factors is
‘l" 8:1,4:1,2:1,1:1,1:2, 1:4 and 1:8.
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Function Button Menu Iltem Hot Key Description

Fit image to k. A Tools>Zoom->Fit to window Ctrl-F Fit the selected image to the size of the frame.

window kR This is also useful to reset the image size after

using magnification and cropping tools.

Actual image El_ﬂ Tools>Zoom->Actual size  Ctrl-Alt-A
size )

Display the selected image at its real-world size.
When active, the zoom mode renders the images
in real-world size. When inactive, the zoom mode
will render the images in pixel size, matching an
image pixel to a monitor pixel. Refer to section
5.5.3.3 for more information. For actual size zoom
mode to work, both the monitor and the image
need to be calibrated. When you first enable
actual size zoom mode, you are automatically
prompted to confirm the monitor calibration. If the
selected image does not already contain pixel size
and spacing information, you are also
automatically prompted to define it.

Reset image ¥| Tools>Reset->Image size Display the selected image with no magnification

size O or interpolation of any kind applied. The resulting
image contains only original pixel values.

Reset image « | Tools>Reset>Image Reset the image(s) in the selected frame to the

position + position original position, which usually means centered in
the image frame.

Reset image « Tools>Reset>Image Reset the image(s) in the selected frame to the

orientation i_ orientation original orientation.

Reset image .. X| Tools>Reset->Window/Lev Reset the images(s) in the selected frame to their

window/level b el original window and level setting.

Invert |:|+|| Tools—>Invert Invert the slope of the applied window/level curve.

grayscale

Color/grayscal Tools—>Grayscale Toggle the applied palette between color and

e palette grayscale.

Open report ' View->Report Panel F8 Display the full size report panel. Note that the

panel = hot key displays the last report panel (full or

compact) used. Refer to section 3.6.3 for more
information.

3.1.3 ORIENTATION TOOLBAR

The Orientation toolbar provides tools for flipping and rotating images. To display the Toolbox
dL| =| toolbar, select Orientation Tools from the Toolbar item in the View menu at the top of the main
S .| Screen. The functions available in the Orientation toolbar are also available from the Tools
<k|d|| menus, and via hot key sequences.

Function Button Menu Iltem Hot Key Description

Flip horizontal i\ Tools>Transform->Flip horizontally Ctrl-H Flip image(s) in selected frame horizontally.

Flip vertical il Tools—>Transform->Flip vertically Ctrl-U Flip image(s) in selected frame vertically
-

Rotate right & Tools—>Transform->Rotate right Ctrl-R Rotate image(s) in selected frame to the
bk right 90°.

Rotate left ‘h Tools—> Transform->Rotate left Ctrl-L Rotate image(s) in selected frame to the
st left 90°.

3.1.4 WINDOW/LEVEL TOOLBAR
The Window/Level toolbar

provides tools for adjusting ‘Wi”d°W| 214 —J— Level [ 107 -—J— [+ nital v]  Save |

an image’s window center

Page 14



PracticeBuilder 1-2-3
Viewer Operator’'s Manual

—

erng

ImageMedical

and window width. The toolbar consists of text boxes for reporting the current window/level settings and
explicitly defining them, sliders for quickly adjusting them, and a text box for creating and applying preset
window/level settings. To display the Window/Level toolbar, select Window/Level from the Toolbar item in
the View menu at the top of the main screen. Adjusting the window and level setting is also available
through mouse controls.

The left slider bar controls the window width. The right slider bar controls the window center. The drop-
down menu allows for selection of predefined window/level settings. Some defauls always exist,
including Initial, and Actual Range. The others were created by the user. See section 4.3.1 for
information on creating and applying preset window and level values.

3.1.5 ANNOTATION TOOLBAR

The Annotation toolbar provides tools for adding graphics
and measurements to images. You can add annotated text ﬂ '--'-ul ,é_lﬂialﬁjl CJl ‘:'\,.l T | 123' i |
to a key images attached to a report, identify a specific

region of interest (ROI), and calculate the average Hounsfield unit within a region of interest. In addition,
you can draw pointers to a specific viewing area within an image, and use the measuring tools for
determining the distance and angle between two points on an image. To display the Annotations toolbar,
select Annotation Tools from the Toolbar item in the View menu at the top of the main screen. The
functions available in the Annotation toolbar are also available from the Settings menus, and via mouse
controls.

Function Button Menu ltem Description

Annotation ﬁ Settings>Cursor>Annotation> General annotation mode, used for adding new

mode ¥ | Select annotation, and for selecting existing ones for editing and
deleting. When in this cursor mode, spin the middle
mouse button to flip through the individual annotation
tools. Refer to section 6.2 for more information.

Distance vl Settings>Cursor>Annotation>  Perform linear measurements. The image must be

measurement __ | Measure distance calibrated in order for the results to appear in units of
distance.

Angle i:. Settings>Cursor>Annotation> Perform angular measurements.

measurement Measure angle

Hounsfield Settings>Cursor>Annotation> Calculates and displays the average pixel value within the

value & Hounsfield value defined area.

Region of P Settings>Cursor>Annotation> Calculates the area within the defined region of interest.

interest area — 1 Region of interest The image must be calibrated in order for the results to
appear in units of area.

Free form '::J Settings>Cursor->Annotation> Calculates the area within the defined region of interest.

region of _ -1 Freehand region The image must be calibrated in order for the results to

interest area appear in units of area.

Add pointer C\, Settings>Cursor>Annotation=> Add a point graphic and an optional text string to the

Pointer image.
Add text T Settings>Cursor->Annotation> Define a text string and place it on the image.
Text

Key image 1% Settings>Cursor>Annotation> Display a sequential number on the key image. This

index number _ =1 Report figure number annotation tool is available only when applied to a key
image in the report panel.

Spine labeling I Settings>Cursor>Annotation> Display labels identifying vertebral disks and interspaces.

tool g Spine labeling tool

3.1.6 GRID LAYOUT TOOLBAR

The Grid Layout toolbar provides preset matrices for
the main viewing workspace. This toolbar is
available by default in the layout manager, and can
be displayed in the main viewing area as well. The maijority of the preset matrix options split the screen

O|m|e2|B| | | | | || e
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into symmetrical groups of image frames. The custom grid button, @ pops up a window so you can
define a custom grid by specifying the number of rows and columns you want to appear in the workspace
area. The button is used to apply a single grid layout across multiple monitors. For example, is you
use a 1-up grid layout with a 12-up tile layout, you get 12 images displayed on the current screen, similar
to a sheet of film displaying CT images. If you want the 12-up to continue onto a second monitor, select
the span multiple monitor button, and the second monitor displays the second set of 12 images.

To display the Grid Layout toolbar, select Grid layouts from the Toolbar item in the View menu at the top
of the main screen. In the layout manager, select Grid layouts from the View menu.

3.1.7 TILE LAYOUT TOOLBAR

The Tile Layout toolbar applies a specified tile layout to a selected frame. This toolbar is
B M| available by default in the layout manager, and can be displayed in the main viewing area as
m|mm| well. When the tile mode is 1-up, the image frame displays the images in stack mode, which
facilitates the cine operations. When the tile mode is anything other than 1-up, the specified
number of images appears in the frame. When you scroll through the images, one image is
removed from the displayed set, the remaining images shift up or down, and one image is
added. The custom tile button, B, allows you to define a custom tile setting by specifying the
number of rows and columns you want to appear in the workspace.

To display the Tile Layout toolbar, select Tile layouts from the Toolbar item in the View menu at the top of
the main screen. In the layout manager, select Tile layouts from the View menu.

3.1.8 TEMPLATE TOOLBAR

The Template toolbar contains a list of available hanging :

protocol templates, and allows you to create a label for the ||MH Lumnbar Spine j Save |
current layout. This toolbar is available by default in the

layout manager, and can be displayed in the main viewing area as well. To apply a template to the
loaded study, click on the toolbar to display a list of templates. Select the template. To save the current
layout as a template, click in the text box, enter the label, and click Save. To display the Template
toolbar, select on Templates from the Toolbar item in the View menu at the top of the main screen. In the
layout manager, select Templates from the View menu.

3.1.9 CINE CONTROL TOOLBAR

The Cine toolbar provides controls for automatic playback of a cine | Soesd

loop. This toolbar consists of a Play/Stop button, speed controls || Fla¥ | ==| =P=®

and a loop direction control. To display the Cine toolbar, select

Cine control from the Toolbar item in the View menu at the top of the main screen. The Cine toolbar is
also available from the Cine menu, along with menu items for the functions found on the toolbar.

3.1.10 LINK CONTROL TOOLBAR

ot o The Link toolbar provides controls for linking one or more image frames together.
PracticeBuilder 1-2-3 will automatically link series in frames that are marked by the modality
F[Sg’f [+ as sharing the same frame of reference. If this information is not encoded in the image
object, you can manually link one or more frames together. Section 5.4 contains information

ﬂll on creating and using links.

PracticeBuilder 1-2-3 supports up to 7 individual link groups. The Link toolbar displays the link group
assigned to the selected frame, the frame number currently displayed, and buttons for advancing through
the stack of images. To display the Link toolbar, select Link controls from the Toolbar item in the View
menu at the top of the main screen. Link controls are also available from the mouse.
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3.1.11 Aubpio CONTROL TOOLBAR

The Audio toolbar provides controls for recording and N T

playing back dictation. The Audio Control toolbar is J .'l 0" Kl j I 2
available on the full report panel. This toolbar '

contains a record button, a play/stop button, and a delete button for removing portions of a recording.
The gauge in the toolbar displays the current location of the recording, and can be used to jump ahead or
rewind it. The text field displays the position in the recording in seconds. To display the Audio Control
toolbar, open the report panel, and select Audio Controls from the View menu.

3.1.12 STATUS BAR

The Status Bar displays dynamic status messages as PracticeBuilder 1-2-3 performs some action. The
status bar is the one toolbar whose location is fixed. If displayed, it appears at the bottom of the screen.
The Status Bar displays the current working state, the loading progress bar, and the coordinates of the
cursor in an image. Section 3.5 explains the information that is available on the Status Bar.

3.2 Menus

The PracticeBuilder 1-2-3 viewer menus at the top of the application window organize all of the functions
and configuration tools. The list includes the File menu, View menu, Settings menu, Tools menu, Cine
menu, Collaboration menu, and the Help menu. Additional menus may exist depending on the plug-in
modules PracticeBuilder 1-2-3 loads when it initializes. Information on these conditional menus is
available in Chapter 0. Other menus exist in the different PracticeBuilder 1-2-3 panels, although many of
them are repeated or subsets from the main application window, included on the panel for convenience.
Using the mouse, left-click on the menu label at the top of the screen to reveal the available options and
submenus.

The PracticeBuilder 1-2-3 viewer menus are available as a popup menu, accessible from anywhere in the
main viewer workspace. To display a popup menu, position the cursor over the main workspace and click
the right mouse button. The popup menu disappears when you click any mouse button. If you are using a
single-button mouse, hold down the Shift key and click the mouse button to display a popup menu.

3.2.1 FIiLE MENU
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PracticeBuilder 1-2-3’s File menu provides access to functions to sign Open previous study Chrl+Alt-+Up
on and off, open and close study files, bookmarking and restoring Open next study Chrl+Alt+Dowin
bookmarked sessions, saving images to files, printing images to R
Microsoft Windows and DICOM-compatible printers, clearing the Close views
PracticeBuilder 1-2-3 viewer cache, connect to collaboration session, Bookmark AR
and terminate the viewer session. Restore Chrl4-Alk4+R
Update plugins
Menu Item For details, see ... )
- = Send image
Open previous/next study Section 5.1.3 Send series
Close SFUdy Sect!on 5.6 Save image ... Ctrl+Shift+I
Close views Section 5.6 Save series .. Chrl+5hift+5
Bookmark/Restore Section 5.1.4 Copy image to clipboard  Chrl4-Shift+C
Update plugins Section 0 Prirt: ... Chrl+P
Send image/series Section 7.1 1 getpbs[e]. phs
Save images/series ... Section 10.1 2 getpbs[2].pbs
Copy image to clipboard Section 10.1 igetpgsg.pgs
Print Section 11 AL
Empty cache Section 4.1.6 Empty cache
Signon ... Section 2.2.3 g i i
Sign off Section 2.2.3 Sign OFF
Connect to collaboration ... Section 9 Cannect to collaboration ... Chri+Alt+C
Exit Section 5.6 Quit Chrl4+-Q
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PracticeBuilder 1-2-3's View menu provides access to the toolbars, individual panels, the panning
magnifying glass, and controls for displaying and hiding different image overlays.

Menu ltem For details, see ...
Taolbars b P v Templates Toolbars Section 3.1
v hindowLevel - :
Magic Glass Albeh » Arrotation ool Magic glass Section 5.5.3
_ Grid lyouts Thumbnail panel Section 3.4
¥ Thumbnai Panel AT e Layout manager Section 3.6.1
BT Fé N Information panel Section 3.6.2
Info Panel F -m o Report panel Section 3.6.3
e 354 Bl Fa v Tile layouts p p : ! -0.
v Off v Toolbox Show/Hide annotations Section 6.2
v Show Annotations F3 Ful Orientation tools Show/Hide image Section 6.1
v Show Image info F10 Compact v Standard toolbar overlays
v Show Crientation Fl1 ¥ Status har Show/Hide orientation Section 6.1
v “how Annotation indices SI&QW/Hide annotation Section 6.2
Show Tick marks Indices - - -
Show/Hide tick marks Section 6.2

3.2.3 SETTINGS M

ENU

PracticeBuilder 1-2-3’s Settings menu provides access to the customized settings window where you can
customize the viewer characteristics, select a cursor mode, calibrate the image and monitor, change the

grid and tile layouts, modify the localizer lines settings, and set series-specific settings.

v Mormal el
Maanifier Chr|+1a
Report attachment
Cine link
ROT with WL
Custornize setkings ... Cropping
iZursar k P  Magic x ot
; elec
Multiple monitar Morikar Annokations P —>
Calibration b Image - Measure distance
atid lavouts ] P Tile across monitors Measure angle
Tile: N v Notie - Hau!wsﬁeld. value
Localizers 4 7 tiles horizontally 0 Region of interest
Series " Z tiles vertically 3 up harizonkalky Frn?ehand region
4 tles 3 up vertically Fointer
Text
6 tiles landscape up '
' ' fup Report Figure Mo,
S & tiles portrait . '
&uto split series o aup Spine labeling kool
. iles
Buko sork series T ] 1Z2up
?es an scfape 16 up
(1:2 tlles portrait U o, it
ustom ... .
v ol selected cell — » ——P> tight
i u
v fuko find lacalizers Join selected cell ¥ P
dowin

Show localizer lines on selected image
Show hash marks on selected image

Show localizer lines on all images Fiz
Hide lacalizer ines on all images Fiz
Show hash marks on all images Alk+F12
Hide hash marks on all images alk+F12
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Menu ltem For details, see ...
Customize Settings Section 4.1
Cursor Section 5.4, 5.5, 6.2, and 8.3
Multiple monitor Section 0
Calibration Section 4.5.1
Grid layouts Section 5.3.1
Tile layouts Section 5.3.2
Localizers Section 6.1
Series Section 5.4.1.1

3.2.4 TooLs MENU

PracticeBuilder 1-2-3’s Tools menu provides access to various tools that control the screen layout and the
manner in which it renders the images. This includes the ability to reset the image characteristics, apply a
zoom factor and an interpolation algorithm, invert the grayscale slope, apply color to the LUT, reorient the
image, and customize the set of images in a series.

v Image size Actual size Chrl-AlE+HA
Image positian Flip horizonkally  Ckrl+H §:1 Chrl+6
Image arientation Flip wertically — Ctrl+U 41 Chrl4
WindowsLevel f 21 Chrl+2
Reset ~ —p Rokate right Chrl4+-R .
Ratate left Chrl+L 1:1 i1
TransFarm g > 1:2 Alt+2
Zoom infout  # L I Alt+4
Interpolation ¥ —P» ) 1:8 Alt+a
P Mearest pixel GirEmkkiam . :
Inverk ™ . . v Fit ko window  CkrlH-F
v Bilinear inkerpolakion Zoom Factar
Greyscale
wWindow | Level Full screem FS
&pply » P Invert
— Greyscale
Seties *—P  Find all localizers

Find series localizer

Splic all series
Split series

Sork all series
Sark series
Inwvert series

Cuk series
Join series forwards
Joim series backiards

Menu Item For details, see ...
Reset Section 5.5
Transform Section 5.5

Zoom Section 5.5
Interpolation Section 4.1.4 and 5.5
Invert Section 5.5
Greyscale Section 5.5

Apply Section 5.5

Series Section 0 and 5.4.1.3
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3.2.5 CINE MENU
The PracticeBuilder 1-2-3 Cine menu provides controls for displaying stack

views. The menu includes controls for cycling through the images in the stack :EE:?_Z

view, which simulates playing a cine loop, controlling the looping mode, altering

the playback speed, and displaying the cine controls as a floating or docked Mezt Frame On

toolbar. Preceding frame Lp
Menu Item For details, see ... v Cyelic mods
Play/Stop cine Section 5.5.1 Reverse mode
Next/Preceding frame Section 5.5.1 Faster speed
Cycle/Reverse mode Section 5.5.1 Slawer speed
Faster/Slower speed Section 5.5.1 _
Link Section 3.9.1 and 5.4.3 L5583
Toolbar Section 3.1.9 Toolbar

3.2.6 COLLABORATION MENU

The PracticeBuilder 1-2-3 collaboration menu enables a user to create a
collaborations session, connect to an established collaboration session, and
disconnect from a collaboration session. Refer to section 9 for complete details
on collaboration sessions.

Connect ... ChrlHalk+C
Disconnect  Chrl+AlE+D

3.2.7 HELP MENU

PracticeBuilder 1-2-3’s Help menu provides access to information about the
PracticeBuilder 1-2-3 viewer. It contains detailed information on the available
features, a summary of the newest features added in the last upgrade
installed on your server, plus details about its version, which is helpful in the fbout PracticeBuider 1-2-3
event you need to contact customer support. For complete details on

PracticeBuilder 1-2-3 Help, refer to section 12.

Cantents
MNews

3.2.8 RuN MENU

The PracticeBuilder 1-2-3 run menu exists on the dedicated workstation only. One of
the features of the dedicated workstation is its ability to restrict access to third-party
Canfigure ... applications. This permits PracticeBuilder 1-2-3 to better allocate system resources,
plus provides the system administrator a means to limit the use of the workstation for
viewing images. The Run menu lists the configured applications that a user can invoke while using the
PracticeBuilder 1-2-3 dedicated workstation. The Configure entry is available for configuring applications.
An application can be invoked manually by selecting it from the menu, or automatically when the viewer
initializes. For additional information on configuring third-party applications in a dedicated workstation,
refer to section 4.5.3.

<Empky =

3.3 Image Viewing Area

The PracticeBuilder 1-2-3 image viewing workspace makes up the majority of the user interface, as
shown in Figure 3-1. This is the area that renders the full fidelity image data, along with applied
annotations, overlays, and other enhancements to the image data set. The main viewing area is the one
area of the PracticeBuilder 1-2-3 viewer that you cannot hide or close.

The user can customize the image viewing workspace. The area can be subdivided into multiple areas
called image frames. On multiple-monitor workstations, it is possible to define one image frame that
spans across all the monitors. Each image frame can display the images in a number of tile modes. The
default tile mode is 1-up, also called stack mode, meaning only one image appears in the frame. A 4-up
tile mode displays two rows and two columns of images, displaying four successive images loaded into
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the frame. By scrolling through the image frame, the user can display all the full-fidelity images loaded
into the image frame. Section 5.3 contains information on modifying the grid and tile modes.

To load an image into the main viewing workspace, you need to drop a thumbnail image into it. See
section 5.2.1 for details on loading images from the thumbnail panel and the layout manager.

3.4 Thumbnail Panel

The PracticeBuilder 1-2-3 viewer includes a panel in the main viewing workspace for displaying the
thumbnail images of each series. When displayed, the thumbnail panel is located on the left border of the
main viewing workspace, as shown in Figure 3-1.

A thumbnail image is a highly sub-sampled rendering of an image in the study, and can be used for quick
identification of the full-resolution image. The thumbnail panel consists of one or more columns of
thumbnail images, which may scroll off the bottom of the panel if too many rows exist. Each thumbnail
image in the thumbnail panel corresponds to a single series in the study. If multiple studies are loaded in
the thumbnail panel, a study identification header, listing the patient name and study date, separates
each study.

To display the thumbnail panel, place the cursor over the leftmost border of the main viewing workspace.
When positioned correctly, the cursor changes to a bi-directional arrow. Click the left mouse button and
drag the border to the right, revealing the thumbnail panel. Size it to your preference and release the
mouse button. You can also show and hide the thumbnail panel by clicking on View menu and selecting
Thumbnail Panel, or by entering Alt-T on the keyboard. Change the thumbnail image size with the
magpnification tool, &, by applying it directly to the thumbnail image, or by setting the default thumbnail
size on the Customize Settings’ Layout page.

Instruction Summary — Show/Hide Thumbnail Panel
» Log on to PracticeBuilder 1-2-3 and open a study in the viewer.
» Position the cursor over the left border of the main viewing workspace, until the cursor
changes to a bi-directional arrow.
» Click and drag the border to the right using the left mouse button.
» To close the panel, click and drag the right border of the thumbnail panel to the left.

Each image in the thumbnail panel displays a blue progress bar along its bottom edge, showing the
status of the image as it downloads from the PracticeBuilder 1-2-3 server. If the image
already resides on the local workstation, the progress bar appears briefly as
PracticeBuilder 1-2-3 reads the data from the hard disk. When the progress bar
disappears, the full image is available for displaying in the Viewer. You can load a
thumbnail into the main viewing workspace before or after the progress bar completes.
PracticeBuilder 1-2-3 displays all the data that has downloaded from the server, and
automatically updates the image when the rest of it data arrives. Note that the
download completion percentage is displayed in the lower right corner of the image frame as part of the
default overlay.

On the upper left edge of the thumbnail image, you will find a multiple-image series indicator. If three
small lines intersect the left edge of the thumbnail image, the series consists of multiple images. If no
such indicator exists, the image is a single image. You can scroll through multiple-image thumbnails the
same way you scroll through images in the main viewing workspace. Each of the individual thumbnail
images in the series has its own progress bar. As you scroll through the series, PracticeBuilder 1-2-3
displays the corresponding progress bar automatically.

The thumbnail image can contain a key image indicator. If the image represented by the thumbnail image
is stored as a key image, the top left corner contains a circle. If no circle exists, there are no key images
based on the image represented by the thumbnail image. To display the key image, open the report
panel.
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The color of the frame surrounding each of the thumbnail images denotes some status. For example, all
the thumbnail images that are loaded into the selected image frame can be highlighted one color, while all
the thumbnail images that are not in the selected image frame could be another. You can also select a
color to indicate that the thumbnail images are not in any image frame, which can be used to point identify
which series you have not viewed. Section 4.1.9 contains additional information on thumbnail frame
colors.

For information on loading images from the thumbnail panel into the main viewing workspace, refer to
section 5.2.1.

The thumbnail panel enables users to identify and access available series without having to open the
layout manager. The images in the thumbnail panel have the same characteristics and functions as
those contained in the layout manager.

3.5 Status Bar

The status bar, located at the bottom of the PracticeBuilder 1-2-3 viewer, displays the current status of an
action. When the viewer is idle, the status bar displays Ready. When the viewer is downloading images
from the PracticeBuilder 1-2-3 server, the status bar displays a blue progress bar. The progress bar
moves across the status bar, indicating the percentage of the study information transmitted. When the
progress bar completes, the thumbnail images are available for viewing. Note that when using image
compression, the images may arrive at your station in waves of increasing fidelity. The individual
progress bars in the thumbnail images indicate the progress of the individual image decompression.

On the far right side of the status bar is a quantitative indication of the download completion. When this
value reports 0%, the transmission has not begun. In some cases, the PracticeBuilder 1-2-3 server may
take some time to collect the selected study from its storage location. Once the data is ready for
download, this field shows the progress.

3.6 Independent Popup Panels

A number of control panels exist in the PracticeBuilder 1-2-3 viewer. These include the layout manager,
the report panel, the object information panel, and the print control panel.

Each of the control panels appears as an independent popup window. You can display or hide them as
needed. Most of them contain a setting to keep the window on top of the other PracticeBuilder 1-2-3
windows, including the main viewing workspace. If you want to keep the window displayed while you
click on buttons and menus outside the window, pull down the first menu in the popup window and select
Keep on Top. If a checkmark appears next to this item, the window will remain in the foreground. Clear
the checkmark to allow the window to move to the background when you select another window on your
workstation.

3.6.1 LAYOUT MANAGER

The PracticeBuilder 1-2-3 layout manager is a popup panel =
for previewing images loaded into the viewer, and organizing N EEEE e e e e

them in the main viewing workspace. The layout manager |———— ..
provides controls to select the monitors to use, the grid to
apply to each monitor, the tile mode of each image frame,
and the images to load into each image frame. After defining
a layout, the layout manager can store the configuration as a
hanging protocol template, which you can apply when loading
a subsequent study, making it unnecessary to define the
configuration again.
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The layout manager window has three sections. The top part of the window contains the menus and
toolbars. These are the same toolbars available in the main viewer, as described in section 3.1. The
menus are similar to those in the main viewer as described in section 3.2, although some reorganization
has been applied.

The center section of the layout manager contains an emulated display. These emulated monitors look
and behave like the main viewer screens, but appear in the layout manager for simplicity. There is one
emulated monitor for each real monitor. You have almost all the functionality present in the main Viewer
as you do in each of the emulated monitors, including window and level, scrolling and resizing.

The bottom section of the Layout Manager contains all the images as stacked thumbnails. This section
has the same functionality as the thumbnail panel, as described in section 3.4.

When you load a study into the PracticeBuilder 1-2-3 viewer, the layout manager automatically appears
unless you explicitly instructed the viewer not to do so, or PracticeBuilder 1-2-3 automatically applied a
hanging protocol. To manually display the layout manager, select Layout Manager from the View menu,
or press the F6 function key. You can close the layout manager by clicking the Close button in the top
right corner of the window, pressing the F6 function key, or, if the Keep on Top setting in the Layout
Manager menu is unchecked, clicking outside the layout manager window.

For information on loading the images from the layout manager, see section 5.2.2.

3.6.2 INFORMATION PANEL

The PracticeBuilder 1-2-3 information panel contains a dump of all the attributes in each of the images
loaded in the viewer. The information panel is primarily used for support and debug purposes, although
the information is available to users as well. There may be times when you need to investigate the image
object’s technical data. Perhaps you need to find the field used to store a particular data value you want
to display in the overlay information. You can also use the information panel to see how some numeric

data changes from one image to the next, without having to make changes to the overlay configuration.
it wevarmro,oemannar =

ks Pl

e 7 To display the information panel, select an image currently loaded
= into the main viewing workspace, and press the F7 function key, or

S o select Info Panel from the View menu. The information panel is a
Bt S ST 1 s text dump of the object’s attribute list, sorted alphabetically.
e ol Private attributes inserted by the device that created the object
B that PracticeBuilder 1-2-3 does not interpret appear with a DICOM
" tag rather than an attribute label. To locate a particular field in the
information panel, use the scroll bar on the right to move through
= _ the data. To hide the information panel, press the F7 function key
O T ———m—m—"—n"" again, or, if the Keep on Top setting in the Info Panel menu is
T unchecked, clicking outside the layout manager window.

ImaseOricntationPatient; 110%3.251781 31 72,381 5.46e-1 BULIATI1 4480 0,07 X238157 =

3.6.3 REPORT PANEL

The PracticeBuilder 1-2-3 report panel displays reports associated =
with prior studies opened in the viewer, as well as records reports for [ e | s
the new studies. The report panel includes the text of the main
report, the text of the addendums to the report, the original dictations,
if available, and the key images.

To open the report panel, click the report button, " in the toolbox : o
toolbar, press the F8 function key, or select Report Panel from the
View menu. By default, the report panel appears in the Full view
mode. You can display the smaller version by selecting to display the | P
report panel in Compact mode.
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The full view report panel contains the most complete report information and access to the complete set
of reporting functions. In the full view report panel, the user can record and edit a voice dictation, type
and edit report and addenda text, review the patient demographic information, obtain information on who
created the original reports and addenda, update the study state, and perform some simple management
functions such as submitting the report manually to the server, clearing all the changes and starting over.
The full view report panel also provides access to the study’s key images.

The compact view report panel is a smaller version of the report panel, consisting primarily of the most

common tools needed to dictate and submit a report. Reduce the full view report panel by clicking on the

Compact button on the full view report panel. By compacting the report

, , panel, you can view and manipulate images while dictating the report. For

o] }——T7 even less obstruction, you can dock the compact view report panel as a

[Urviswed =] vt | i | PracticeBuilder 1-2-3 viewer toolbar. To dock the company view report
panel, drag it to the outside of the main viewing workspace and release it.

3.6.4 PRINT PANEL

The PracticeBuilder 1-2-3 print panel is a staging area used to collect images and format sheets of film for
printing. The print panel provides tools for selecting and organizing the images, specifying the film sheet
layout, and selecting a Windows-based or DICOM compatible printer along with its respective print
parameters. The images in the print panel have most of the functional characteristics of images in the
thumbnail panel and main viewing workspace, allowing you to enhance the display characteristics, such
as change the window or level and adjust an annotation, prior to submitting the print job to the printer.

To open the print panel, select Print... from the File menu. EEEEEES——————————————— 4

@ Windows ¢ Dicom Diopimage: © Single  Series © Study  Prompt

By default, no images are loaded, unless you have already ... [ronsorrz =] S| o B 1)
selected one of the series in the main viewing workspace. o o T2 el = o
The process is to load the selected images into the print :

panel from either the thumbnail panel or the main viewing | g% @\ & {l\
workspace, adjust them as necessary, select the print ' ey | Ya
parameters, which differ depending on whether you are
printing to a DICOM or Window printer, and then submitting
the print job. The print panel remains displayed until you
submit the print job. Close the print panel without
submitting the print job by clicking on Cancel or the close
button on the top right corner of the window.

|»

Refer to section 11 for detailed instructions on how to build
a film sheet and submit a print job.

3.7 Plug-in Modules

PracticeBuilder 1-2-3 supports independently licensed plug-in modules that offer a suite of functions not
available in the baseline viewer. An example of a plug-in module is multiplanar reconstruction. When
you install a PracticeBuilder 1-2-3 viewer on your workstation, it queries the server for a list of licensed
plug-ins. If the viewer determines you are licensed to use a plug-in, it prompts you to download and
install it. If a newer version of the plug-in exists on the server, the PracticeBuilder 1-2-3 viewer prompts
you to download and install it as well. To see a list of available plug-ins, select Update plug-ins from the
File menu. Once installed, the plug-in automatically initializes itself and makes its functions available.

You can find a complete list of PracticeBuilder 1-2-3 viewer plug-ins in section 0. Refer to the relevant
subsection for specific details on how to use the features in the plug-in.
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3.8 Display Modes

Normally, the PracticeBuilder 1-2-3 viewer shows the default display mode, consisting primarily of the
main viewing workspace. Additional display modes exist. These display modes offer an alternative view
of the data, usually for a specific, short-term purpose.

3.8.1 FuLL ScREEN MODE

PracticeBuilder 1-2-3 offers a full screen display mode that eliminates all extraneous information from the
monitor and uses all the space for displaying the image. When active, the menus and toolbars disappear
from the screen, but all mouse controls remain available and you can apply them to the image.

Full screen display mode applies to an image frame. First load the image or series into an image frame,
and apply a tile mode if necessary. To active full screen mode, select the image frame and press F5. To
return to the normal display mode, press F5 again, or hit the Esc button.

3.8.2 CALIBRATION MODE

One of PracticeBuilder 1-2-3 viewer's zoom modes supports rendering the image using a real-world
scale. To support this zoom mode, both the image and the monitor must contain calibration information.
If either is not calibrated, the PracticeBuilder 1-2-3 viewer notifies you and invokes a wizard to collect the
requisite information. You can also run this wizard manually. The calibration wizard uses two display
modes, each different from the default display mode. The monitor calibration display mode consists of a
set of rulers you adjust to indicate the actual size of an object on the monitor. The image calibration
display mode displays the image in need of spacing information, and a tool for defining measured objects
on the image, which PracticeBuilder 1-2-3 uses to define the physical size of the pixels.

Section 4.5.1 contains detailed information on the monitor calibration and instructions for calibrating one
or more monitors. Section 5.5.6 contain additional information on image calibration and the image
calibration display mode.

3.9 Mouse Operations

The mouse is a powerful tool in the PracticeBuilder 1-2-3 viewer. A large number of the most common
functions available from menus, toolbars and function keys are also available from the mouse. With a
litle practice and some dexterity, you should be able to accomplish the majority of your task simply
through the use of a three-button mouse with a wheel.

PracticeBuilder 1-2-3 is able to support a large number of functions on the mouse because it supports
multiple cursor modes. Each cursor mode assigns specific functions to each of the mouse buttons. By
changing the cursor mode, the different PracticeBuilder 1-2-3 functions become active. The following
section outlines each of PracticeBuilder 1-2-3’s cursor modes.

3.9.1 CuURSOR MODES

PracticeBuilder 1-2-3 viewer has a number of cursor modes available to control which functions get
applied when clicking one of the three supported mouse buttons. The cursor icon identifies the active
cursor mode. There are a few ways to activate a cursor mode.

Select the cursor mode from the Cursor submenu in the Settings menu.

Select the cursor button in the Toolbox toolbar.

Press the hot key combination (available for a limited number of cursor modes).
Click the middle mouse button to toggle through the cursor modes.

Press the minus (-) key to toggle through the cursor modes.

VVYVVYVYYV

Some users select a cursor mode and want to use it until they explicitly select another cursor mode.
Others prefer the cursor mode automatically reset to the default mode after applying an action.
PracticeBuilder 1-2-3 lets the user specify whether the mode resets to the default or persists in the
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selected mode. When clicking the mouse button, the cursor mode automatically resets to the default
when you release the button. If you hold down the ALT key while pressing the mouse button, the cursor
mode remains active after performing the action. This is useful when adding annotations or attaching
multiple key images to a report.

Hold down the Alt key to remain in the cursor mode for magnify, key image, link, ROI with W/L, crop,
magic X. The annotation cursor mode persists automatically, although it retains the specific annotation
tool if you hold down the Alt key.

3.9.1.1 Normal Cursor
Use the Normal (arrow) Cursor to click and select menus, menu items, buttons, slider bars, images,
[:E| and to click and drag to relocate toolbars and resize the Image and Thumbnail Windows. This is
the default cursor mode.

3.9.1.2 Magnification Cursor
The magnification cursor mode is for zooming in and out on images. The magnification is based
on the position of the cursor, so position the cursor over the point of interest before clicking the
~—— mouse.

When magnifying an image, a small plus sign (+) gets attached to the cursor, and a dotted white line
appears in the image in the thumbnail panel, indicating the viewable magnified image in relation to the
original image. Click the left mouse button to apply a 2x magnification to the displayed image, centered
on the cursor location. Hold the Shift key down when clicking to double the magnification to 4x. The
cursor displays two plus signs to indicate the 4x zoom factor.

To decrease the image size incrementally, hold down the Ctrl key when clicking the mouse. The icon
includes a small minus sign (-) next to the cursor. Hold the Shift key with the Ctrl key to zoom out by a
factor of 4x.

Clicking the right mouse button draws a zoom region. When you release the mouse, an image in the
defined region is magnified to fit into the image frame.

Reset the image size by reloading the image into the frame from the thumbnail panel, clicking on the
Reset Image Size button or menu item, or use the magnification mode to apply a reverse zoom.

3.9.1.3 Key Image Selection Cursor
The key image selection cursor lets you attach an image to a report. When activated, the cursor
J looks like a paper clip. To attach an image to a report, click on an image. When attached to the
report, a key image icon is displayed in the top left corner of the image to denote the image is
attached to the report exactly as rendered in the image frame. A paperclip icon appears in the top left
corner of the image to denote the image is attached to the report, but not as it appears in the image
frame. Click the key or paper clip icon on the image to remove it from the report.

3.9.1.4 Link Cursor

The link cursor is for linking one or more studies together so a single scroll command applies to all
=#r| linked image frames. Double-click the link cursor button to automatically link together all series
==I from the same study, in the same image plane and within the same frame of reference as defined
by the imaging modality. To manually link image frames together, select the Link cursor mode, move the
cursor to the first image frame, press and hold down the left mouse button, drag the cursor to the frame
you want to link, and release the mouse button. To link a third frame to the first two, repeat by starting
with one of the two original frames, and releasing the mouse when the cursor is in the third image frame.
To remove a link, double-click on the link icon in the top-left corner of the image.

3.9.1.5 ROI With Window/Level Adjustment
A user can set the window width and center values for an entire image or study based on the
= dynamic range of a specified region of an image using the ROl with window/level adjustment
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cursor mode. After selecting the ROI with W/L mode, position the cursor over the image, and click and
drag to define the region of interest. When you release the cursor, the pixels within the region are used to
define the window width and center. These values are applied to the entire image. The region defining
the area remains on the screen. Resize it and drag it around to change the window and level settings.
Click anywhere on the image outside the region of interest to remove it.

3.9.1.6 Crop Image Cursor Mode
Remove extraneous information from the viewable image in the frame with the crop image cursor
E mode. Click the image and drag the mouse to define the image region. When you release the
mouse, all image data outside the defined region disappears from view. Click on the region border
and drag it to resize the crop region. Select the Fit to Window mode to display the image as large as
possible in the image frame. Double-click anywhere in the image frame to remove the crop region.

3.9.1.7 Magic X Cursor Mode

— Locate a defined point in one image on all other images that share the same frame of reference
using the Magic X cursor mode. Select Magic X mode, and click on an image. All series currently
displayed in other frames scroll to the image closest to the selected point. If you click and hold the

mouse button, the Magic X marker is displayed in each image frame. If you drag the mouse while holding

down the button, the images update dynamically as the reference point moves.

3.9.1.8 Magic Glass Cursor Mode
Magic Glass cursor mode is actually a panning magnifying glass, zooming the image behind it.
After activating the magic glass window, click on the popup window and drag it to move it around.
The area under the image is magnified by a factor defined in your customize settings table. Only
image data is magnified. To clear the magnifying glass, left-click anywhere outside of the zoom area.

Resize the magic glass window positioning the mouse over the edge of the window until it changes to a
bi-directional arrow. Click the left mouse button and drag to resize the window. The window size can be
up to 20% of the size of your display resolution. Note that large Magic Glass windows may result in
ghosting as you drag it around. If you find this distracting, reduce the size of the magic glass window.

3.9.1.9 Annotation Cursor Mode
The annotation cursor mode is the general cursor mode for all annotation tools. The general
J annotation mode is needed to move and edit existing annotations. To apply a specific annotation,
select the desired annotation from the annotation toolbar, or spin the wheel on the mouse when
general annotation mode is active.

3.9.2 MousEe FUNCTIONS

The following table lists PracticeBuilder 1-2-3 viewer's mouse functions and actions based on the location
of the cursor when the action is requested.

Cursor Mouse
Mode Location Left Button Middle Button | Right Button
Pointer Main Viewing Click: Select image frame Click: Toggle Click: Features popup
Workspace cursor menu
Image Click: Select image/series Click: Toggle Click: Features popup
Drag: Scroll images (image fit-to-window), | cursor menu
or Pan (resized image) Roll: Scroll images | Drag: W/L image/series
Layout Click: Select image/study Click: Toggle Click: Features popup
Manager Dbl-click: open image/series cursor menu
Drag: Select multiple images/series Roll: Scroll images | Drag: W/L thumbnail
image(s)
Toolbars Click: Select Click: Toggle Click: Features popup
Dbl-click: Detach/attach toolbar cursor menu
Drag: drag toolbar
Elsewhere Click: Select Click: Popup menu
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Cursor Mouse
Mode Location Left Button Middle Button | Right Button
Magnifying Image Click: Zoom up and center Click: Toggle Click: Features popup
Glass Shift-click: Zoom up 2x and center cursor menu
CTL-click: Zoom down Roll: Scroll images | Drag: Size zoom area
Shift-CTL-click: Zoom down 2x
ALT-<cmd>: Stay in magnify mode after
click
Layout Click: Zoom up Click: Toggle Click: Features popup
Manager Shift-click: Zoom up 2x cursor menu
CTL-click: Zoom down Roll: Scroll images
Shift-CTL-click: Zoom down 2x
ALT-<cmd>: Stay in magnify mode after
click
Annotation Image Click: Apply annotation graphic Click: Toggle Click: Annotation popup
Mode Drag: Reposition annotation graphic/move | cursor menu
graphic endpoint/move annotation Roll: Scroll Drag: W/L image/series
label/text annotation tools
Key Image Image Click: Select image as key image Click: Toggle Click: Features popup
Selector ALT-click: Stay in key image mode after cursor menu
click Roll: Scroll images | Drag: W/L image/series
Layout Click: Select image as key image Click: Toggle Click: Features popup
Manager ALT-click: Stay in key image mode after cursor menu
click Roll: Scroll images | Drag: W/L image/series
Magic X Image Click: Display location of image in all Click: Toggle Click: Features popup
displayed frames cursor menu
Drag: Dynamically display location of Drag: W/L image/series
images is all displayed frames
ALT-click: Stay in Magic X mode after
click
Link Image / Click-Drag-Release: Click on first series, Click: Toggle Click: Features popup
Layout drag to series to link, and then release cursor menu
Manager ALT-click: Stay in Link mode after click Drag: W/L image/series
Cursor Dbl-click: Auto-link all series in same
Toolbar plane
Magic Glass Image Drag: Move the magnification window

3.10 Hot Keys and Macros

Hot Keys include various accelerator key combinations used to speed up the application of a function.
The PracticeBuilder 1-2-3 accelerator keys operate only within PracticeBuilder 1-2-3 viewer, and may be
in conflict with hot keys employed by other application installed on your PC.

F5 Full-screen Mode F10 Show Image Overlay Info
F6 Show Layout Manager F11 Show Orientation

F7 Show Image Information Dump Alt-F11 Show Orientation Cube
F8 Show Report and Key Images F12 Show localizer line

F9 Show Annotations Alt-F12 Show hash marks

Ctrl-1 Zoom 1 : 1 Alt-1 Zoom 1 :1

Ctrl-2 Zoom 2 : 1 Alt-2 Zoom1:2

Ctrl-4 Zoom 4 : 1 Alt-4 Zoom1:4

Ctrl-8 Zoom 8 : 1 Alt-8 Zoom1:8

Ctrl-H Flip horizontally Ctrl-N Normal cursor mode
Ctrl-U Flip vertically Ctrl-M Magnification cursor mode
Ctrl-L Rotate left Ctrl-O Open (study file)

Ctrl-R Rotate right Ctrl-Up Open previous study
Ctrl-F Zoom fit to window Ctrl-Down Open next study
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Ctrl-Q Close viewer Ctrl-P Print (selected images)
Home Show first cine frame Up Show previous cine frame
End Show last cine frame Down Show next cine frame
Ctrl-Z Undo (text editor) Shift-Del  Cut (text editor)
Ctrl-X Cut (text editor) Ins Copy (text editor)
Ctrl-C Copy (text editor) Shift-Ins  Paste (text editor)
Ctrl-v Paste (text editor)
Ctrl-F Fit image to window
Alt-M Magic glass window

3.11 Running PracticeBuilder 1-2-3 Viewer

Each of the three PracticeBuilder 1-2-3 viewers use a different mechanism to start and terminate.

3.11.1 STARTING AND TERMINATING THE DEDICATE WORKSTATION VIEWER

The dedicated workstation starts automatically when the user logs onto Windows using the Windows
account. In some cases, the PracticeBuilder workstation account may be set up as the default Windows
account, meaning the workstation automatically boots to the PracticeBuilder 1-2-3 dedicated workstation.
After the workstation initializes, the user receives a login prompt. This is the PracticeBuilder 1-2-3 sign on
window, prompting for a valid PracticeBuilder user account ID and password. It is separate from the
Windows account. After entering a valid PracticeBuilder user account ID and password, the workstation
downloads the user’s profile information and is ready to start displaying images. The study panel should
automatically appear, listing the default worklist.

To terminate the application and log off from the workstation, select the Exit option from the File menu.
This closes the open studies, and terminates the active session. When the PracticeBuilder 1-2-3
dedicated workstation session terminates, the user is also logged out of Window. It is not possible to
terminate the PracticeBuilder 1-2-3 dedicated workstation viewer to run other Windows applications
without having access to another Windows account on the PC. To learn how to run authorized
applications while using the dedicated workstation, refer to section 4.5.3.

3.11.2 STARTING AND TERMINATING THE ACTIVE-X VIEWER

As the name indicates, the active-X viewer uses Windows Active-X controls to start. When you install the
software, a file type is registered in Microsoft Windows. The default application for that file type is the
PracticeBuilder 1-2-3 viewer. When you select certain items on the PracticeBuilder 1-2-3 worklist, the
browser downloads a file of the registered type. As a result, Windows automatically launches the viewer.

To get to the worklist so you can load a study in the active-X viewer, you must log onto PracticeBuilder 1-
2-3. Select the hyperlink that is the patient’s name on the worklist, or click on the Open button, and the
viewer starts. If you run the viewer in Standby mode, as described in section 4.1.1, the viewer is always
loaded in memory and launches faster than it otherwise would.

To start the PracticeBuilder 1-2-3 active-X viewer without loading a study, go to the Windows Start button,
and select Programs. A list of available programs appears. Select PracticeBuilder 1-2-3, and
PracticeBuilder 1-2-3 again from its submenu. If configured to run in Standby mode, the viewer loads, but
remains minimized in the system tray.

To terminate a viewing session, close the viewer application by selecting Exit from the File menu or

clicking on the Close button in the top right corner of the application window. If running in configured for
Standby mode, the active-X viewer doesn’t really terminate. It closes the open study and then returns to
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Standby mode. To completely terminate the active-X viewer, find the PracticeBuilder 1-2-3 icon in the
system tray, right click on it, and select Exit.

3.11.3 STARTING AND TERMINATING THE STANDALONE VIEWER

The PracticeBuilder 1-2-3 standalone viewer is most often found on a CD or DVD. To launch the viewer,
insert the CD or DVD into the drive on your workstation. If you have Windows autorun enabled, the
viewer automatically loads. If this does not happen, go to the Windows Start menu, select Run, and enter
d:\pbuilder.exe, where “d:” is the drive label for your CD/DVD device.

When the standalone viewer initiates, the study panel appears. The studies available on the CD/DVD for
displaying in the standalone viewer appear in the study panel. It is not possible to load studies that do not
appear on the CD/DVD.

To terminate the standalone viewer, select Exit from the File menu, or click on the close button in the top
right corner of the application window.
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4 Configuration Settings and Options

The PracticeBuilder 1-2-3 viewer supports a customizable graphical user interface (GUI). The user has
the ability to define the screen layouts, toolbar arrangements, preset values, custom handing protocol
templates, network settings, overlays, and other settings that make the GUI better suited to specific uses.
PracticeBuilder 1-2-3 records each user's specific profile on the server, and downloads it to the
workstation when a user logs in. This permits each user to customize their workspace without imposing
their preferences on other users.

The sections in this chapter provide details for customizing the PracticeBuilder 1-2-3 viewer settings.
These settings are available on all versions of the PracticeBuilder 1-2-3 viewer, except when noted
otherwise.

4.1 Customize Settings Window

The customized settings window contains the means for settings and reviewing the viewer’s default
behavior and appearance. Open the customize settings window by selecting Customize Settings from
the Settings menu. The customize settings window consists of a number of tabs, each with a set of
configurable settings, plus an OK, Cancel, and Reset All button. To record all the changes you make on
one of the pages in the customize settings window, click on the OK button. Use the Cancel button to
close the customize settings window without saving your changes. The Reset All button resets all the
viewer’s settings to the original settings before you started editing them.

The customize settings windows contains a number of pages. A tab at the top of the pages, identifies
each page. To go to a specific settings page, click on the corresponding tab. Note that some tabs may
not be visible initially. At the far right of all the tabs are arrow buttons. Click on these buttons to display
more tabs.

The available customize settings are grouped into the categories listed below. The sections that follow
give detailed information on each of the customize settings pages.

Settings General viewer feature settings

View Monitor controls and panel settings
Layout Image layout settings

Images Image zooming and compression settings

DICOM Fields Overlay and print header settings
Hash Marks Localizer and Magic X spacing settings

Prefetch Prefetch settings

Cache Viewer cache usage settings

Colors Custom color selections

Advanced Communication and miscellaneous settings
Spine Spine labeling tool settings

4.1.1 GENERAL SETTINGS
The general settings page in the customize settings window

contains parameters that affect the way specific functions behave St | G o e o oot Pt i (1
in the PracticeBuilder 1-2-3 viewer. To display the general —— R
settings page, select Customize Settings from the Settings menu, o kb o I Bt o
and click on the Settings tab. ¥ Toolis ¥ Adiust for CEMAR

¥ Art marker line ¥ Speschiike support
In many cases, the general settings toggle the behavior of B2 vt icer [2leon somnctiia sotes
functions that different users prefer to be enabled or disabled, B s
depending on the manner in which they use PracticeBuilder 1-2-
3. Specifically, the general settings are follows: [P | et [ 75

oK I Cancel Reset all
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Setting Default Description

Standby mode Enabled Standby mode instructs the viewer to load when Windows starts, and remain in
memory. This permits the viewer to launch quicker when opening a study. When
disabled, Windows must read the viewer from disk and load it before the viewer can
start loading data.

Use HTTP proxy Enabled If a proxy server exists between the workstation and the server, certain
communications actions are needed. This setting should be enabled at all times.

Tool tips Enabled Tool tips are popup text strings that help identify the function of a tool. When
enabled, tool tips appear one second after you place the cursor over a button, field
or gauge in the viewer. When disabled, no tool tips appear.

Ant line marker Enabled The ant line marker is the moving, dotted white line that marks the view area in a
thumbnail image. When enabled, the ant line marker denotes the location and size
of the image area displayed in the window when a zoom factor is being applied to
the image. If disabled, the markers appear as a solid line the thumbnail image.

Annotation Enabled Image annotations can include an index for reference purposes. When enabled, an

indices automatically incremented index is included with every annotation applied to an
image. When disabled, the index is not displayed. Override this setting on an
individual basis by right clicking on a specific annotation and select Show Index to
toggle the setting.

Tick marks Disabled | Linear measurement annotations support tick marks to assist in calculating
distances. When tick marks are enabled, the marks appear on linear measurement
annotations. Override this setting on an individual basis by right clicking on the
specific annotation and select Show tick marks to toggle the setting.

Center zoom Enabled The center zoom region setting defines the focal point location when establishing a

region zoom region. When enabled, the location of the cursor when you first click is set as
the center of the defined region. When disabled, the location of the cursor when you
first click is set as the corner of the defined region.

External level Disabled | The external level allowed setting provides you with the ability to set your window

allowed center value outside the defined region.

Adjust for CEMAX | Enabled The adjust for CEMAX setting resolves a problem rendering images that were
process by CEMAX products.

SpeechMike Enabled The SpeechMike support setting instructs the viewer to apply the Philips

support SpeechMike controls to the microphone device. When enabled, the control file is
loaded and the buttons on the SpeechMike function. When disabled, the controls
on the SpeechMike are disabled.

Keep Speech- Enabled The Keep SpeechMike active setting keeps the SpeechMike activated when you

Mike active pause your recording.

Mode change Enabled | The middle mouse button on a three-button mouse changes the cursor mode when

with middle button clicked. Some mice are overly sensitive, and an attempt to scroll the mouse wheel
inadvertently clicks the button. Disable the mouse click function by disabling the
mode change with middle button setting.

Continuous image | Disabled | Scrolling through images in an image frame can progress smoothly by rendering

scrolling every image, or quickly by skipping through the images at a rate based on the
speed the user scrolls. When continuous image scrolling is enabled, the viewer
may skip images to keep up with the scroll speed. When disabled, the viewer
displays every image in the stack.

Proposed states -- The Proposed states button opens the window used to set the states to propose
when closing a study. See section 4.1.1.1 for more information.

Magic glass zoom | 2:1 The magic glass zoom factor defines the magpnification applied to the data inside the

factor magic glass window. The default is a 2x magnification.

4.1.1.1 Proposed States

[ Provoncd repartatates =

When closing a study, PracticeBuilder 1-2-3 attempts to set the study
state to its new state based on the actions you performed while viewing
the images. For example, if you opened a study that was in the Unviewed
state, and you dictated a report, PracticeBuilder 1-2-3 would suggest you
set the state to Dictated when you close the viewer. To define the
defaults, open the proposed states window, and select the resulting state
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based on the defined action listed in the window. If you do not explicitly set the state of the study before
you close the viewer, the prompt PracticeBuilder 1-2-3 displays suggests the defined state.
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4.1.2 VIEW SETTINGS

The view settings page contains monitor configuration parameters,
plus controls for setting viewing characteristics of the many panels
available in PracticeBuilder 1-2-3. To display the view settings
page, select Customize Settings from the Settings menu, and click

on the View tab.

The majority of the settings on the view page determine how
PracticeBuilder 1-2-3 uses the monitors.
workstation, the PracticeBuilder 1-2-3 viewer can appear on one or
more of the monitors. By identifying the primary monitor and which
others to enable, the user can run PracticeBuilder 1-2-3 while
leaving other applications, such as the procedure order information
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Settings Wiew | Lapout | Imsges | Dicom fields | Hash marks | Prefatch | Cashe | 141

I¥  Show thumbnail panel
™ Layout manager on top
¥ Info panel on top

™ Repoit panel on top

¥ Piint panel on tap

¥ Collaboration panel on top

Repoart panel
& Full " Compact
¥ Audia [~ Annotation

~Layout managst
W Templates
V¥ Grid layouts
I Tile layouts

ezl rsitiae |—1:|' B Fj

Monitar #1 | |Aute =

W¥ Privawmoritor I Disshl=

W Templates

¥ window/Level

I &nnatation

™ Grid layouts I™ Drientation

[# Tile lapauts ¥ Standard
¥ Status bar

™ Link
I” Cine
¥ Toolbax

In a multiple monitor

Reset All

oK I Cancel

or the patient history, displayed on the remaining monitors.

Section | Setting Default Description

Monitors | Number of monitors | 1x1 The number of PracticeBuilder 1-2-3 windows to display on the
current monitor. Useful to split a single 2560x1024 Windows
monitor into two 1280x1024 monitors. Only active on single-
monitor workstations.

Monitor # - Select the monitor to configure. Numeric index refers to the
Windows monitor number. See Windows Display properties.

Auto/BW/Color Auto Set the monitor type to greyscale, color, or let PracticeBuilder 1-2-3
figure it out.

Primary Monitor Monitor #1 The selected monitor is the primary monitor, and will display the
popup windows, display the thumbnail panel, and handle other
functions. Primary Monitor can be selected for only one monitor.

Disable Disabled Do not display PracticeBuilder 1-2-3 on the selected monitor.

Templates Enabled Show/Hide the templates toolbar on selected monitor.

Window/Level Enabled Show/Hide the window/level toolbar on the selected monitor.

Annotation Enabled Show/Hide the annotation toolbar on the selected monitor.

Grid Layouts Disabled Show/Hide the grid layouts toolbar on the selected monitor.

Tile Layouts Disabled Show/Hide the tile layouts toolbar on the selected monitor.

Link Disabled Show/Hide the link toolbar on the selected monitor.

Cine Disabled Show/Hide the cine toolbar on the selected monitor.

Toolbox Enabled Show/Hide the toolbox toolbar on the selected monitor.

Orientation Enabled Show/Hide the orientation toolbar on the selected monitor.

Standard Disabled Show/Hide the standard toolbar on the selected monitor.

Status bar Enabled Show/Hide the status bar on the selected monitor.

General | Show Thumbnail Disabled Show/Hide the thumbnail panel on the primary monitor.

Panel

Layout Manager on Enabled Keep the layout manager displayed on top of all other windows.

top

Info Panel on top Enabled Keep the information panel displayed on top of all other windows.

Report Panel on top | Enabled Keep the report panel displayed on top of all other windows.

Print Panel on top Enabled Keep the print panel displayed on top of all other windows.

Collaboration Panel | Enabled Keep the collaboration panel displayed on top of all other windows.

on top

Report Full Selected Default to the full report panel when opening the report panel.
Panel Compact Unselected | Default to the compact report panel when opening the report panel.

Audio Enabled Show/Hide the audio toolbar on the report panel.

Annotation Disabled Show/Hide the annotation toolbar on the report panel.

Layout Templates Enabled Show/Hide the templates toolbar on the layout manager.
Manager | Grid Layouts Enabled Show/Hide the grid layouts toolbar on the layout manager.
Tile Layouts Enabled Show/Hide the tile layouts toolbar on the layout manager.
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4.1.3 LAYOUT SETTINGS

The layout settings page contains settings for presenting
information in the PracticeBuilder 1-2-3 viewer. The page
provides parameters for properly organizing series and image
data, default sizes for thumbnail and report images, selecting
default grid layouts, and identifying default hanging protocol
templates. To display the layout settings page, select Customize
Settings from the Settings menu, and click on the Layout tab.

The settings on the layout page apply to specific image types.
PracticeBuilder 1-2-3 identifies an image type by the modality
values stored in the series object. To assign settings to a
particular image type, you must first select the modality type from
the pull-down menu on the layout page. A general image type,
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called Default, appears at the beginning of the pull-down menu. When this value appears in the pull-
down menu, the setting applies to all image types unless overridden with a specific setting. There are
checkboxes on this page labeled Use Default. When checked, PracticeBuilder 1-2-3 uses the default
setting for the selected image type. In other cases, a gray check appears in the checkbox, indicating the

selection is actually defined by the default setting.

The table below provides detailed information on each of the settings on the layout page. There are two
settings that apply to the entire page, and therefore are not assigned to any single section. The Settings
For: menu contains all of the supported modality types that the settings on this page can apply to. The
Use hanging protocol assistant checkbox enables and disables a number of the sections on this page. If
the hanging protocol assistant is enabled, the hanging protocol template defines many of the settings.

When disabled, the user settings take precedence.

Section Setting Default Description

undefined parameters.

Settings for: -- Select the modality the settings on this page apply to. Select the
modality type Default to set the default settings for all the

Use hanging protocol | Enabled | When enabled, the hanging protocol assistance attempts to select

assistant the best-defined hanging protocol template based on previous
usage. When disabled, the Template settings take precedence.
Monitor Multiple monitor Enabled | Permit the PracticeBuilder 1-2-3 viewer to appear on all enabled
setting monitors for the selected modality type. This setting is effective

only when multiple viewer monitors are configured enabled, or the
number of monitors configured on the view page is greater than 1.

Automatic | Find localizers Enabled | When enabled, separate localizer images that are grouped in
settings series with non-localizer images into their own series. When
disabled, localizer images are grouped as specified by the object
data.
Split series Disabled | Some series contain images in different planes, or using different

object data.

acquisition parameters. PracticeBuilder 1-2-3 can sometimes
identify these series. When Split series is enabled, the images are
grouped together into individual series and made available to the
user. When disabled, the series are grouped as specified by the

Sort series Disabled | When enabled, always sort the images by image position, or slice
number when position information is unavailable. When disabled,
the series is ordered as it arrived at the server.

Series split length 0 For series with fewer images than specified in the Series split
length setting, separate all images into their own series. Useful for
separating CR series into single images.

Thumbnail | Use default size Enabled | Use the default thumbnail size.

size Size - Override the default thumbnail size for the selected modality. The
value is defined in pixels-squared

Report Use default size Enabled | Use the default image size.
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Section Setting Default Description
figure size | Size -- Override the default figure size for the selected modality. The
value is defined in pixels-squared.
Image Use default setting Enabled | Use the default image layout setting.
Layout Tile across monitors - When selected, the selected tile mode is applied across all
enabled monitors.
N-up -- The default grid layout for the selected modality type.
Custom -- Define a custom grid layout for the selected modality type.
Template | Use default template | Enabled | Use the default hanging protocol template setting.
Template menu -- Select the hanging protocol template to apply to studies of the
selected modality type.
Show layout Enabled | When enabled, display the layout manager after applying a
manager hanging protocol template. When disabled and a template was
automatically applied, do not show the layout manager.
4.1.4 IMAGE SETTINGS

The customize setting window’s image settings page contains
image communication and interpretation information.
defines defaults for compression modes, interpolation algorithms,
and default window and level settings.
settings page, select Customize Settings from the Settings menu,
and click on the Image tab.

The settings on the image page apply to specific image types,
identified by the modality parameters stored in the series object.
To assign settings to a particular image type, you must first select
the modality type from the pull-down menu on the image page. A
general image type, called Default, appears at the beginning of the
pull-down menu.
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When this value is selected, the settings apply to all image types except those

overridden with a specific setting. There are checkboxes on this page labeled Use Default.

When

checked, PracticeBuilder 1-2-3 uses the default setting for the selected image type.

The table below provides detailed information on each of the settings on the image page. There is one
setting that applies to the entire page, and therefore is not assigned to any single section. The Settings
For: menu contains all of the supported modality types that the settings on this page can apply to.

Section Setting Default | Description

Settings for: - Select the modality the settings on this page apply to. Select the
modality type Default to set the default settings for all the undefined
parameters.

Use W/L Range Min 0 When overriding the defined window/level setting for an image, this
is the lower window width setting.

Max 4096 When overriding the defined window/level setting for an image, this
is the upper window width setting.

Automatic Enabled | When enabled, use the actual pixel range as the window width and
automatically calculate the level. When disabled, use the values
defined in Min and Max. This setting applies only when no default
window width and center value exists in the image object.

Interpolation Use default Enabled | Use the default interpolation algorithm.

Nearest pixel Use pixel replication to create pixels.

Bilinear Default Use a bilinear interpolation algorithm to create pixels.
Compression Use default Enabled | Use the default compression algorithm.

Uncompressed Do not use any compression on the image data.

Jpeg Compress the image data using JPEG.

Wavelet Compress the image data using a progressive wavelet algorithm.

Auto Default Have PracticeBuilder 1-2-3 select the best compression setting
based on network configuration and utilization.
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Section Setting Default | Description
Auto W/L Setting | Use default Enabled | Use the default auto W/L override setting.

No override Default Do not override the WI/L setting defined in the image object.

Override by When the entire study defines a full window width, replace it in

study each image with a calculated histogram equalization value.

Override by When the entire series defines a full window width, replace it in

series each image with a calculated histogram equalization value.

Override by When the image is defined with full window width, replace it with a

image calculated histogram equalization value.

Wavelet Quality Use default Enabled | Use the default wavelet quality setting.

Lossless Default When using wavelet compression, use bit conserving quality factor.

N:1 Lossy When using wavelet compression, terminate the decompression
when the selected ratio is achieved.

Auto W/L Range | Use default Enabled | Use the default automatic window/level range.

Distribution 95% To eliminate the noise that may exist at the extreme ends of the
distribution curve, reduce the data set to the defined distribution
range.

Zoom mode Use default Enabled | Use default zoom mode.

Fit to window Default Fit the image to the image frame. Use the interpolation algorithm
selected for this modality type to create additional pixels.

1:1 Display only original pixel data, with no zoom factor applied.

Actual size Display the image in the actual image size. This requires the
monitors be calibrated for size before opening a study, and the
image objects include pixel size information.

4.1.4.1 Ignore Default Window/Level Setting

Some modalities explicitly define a window width that reflects the full range of the pixel data, or a center
value outside the window range, even if these settings result in poor image quality. By default,
PracticeBuilder 1-2-3 applies predefined window width and center values, regardless of the results. To
avoid applying bad window and level values, use the Auto W/L Setting tool to ignore the predefined
values and use its own histogram analysis to set the initial window and level.

On the image settings page, go to the Auto W/L Setting area, select one of the override settings. No
Override instructs PracticeBuilder 1-2-3 to use the window and level setting predefined in the image
object. Override by Study/Series/image means use the internal histogram analysis algorithm when the
entire study, series or image defaults to a full window width. (The optimal setting is Override by Series.)

4.1.4.2 Correcting Invalid Window and Level Settings

Some imaging modalities and PACS systems change the original image data, causing rendering
problems in a third party systems. If this occurs when using PracticeBuilder 1-2-3, you can force a
correction that adjusts the window and level settings. From the image settings page, go to the Use W/L
Range field, and set the minimum and maximum window and level settings for each modality. If you need
to use the defined range, select Automatic, in which case PracticeBuilder 1-2-3 uses whatever the image
object has defined for itself.

4.1.4.3 Compression Warning

When compression is used to download images from the PracticeBuilder 1-2-3 server to the viewer, the
image may contain bit errors that result in modified pixel values. This is common when employing
compression ratios that are not bit conserving. To help the user know when a particular image was
downloaded using a lossy compression ratio, a warning icon, 2\ appears in the upper left corner of the
image frame. To eliminate this warning, select Uncompressed in the image settings page’s Compression
section, or select Wavelet and set the Wavelet Quality setting to Lossless.

4.1.5 SERVER/PREFETCH SETTINGS

The server/prefetch settings page in the customize settings window configures the server setup for
downloading and prefetching images. On the PracticeBuilder 1-2-3 dedicated workstation, the page is
labeled Server. On the other viewers, it is Prefetch. The page contains the server address, the protocol
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used to communicate with the server, prefetch settings and
compression settings.
page, select Customize Settings from the Settings menu, and click
on the Server or Prefetch tab.

Like some of the other settings pages, the Compression section
settings apply to specific image types, identified by the modality
parameters stored in the series object.
settings to a particular image type, select the modality type from
the pull-down menu in the Compression section. A general image
type, called Default, appears at the beginning of the pull-down
When Default is selected, the settings apply to all image

menu.
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types except those overridden with a specific setting. There are checkboxes on this page labeled Use
Default. When checked, PracticeBuilder 1-2-3 uses the default setting for the selected image type.

The table below provides detailed information on each of the settings on the server/prefetch page.

Section Setting Default | Description
General Server http Use a secure (HTTPS) or open (HTTP) connection to the server.
(protocol)
Server NULL The server address. This value can be a hostname, such as
(address) pacs.hospital.com, or an IP address, such as 10.0.0.1.
Cycle time 30 The time between queries for new studies. The more frequent the
minutes | query cycle, the more traffic that results on the network.
Check server -- This button checks to see if the configured server is available. Use it to
verify your configuration of the server.
Enable Disabled | Turn prefetching on and off. When checked, the workstation queries
prefetch the server once every cycle for new studies as defined by the prefetch
worklist filter. When unchecked, no checking occurs.
Prefetch in Enabled | When prefetching is enabled, the query and subsequent downloads can
standby mode take CPU cycles away from other PracticeBuilder 1-2-3 activities. On
only slower machines, this can impact the GUI performance. When Prefetch
in standby mode only is checked, the query executes when the viewer
is inactive and in standby mode. Clear this checkbox to continue to
qguery and download studies when the viewer is open.

Compression | Settings for: - Select the modality the settings in this section apply to. Select the
modality type Default to set the default settings for all the undefined
parameters.

Same as Enabled | When checked, the viewer ignores the compression settings on this
Image settings page and default to those on the Image settings page. To activate the
settings on this page, clear the checkmark.

Study Data Use default Enabled | Use the default compression algorithm.

Download Uncompressed Do not use any compression on the study data.

Compressed Compress the study data. This uses lossless wavelet.
Auto Default Have PracticeBuilder 1-2-3 select the best compression setting based
on network configuration and utilization.

Image Use default Enabled | Use the default compression algorithm.

Compression | Uncompressed Do not use any compression on the image data.

Jpeg Compress the image data using JPEG.

Wavelet Compress the image data using progressive wavelet algorithm.

Auto Default Have PracticeBuilder 1-2-3 select the best compression setting based
on network configuration and utilization.

Wavelet Use default Enabled | Use the default wavelet quality setting.

Quality Lossless Default When using wavelet compression for the image data, use a bit
conserving quality factor.

N:1 Lossy When using wavelet compression for the image data, terminate the

decompression when the selected ratio is achieved.
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4.1.5.1 Prefetching

The prefetch settings in the PracticeBuilder 1-2-3 viewer turn the function on and off (Enable prefetch),
and control the frequency of the prefetch operation (Cycle time), but they do not specify which studies to
include. A worklist filter controls the study list. Section 4.4.1 contains information on setting up prefetch
filters.

In addition to enabling the prefetch setting in the server/prefetch settings page, the PracticeBuilder 1-2-3
viewer must be running in standby mode. When the viewer is running in standby mode, the
PracticeBuilder 1-2-3 icon appears in the Windows system tray. Refer to section 4.1.1 for information on
enabling standby mode.

4.1.6 CACHE SETTINGS

The cache settings page defines the parameters the | sum:|ven | L] insses] pcomFists | Hoshbaks| Feih Coche | 4le]
PracticeBuilder 1-2-3 viewer's cache uses to manage the study
and image data. The page contains the location of the disk cache,
its size and some control parameters. To display the cache
settings page, select Customize Settings from the Settings menu, _ -
and click on the Cache tab. o [ TS e s

I {Flnge fies from the cache afted ET] :ll days

Cache

Directory name: IC:\Pngram Files\PracticeBuilder\PECachet,

The workstations’ data storage cache uses a portion of the
available disk space. When you open or prefetch a study the first
time, PracticeBuilder 1-2-3 transfer the data from across the
network and stores the data in the cache. For subsequent opens,
PracticeBuilder 1-2-3 uses the data in the cache, eliminating the o |_Coel | R |
network transfer. Unless you have a complete understanding of the ramifications of changing the size of
the disk cache, ask your administrator for assistance.

PracticeBuilder 1-2-3 manages the cache itself, so there is no need to do anything. The data on the
cache settings page allow you to change the default cache settings, and to reclaim the cache space by
clearing it. If you clear the cache, the data downloads across the network from the server the next time
you open the study. Note that when upgrading the viewer to a new version, the cache may be cleared
automatically.

Section | Setting Default Description
Cache Directory C:\Program Files\ The directory PracticeBuilder 1-2-3 uses for the disk cache. If
name PracticeBuilder\PBCache\ | the default directory does not contain enough disk space,

change the setting to a disk drive that does. Create the
directory before entering it here.

Directory 511 MB The size of PracticeBuilder 1-2-3’s disk cache. It should be
size large enough to store all the images you want to be available
locally at any one time. If too small, redundant image
downloads result. If too large, other application on the
workstation may not have the disk space they need.

Empty - This function empties the cache. Use it to recoup disk space
cache taken up by PracticeBuilder 1-2-3 data.

Purge files | Disabled If you want to purge the data from the local disk cache on a
from cache regular basis, enable this function by putting a check in the
after X box. When enabled, enter the number of days between
days purges.

4.1.7 DICOM SETTINGS

The DICOM fields settings page contains tools for defining the overlays that appear on the images in the
viewer and on printed film. To display the DICOM fields settings page, select Customize Settings from
the Settings menu, and click on the DICOM Fields tab.
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The table below provides detailed information on each of the
settings on the image page.

Setting Description

Settings for: Select the modality the settings on this page apply to. Select the modality type Default to set
the default settings for all the undefined parameters.

Use the default Instructs PracticeBuilder 1-2-3 to use either the default setting for the specified Display Location,

list for this display | or to customize the Display Location for the selected modality type. When checked, the default

location settings are used. When cleared, the control panel is activated and you can customize the
attributes. The default is checked.

[Control panel] Work area for organizing the selected attributes to display in the area specified in Display

Location. Clear the check in the Use the default list... box to activate this area.

Display Location: | The areas of the image and film that you can place demographic and study information. The
available options include top-left, top-right, bottom-left and bottom-right corners of an image,
and the header on a printed sheet of film. Select the appropriate location from the menu before
making changes to the control panel.

Character Size: The font size of the overlay data. The font type is not configurable.

Tag: List of available attributes tags from the DICOM object. This list is created from the attributes
defined in the object loaded in the viewer. If the attribute does not exist in this list, it is not
defined in the DICOM object.

Info: List of calculated values created by PracticeBuilder 1-2-3 that can be used in overlays.
Add Tag Click this button to add an attribute from the Tag list.

Add Info Click this button to add a value from the Info list.

Add Text Click this button to add a text string.

Break Click this button to insert a carriage return (new-line) character.

Remove Click this button to remove the item selected in the control panel.

Up/Down arrow Move the selected item in the control panel up or down the list.

Defining overlays for images and film consists of selecting the area of the image or film on which you
want to display some data, selecting the information you want to display, and then formatting the
information. PracticeBuilder 1-2-3 comes with a default overlay defined for all modality types. You can
modify the general overlay specification, and also customize each overlay for specific modality types.
The rules for doing either are the same.

Start by selecting the modality type from the Settings for: menu, or chose the default if you want to
change the common overlay definition. Then, select the location of the overlay from the Display Location:
menu. The control panel updates to show the current settings for that location. If the control panel is
inactive, remove the check from the Use the default list for this display location box. The control panel
can contain literal stings, such as labels, patient demographics, study information, calculated values, and
new-line characters. Use the buttons to the right of the control panel to add and remove these fields.

When you want to insert an attribute, find it in the Tag or Info list, and click on the respective Add button.
To insert a literal string, click on the Add Text button. A popup window appears. Enter the text, and click
OK. The string appears in the control panel in quotation marks. Move the fields around the control panel
by selecting the attribute and clicking on the up and down arrows to the right of the control panel. To
insert a carriage return between two attributes, insert a new-line character by clicking on the Break button
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and moving it to the appropriate location. Remove any attribute in the control panel by selecting it and
clicking on the Remove button.

The Info list contains calculated values, generated by PracticeBuilder 1-2-3 and based on the loaded
study. The list of available values in the Info list is as follows:

Completion The percentage of the image that has already downloaded to the
viewer.
Compression The compression ratio applied to the image.

Current Annotation  If an annotation is currently selected, the value of that annotation
(i.e., the length, area, text string, etc.) appears in the overlay.

Image Index The position of the image in the series. This is different from the
Instance Number in the Tag list. The Instance Number is a value
defined by the modality, and is not guaranteed to be sequential.
The Image Index uses the position in the series, and therefore is
always sequential.

Level Current window center setting.

Packet Size Size of the network packets in the download transmission.
Series Size Total number of images in the series.

Window Current window width setting.

Zoom The zoom factor currently applied to the image.

The example of the overlay settings shown here includes

Settings for: Diisplay Location:

the control panel for the top right and bottom right image = [& 5 [fooren G pneEDOHER
areas, and the resulting image. In the top-right, a carriage = use i defaut st for this display locstion cT
return separates each of the three fields, and there are no Studssoipton e
. . . . <Hreaks 1
literal strings displayed. As a result, in the event the value  |see:Description R
. . . . . <Breaky [
is empty, the field on the image will be blank. Sometimes |Modait add Ter
it is better to include a label so when no value exists, it is _ _
more ObVIOUS tO the user. Settings for Dizplay Ln.callnn
IET j IEottom-thht I

™ Use the dafault list for this display location

In the bottom-right, a literal string exists to separate the

. . . . . =1 Ind
two fields. With no carriage return included, all three fields | ™ Al e

appear on a single line when displayed on the image. —

4.1.8 HASH MARK SETTINGS

The hash mark settings page defines the parameters the PracticeBuilder 1-2-3 viewer uses to calculate
spacing limits for hash marks and other positioning features. You can define the distance that defines
intersecting image planes and when the Magic X positioning tool is out of range. This setting page also
sets the defaults for which kind of hash marks to display. To display the harm mark settings page, select
Customize Settings from the Settings menu, and click on the Hash Marks tab.

PracticeBuilder 1-2-3 makes a distinction between hash marks  setim|vien | Laout] insges| biconFiekis | Heshborks | Prieich| Cache | 4L+

and localizer lines. A localizer line is graphic that shows the (Ha:i::'jm;;;n-;hmwmmmks ozl ‘
intersection of one image on another. This setting applies to the -
selected image and results in a single line on the intersecting F“J:?:LTfﬁgélg.weemmm.m = jdw‘
images. Hash marks are the collection of multiple localizer lines.

This setting applies to all the series of images in the selected = T — el
frame. The result are one or more lines draw in the intersecting ( 7 Diette i out o ,—mj .

images, with the displayed image (in the stack frame) displayed

. . Local
using a bold line. Settings for I™ Shaw T Hide lncalizer Ines an al images
Default | (i Sy st alimages

The following table describes the fields that appear on the hash
mark settings page.

oK I Cancel Resetall
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Section Setting Default | Description
Hark Mark Minimum distance 0 mm Too many hash marks in a small area obscure the radiograph
Spacing between hash marks behind them. This setting defines the minimum spacing permitted
between hash marks.
Localization | Minimum angle 90° Some images are not completely orthogonal to others. This setting
Criteria between image defines the angle of incidence between two intersecting plans that
planes qualifies for displaying a localizer line denoting the intersection. If
the two plans intersect as an angle greater than what is defined, the
localizer line appears on the image.
Magic X Dimmed Magic X out | 10 mm If the current position of the Magic X tool is more than the specified
Limits of N mm. distance from the last image in a series, the graphic dims to a light
gray. The graphic remains gray until the current position is within
the defined distance, or it reaches the Disable distance.
Disable Magic X out | 100 mm | If the current position of the Magic X tool is more than the specified
of N mm. distance from the last image in a series, the graphic disappears.
Localizers Settings for: -- Select the modality the settings in this section apply to. Select the
modality type Default to set the default settings for all the undefined
parameters.
Show/Hide localizer | Hide Show or hide a single localizer line showing the intersection of the
lines on all images selected image on the image in all other image frames.
Show/Hide hash Hide Show or hide the hash marks showing the intersection of all images
marks on all images in the selected frame on the image in all other image frames.

4.1.9 COLOR SETTINGS

The color settings page contains tools for customizing the colors of

Images | Dicom Fields | Hash Marks | Prefeich | Cache  Colors | Advanced | A

the different parts of the viewer. To display the color settings page,

select Customize Settings from the Settings menu, and click on the
Colors tab.

You can customize many of the colors used in the PracticeBuilder 1-
2-3 viewer. The list below defines each of the areas. When you

Calar Setting

Background - e |
Fioset selected color

select an area, the current color setting appears to the right of the
area list. The color panel that pops up contains a list of predefined
colors, and an option for defining custom colors.

Annotations
Background
Calibration rulers
Current image

Grid splitter

Hash line shadow
Hash lines

Image background
Information overlay text

Information panel background

Information panel text
Marker line

Report panel background

Report panel text
Orientation information
Selected annotations
Selected image
Series #1-4

Image annotations

Ok Cancel Reset All

Viewer background

Calibration ruler annotations

Frame color of thumbnail image that corresponds to the displayed
image in the selected frame

Image grid border

Used when only part of the localizer line intersects the image
Localizer lines and hash marks

Color of the image frame that does not contain image data
Color of the overlay text displayed on an image

Background color of the information (info) panel

Color of the text in the information (info) panel

View area border displayed on thumbnail images, when Ant
Marker setting is disabled

Background color of the report panel

Color of the text in the report panel

Line

Color of the orientation (left-right) markers overlaid on the image

The active annotation, when creating or editing
Grid border color of the selected image frame

Color of the thumbnail border for 1% through 4" series. Colors

repeat starting with the 5™ series.
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Visible image Color of the thumbnail image border for a series loaded in the
selected image frame

The table below provides detailed information on each of the settings on the colors page.

Section Setting Description

Color Settings Area list A list of areas that can be customized.
Change This button pops up a window from which you can set the color.
Reset selected color Resets the selected area to the default value.

4.1.10 ADVANCED SETTINGS

The advanced settings page defines  mMISCEIIANEOUS | ) vecr s | ostiaio| Fetecn] Coche| coms adbances] <l
PracticeBuilder 1-2-3 viewer parameters. To display the e

. . ) [Dsfeu |
advanced settings page, select Customize Settings from the Fam OB oty ot doiond
Settings menu, and click on the Advanced tab. . - I Use et Corpression

com oo - et

The data packet size settings define the network packet size best coakCome @ buto
suited for fast data transfers. The study data download section
controls the compression used on the control data downloaded to Ovyten s [ 55 W e T
the workstation each time you open a study. The progress of the Komp oo |2 ) doan i e
control data download is denoted by a blue progress bar ez | e
displayed in the Status bar along the bottom of the main viewing
area. The following table explains these settings and the others [P o
on this page.
Section Settings Default | Description

Settings for: - Select the modality the settings on this page apply to. Select the
modality type Default to set the default settings for all the undefined
parameters.

Annotation font | 8 point Font size for the text used for annotations.

size

Keep last N 25 Keep the specified number of print logs on the workstation. Print

print logs logs show the results of a DICOM print request, and may be useful
in the event a problem occurred.

Keep last N text | 20 Keep the specified number of text annotations in the annotation text

annotations list.

Connect to Disabled | When a proxy server is involved in the network routing between two

collaboration collaborating workstation, PracticeBuilder 1-2-3 needs to know to

peer directly attempt to connect directly. When a check appears in the box, the
workstation attempts to connect to the other workstation directly.
Data packet Auto Auto PracticeBuilder 1-2-3 selects the best packet size to use when
size transferring data from/to the server based on network configuration
and utilization.

Size Override the automatic packet size setting and force packets to the
specified size. Smaller packets are best used in slow, busy
networks. Larger packets are best used in fast, quiet networks.

Study data Use default Enabled | Use the default compression algorithm to download the control data,
download thumbnails, etc.

Uncompressed Do not use any compression on the control data.

Compressed Compress the control data. This uses lossless wavelet.

Auto Default PracticeBuilder 1-2-3 selects the best compression setting based on
network configuration and utilization.

4.1.10.1 Automatic Communication Optimization

PracticeBuilder 1-2-3 attempts to optimize the communications between the server and the viewer
according to the available bandwidth, the network speed, location of the workstation, etc. You have the
ability to override the optimization, but it is not recommended. To have PracticeBuilder 1-2-3
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automatically perform this optimization, set the Data Packet Size to Auto and the Study Download Data to
Auto.

When set to optimize the communications, PracticeBuilder 1-2-3 packages the initial study information it
sends to the Viewer when loading the study based on the network performance. For example, if the
Server detects that the workstation is located on the same local area network (as defined in the LAN-
accessible IP Addresses section of the System Options on the Server page), the study information is
transferred uncompressed in large data blocks, which improves the delivery time over a fast LAN. If the
connection between the server and viewer is across a slow wide area network, PracticeBuilder 1-2-3 opts
for compressed data and smaller packet sizes.

4.1.11 SPINE TOOL SETTINGS

The spine tool settings page defines default settings for the SPIN€ | eanres s ase| reech] cache] coos | Acanced e | 4l
labeling annotation tool. The configuration defined on this page is [l sowos .
+ Heitsbra

reflected in the spine labeling window when you activate the Ca—|
annotation tool. To display the advanced settings page, select © Diktspace

Customize Settings from the Settings menu, and click on the Spine R | 24 N = e
tab. ™ Include LE

™ Reverse Direction
™ Show lines

The spine labeling function is an annotation tool used to quickly = _ f;“'ﬁjr o
label the components of a spine. When activated, the user clicks —

on an image, and the next spine label appears. Subsequent clicks B
add the next label. To progress smoothly through the spine without

requiring user interaction, defaults are needed. This page provides * ]

the default settings used by the spine-labeling annotation tool.

" Thorical verterae ¢ C-C Interspace

 Lumbar vertebrae ¢ Other Interspace

Cancel Reset All

Section | Settings Default | Description
Initial Vertebra Enabled | This is the starting point for the vertebral labels. Select
Settings the starting vertebra. If the Vertebra radio button is
selected, the tool defaults to labeling vertebral disks.
Disk Interspace Disabled | This is the starting point for the disk interspace labels.

Select the starting disk interspace. If the Disk Interspace
radio button is selected, the tool defaults to labeling disk

interspaces.
Include L6 Disabled | If checked, include L6 in the list of lumbar disks. If clear,
L6 is not included in the default list of lumbar disks.
Reverse Direction Disabled | If clear, labeling progresses in the direction from cervical

to sacral disks. If checked, labeling progresses in the
reverse direction.

Show lines Disabled | If clear, labels appear with no lines connecting the label to
the focal point. If checked, lines connecting the label to
the focal point appear.

Label Cervical C Default prefix for new cervical disk labels
Texts Thoracic T Default prefix for new thoracic disk labels
Lumbar L Default prefix for new lumbar disk labels
Sacral S Default prefix for new sacral disk labels
Size Height/Width -- The height and width of the vertebra and interspaces,
used when locating the intersecting points on orthogonal
images. The value corresponds to the selected radio
button.
Cervical, Thoracic, Lumbar, - The object that corresponds to the reported height and
Sacral vertebra, C-C Interspace, width setting.

and Other Interspace
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4.2 User Profiles

PracticeBuilder 1-2-3 supports customizable user profiles. A user profile contains the configuration data,
viewer settings, hanging protocols, preset values and other information that make the user environment
unique for each individual.

The system stores the profiles on the PracticeBuilder 1-2-3 server(s), and downloads them to the
workstation when the user logs on. As a result, changes users makes to their profile while logged in at
one workstation automatically propagate to the next workstation when the user changes location.

4.2.1 CREATING USER PROFILES

PracticeBuilder 1-2-3 automatically creates a user profile when the administrator creates the user
account. A system default user profiles exists. After the user logs on and makes changes to the default
profile, the changes are stored back on the server. It is possible to use a user profile from an existing
account as the default when creating a new user account. This provides a method for setting up a set of
default user profiles, such as one for technologists, one for radiologists, and another for orthopedists, and
using this as the baseline profile when creating a new user account. For detailed information on creating
user accounts, refer to the PracticeBuilder 1-2-3 Operator’s Manual.

4.2.2 APPLYING USER PROFILES

When a user logs into PracticeBuilder 1-2-3, the user profile for that account automatically downloads to
the workstation and remains there until the next user logs in. The user does not need to take any explicit
action to apply their user profile.

PracticeBuilder 1-2-3 does not support the application of another user’s profile to your account. If you
want to add another user’s setting to your profile, such as a hanging protocol template or series of preset
window width and center values for a particular modality, you must set it up manually under your own
account, or remove your entire account and recreate it using the other user’s profile as the default.

4.3 Presets

PracticeBuilder 1-2-3 supports preset settings for window width and center, and hanging protocol
templates. Preset settings allow you to group together one or more settings to a specific function, and
then apply those settings all at once by selecting the tag from a list. In the case of preset window and
level, you can create modality specific window/level pairs, and apply them to a selected image by
selecting them from the list. In the case of hanging protocols, you can save the layout used to display a
particular study, and then apply it to another study by selecting the tag from the list. If the hanging
protocol assistant is active, it may apply the hanging protocol template automatically. In all cases,
presets speed up image organization and presentation.

4.3.1 WINDOW WIDTH AND CENTER

The preset list of window and level values provide a list of all saved window/level settings for a specific
modality type. The preset window/level list appears in the window/level toolbar. The list of preset values
is in the pull-down menu. A few default values exist in the preset window/level list.

e Initial corresponds to the default window width and center values applied when the image is first
displayed. These values come from, first, the window width and center values explicitly defined in
the image object, and, if none are explicitly defined, the actual or auto range, depending on the
settings in Customize Settings.

e Actual Range corresponds to a full window width, centered in the middle of the maximum range,
as defined by the encoded image information.

e Auto Range corresponds to the result of a histogram equalization analysis performed on the data.
In most cases, this results in a smaller distribution than the actual range due to the interpretation
of the pixel data values.
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To create a preset window/level entry, load an image into the image frame, and adjust the window width
and center to the desired values. On the window/level toolbar, click the Save button, located next to
presets list. An information box appears prompting you to enter a label for the settings. By default, the
label appears as the window width and center separated by a slash. If you want to use something other
than the default label, clear it and enter a new name. Complete the process by clicking on Add. The
label appears in the presets list.

To change the settings for an image, set the window width and center in the selected image, and enter
the name in the text field in the window/level toolbar. Click the Save button. A notice appears prompting
you to confirm overwriting the original settings. Click Yes to complete the change.

Instruction Summary — Creating and Changing Preset Window/Level Settings
» Load image in an image frame and set the window width and center.
» Enter the preset window/level setting label in the text field on the window/level toolbar.
» Click Save.
» If the label already exists, confirm the change by clicking Yes on the popup confirmation notice.

To remove a preset window/level setting, select it from the preset list. The button next to the list changes
to a Delete button. Click on the Delete button. A notice appears prompting you to confirm the delete
request. Click on Yes to remove the preset setting.

The Initial, Actual Range and Auto Range settings cannot be deleted or modified.

4.3.2 HANGING PROTOCOL TEMPLATES

Hanging protocols refer to the way PracticeBuilder 1-2-3 displays the images on the screen. It consists of
the grid layout, which series are loaded into which frames, the tile mode of each frame, the image in the
series that appears on top of the image frame, the location of the current and prior series, series links,
and frame characteristics such as window/level, zoom factor, and panning position. It can take some time
to set up a hanging protocol for a study. Having to do so for each study can impact user productivity. By
saving the hanging protocol as a template and then applying that template when you open a new study,
you can save time setting up the study. PracticeBuilder 1-2-3 allows you to save your hanging protocols
as preset templates.

Hanging protocol templates are available from the template toolbar. The template toolbar exists in either
the main viewing area or on the layout manager. Once you define your layout and load the images into
the emulated monitors, save the hanging protocol by selecting the Save button on the template toolbar. A
popup window appears prompting you for a label. This label appears in the template list to identify the
defined hanging protocol. Enter in a descriptive label for the configuration you just defined, such as
Default CT, or AP/Lat Chest with Priors. Click on OK to save the settings.

Instruction Summary — Creating a Hanging Protocol Template

» Load series into image frames, scroll to starting image, apply window and level, zoom and
position.
Enter the hanging protocol template label in the text field on the template toolbar.
Click Save.
If the label already exists, confirm the change to the existing template by clicking Yes on the
popup confirmation notice.

Y V VY

Hanging protocols defines the template based on the key-clicks used to organize the image series. For
example, on a CT study, if you put the first series (usually the localizer) into the first grid location, put the
second series into the second and third grids, with the second grid in stack mode and the third grid in a
2x2 tile mode, and a prior CT series in the fourth grid, the hanging protocol template consists of four
images frames, with the first series in the first grid, the second series displayed twice as stated, and the
prior in the last grid. When you apply the template to a study, the first and second series are displayed in
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three frames. If a prior exists, it will be in the fourth frame. If a third series exists, it is not loaded when
applying the template to a new study. If no prior exists in the new study, the frame is blank.

After defining one or more layout templates, apply them by selecting one from the pull-down list on the
template toolbar. Refer to section 5.2.3 for details on applying a hanging protocol template to study
images.

If you use one hanging protocol template more often than any other, you can define it as the default for
studies acquired from a particular type of modality. By doing so, the hanging protocol assistant
automatically applies the default template when you load a new study of the specified type. If you decide
to use another template, simply select it from the template list in the Layout Manager.

To define a default template, first create and save the hanging protocol template as previously explained.
To make a template the default, open the Customize Settings window (from the Settings menu) and go to
the Layout page. In the Settings For list, select the modality type you want the default template to apply
to, or Default to specify one template as an overall default. In the Template section of the same window,
select the template from the pull-down list. If the Template area is disabled, it is because the hanging
protocol assistance is active. To deactivate the hanging protocol assistant, clear the checkbox. After
setting the default template to use, re-enable the hanging protocol assistant to instruct PracticeBuilder 1-
2-3 to apply the specified template as the default when it cannot determine which template to apply
automatically.

Instruction Summary — Assigning a Default Hanging Protocol

Create and save the template you want to use as the default.

Go to the Layout page in the Customize Settings window.

Select the modality the default will apply to, or choose Default to set the viewer default template.
Disable the hanging protocol assistance.

Select the template from the pull-down list.

Re-enable the hanging protocol assistant to make the default apply only when no specific
template exists.

VVYVYVYVYVY

PracticeBuilder 1-2-3 records the window and level settings in the hanging protocol template if the
window width and center values exist as preset window/level setting. Before saving the template, define
and save the window and level settings as a preset W/L value. Apply the W/L settings to the images in a
frame. Then save the template as previously defined. The next time you apply the template,
PracticeBuilder 1-2-3 looks to see if the recorded W/L setting in the template matches a preset W/L
setting for the modality type. If defined, PracticeBuilder 1-2-3 applies it to the image. Since
PracticeBuilder 1-2-3 stores a separate list of preset W/L values for each modality type, it is likely that you
will not have the same named W/L preset for more than one modality. As a result, PracticeBuilder usually
applies preset W/L values to studies from the same type of modality that you used to create the template.

4.3.2.1 Hanging Protocol Assistant

The hanging protocol assistant is an automated pattern-matching algorithm that matches existing hanging
protocol templates to the characteristics of the study. When opening a study, the hanging protocol
assistant searches through the defined templates to find the one that best matches the study. If it finds a
good match, it automatically applies it to the study and everything appears in the PracticeBuilder 1-2-3
viewer ready to view. If no good match is found, the hanging protocol assistant uses the configured
default settings for the study’s modality type. If no match is found and no default configuration exists, the
assistant displays the layout manager so you can manually organize the study.

Turn the hanging protocol assistant on and off using the Use hanging protocol assistant checkbox on
Customize Settings’ Layout page. When enabled, the hanging protocol assistant inspects the
characteristics of the existing study, and selects the template you used in the past for a study with similar
characteristics. The assistant looks at the following study characteristics:

o study description e body part
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e modality e localizer image(s)
e number of studies e number of monitors
e number of series in study e monitor orientation

The hanging protocol assistant is like an expert system, meaning it learns from observing your behavior
as you use PracticeBuilder 1-2-3. As in any learning experience, the assistant initially knows very little
about your reading behavior. By defining and saving templates for different layouts, and applying them to
your study accurately, the hanging protocol assistant should be able to correctly select the best template
after a short period of time. The hanging protocol assistant learns by analyzing the studies characteristics
and noting the template you have applied when you close a study, and adds it to its rules base. If you
change the template before closing the study, the assistant will not learn how to apply them correctly.

4.4 Prestaging

All the PracticeBuilder 1-2-3 workstations support prestaging technology via the viewer prefetch function.
The viewer prefetch function consists of a prefetch worklist filter defined by each user, and a query
initiated by the viewer. When the query request yields information on new studies that match the prefetch
filter, PracticeBuilder 1-2-3 viewer retrieves the studies to the workstation and prestages them for viewing.

In addition to the prefetching function, the PracticeBuilder 1-2-3 dedicated workstation supports auto-
routing. The auto-routing function permits the workstation to have a prefetch filter, in addition to the
user’s prefetch filter. Auto routing transmits the studies that satisfy the workstation’s prefetch filter when
they arrive on the PracticeBuilder 1-2-3 server.

4.4.1 PREFETCHING

When the user enables prefetching from the server/prefetch page in the Customize Settings window,
PracticeBuilder 1-2-3 uses the worklist’s filter definition labeled Prefetch to select the studies to send to
the workstation. Define a filter that includes all the studies you want to prestage on the workstation, such
as all high priority (STAT) studies, or all unviewed studies that take place during your reading hours, and
save it as the prefetch filter. When the PracticeBuilder 1-2-3 viewer queries the server for new studies, it
applies the user’s prefetch filter and downloads the studies that are new to the list since the last query.

If no Prefetch worklist exists, PracticeBuilder 1-2-3 uses the Default worklist filter. Note that the Default
filter usually does not limit the number of studies and therefore will result in downloading many studies to
the workstation. This can unnecessarily slow down the network due to the additional traffic, and may fill
up your Viewer cache with irrelevant studies. It is recommended that if you use prefetching, you define a
worklist filter named Prefetch.

The server/prefetch settings page provides the only means for enabling and disabling prefetching. An
administrator can disable prefetching by logging in from the prefetching workstation as the user who
enabled it, and clearing the checkbox.

When enabled, prefetching occurs when the PracticeBuilder 1-2-3 viewer is loaded with a study and when
it is running in standby mode. Depending on the resources and performance of your workstation, you
may experience interference due to the background prefetch processing when using the viewer. If this
happens, select Prefetch in Standby Mode Only in the Customize Settings’ server/prefetch page. When
selected, prefetching will cease when you open a study in the viewer and automatically restart when the
viewer returns to standby mode.

Since prefetching continues to function after the user logs off of the workstation, excess data traffic can

result when too many workstations have prefetching enabled. Reduce the network traffic by reducing the
prefetch cycle time.
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4.4.2 AUTO-ROUTING

The PracticeBuilder 1-2-3 dedicated workstation can have its own prefetching worklist, independent of a
specific user. PracticeBuilder 1-2-3 calls this form of prefetching auto-routing. The Dedicated workstation
controls auto-routing through an auto forward filter configured on the PracticeBuilder 1-2-3 server.

Start by defining a filter for all the studies you intend to auto-route to the PracticeBuilder 1-2-3 dedicated
workstation. Assign a label and save the filter. On the Other Lists page, select the Auto Forward function
for the new filter. In the popup window, select the specific PracticeBuilder 1-2-3 dedicated workstation
device you want to route the matching studies to. Note that the dedicated workstation must exist in the
device table on the Devices web page. Click Apply to save the settings. When the dedicated workstation
is running, it periodically polls the PracticeBuilder 1-2-3 server. The default poll period is once every 30
seconds. When new studies that match the filter appear on the PB server, they are immediately
downloaded to the dedicated workstation.

When a user logs into the dedicated workstation, auto-routing adds the user’s personal prefetch worklist
filter to the query requests. When the user logs off of the PracticeBuilder 1-2-3 dedicated workstation,
prestaging returns to the workstation’s auto-routing configuration.

4.5 System management

Under normal circumstances, the PracticeBuilder 1-2-3 viewer handles all the routine maintenance and
system management functions. Nevertheless, a number of tools exist for manually verifying or overriding
the viewer’s regular procedures.

4.5.1 MONITOR CALIBRATION

Some digital modalities such as CT and MRI convey actual pixel size and spacing information. The
Practice-Builder 1-2-3 viewer uses this data to automatically render images using the correct aspect
ratios, calculate distances and area measurements, and display objects at their actual size. Some
devices, such as frame grabbers, including ultrasound, and film scanners, do not. For the modalities that
do not provide this information, PracticeBuilder 1-2-3 provides a calibration tool that the user can use to
help the viewer generate it. For detailed information on image calibration, refer to section 5.5.6.

Once the pixel size and spacing information is available, PracticeBuilder 1-2-3 still needs to have
information about the monitor in order to render images properly. For this reason, the user has the ability
to calibrate the monitor. While image calibration is needed for each study, monitor calibration is only
needed once for each monitor. However, for safety reasons, PracticeBuilder 1-2-3 prompts the user to
confirm the monitor calibration for each study. Since PracticeBuilder 1-2-3 records the previous monitor
calibration settings, if the monitor or display resolution has not changed, the user simply needs to confirm
the setting.

To calibrate a monitor, select the Calibration item on the Settings
menu, and select Monitor. A notice appears explaining how to use
the monitor calibration tool. If you do not want this notice to appear
each time, click on the checkbox that indicates you do not want to
display it again. Then click on Next. Using a ruler held up to the e
monitor glass, drag the horizontal and vertical rulers on the screen o
using the mouse until they reflect the actual size. When finished,
click on OK.

I [
Repeat this process for each monitor, using the Settings menu at the
top of each monitor to open the monitor calibration window for each respective monitor. Once you have
calibrated all of the monitors, you will not have to do it again until you either update the PracticeBuilder 1-
2-3 viewer, or modify the hardware or display settings.

Page 48



eRgpl — PracticeBuilder 1-2-3
ImageMedical Viewer Operator’'s Manual

4.5.2 EMPTYING CACHE

The PracticeBuilder 1-2-3 viewer cache can hold a lot of data, and therefore it may consume substantial
amounts of disk space. If you share your PC with other applications, you may find it necessary to reclaim
the disk space allocated to the viewer cache. Additionally, for security reasons, you may want to erase
image files from your system after you have finished using them. Typically, PracticeBuilder 1-2-3
manages its cache by clearing unnecessary files on an as-needed basis. Therefore, no intervention is
needed. Nevertheless, PracticeBuilder 1-2-3 provides manual and scheduled cache clearing functions to
remove lingering data files from the disk.

To manually remove the data from the PracticeBuilder 1-2-3 cache, select the Empty Cache function from
the File menu or from the Customize Settings’ cache page.

Instruction Summary — Purging Cache
» From the File menu, select Empty Cache
OR
» From the Settings menu, select Customize Settings
» Select the Cache tab
» Click on the Empty Cache button

To schedule a recurring purge of the cache, go to the Customize Settings’ cache page. Click on the
Purge Files from Cache after N days checkbox and set the number of days field. As long as
PracticeBuilder 1-2-3 is running in standby mode, it will automatically empty the cache every Nth day.

Instruction Summary — Schedule a Recurring Purge of the Cache

From the Settings menu, select Customize Settings

Select the Cache tab

Click to put a check in the box labeled Purge Files From the Cache
Enter the number of days after which a purge will take place

Click on the Settings tab

Click to put a check in the box labeled Standby Mode

VVVVYVYVY

4.5.3 RUNNING OTHER PROGRAMS

The PracticeBuilder 1-2-3 active-X and standalone viewers are both designed to function alongside other
Windows applications. Provided the other applications are designed to do the same, any user should be
able to run any application while the viewer is running, whether it is in standby mode or active with a
study loaded.

The PracticeBuilder 1-2-3 dedicate workstation is different from the other PracticeBuilder 1-2-3 viewers in
that it restricts access to the workstation. This provides PracticeBuilder 1-2-3 more control over the
system’s resources, and give the administrator better control over the use of the equipment. In order for
other applications to execute, the administrator must register them in PracticeBuilder. Depending on how
the admin registers the application, it can start automatically when PracticeBuilder 1-2-3 initializes, or can
be run interactively when the user selects it from a pull-down list.

EvccutablZ oS = Any user can invoke configured commands from the Run
_ menu on the PracticeBuilder 1-2-3 dedicated
coe o s | _wem | workstation. If the user account has Admin privileges

assigned, the Configure item appears in the Run menu.
' o | Use Configure to add or modify commands in the run list.
! A popup window appears. Enter the application
!_H EH—I executable and path, its arguments, and select when to

activate the application. Save the settings. To start the
Cance automatic applications, you must restart PracticeBuilder
1-2-3 by logging back into the workstation.

Command

Parameters:

Direclory
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4.5.4 LICENSING

The use of the PracticeBuilder 1-2-3 active-X and dedicated workstation viewers require a valid license.
All PracticeBuilder 1-2-3 licenses are customized for and installed on the server. When the user logs into
PracticeBuilder 1-2-3, the server checks that the license is installed and permits the operation requested.
Administrators can review the licensed components in the User License Information section of the Server
web page.

The PracticeBuilder 1-2-3 active-X viewer requires the basic standard license. The dedicated workstation
requires workstation licenses.

Plug-in licenses are managed separate from the basic and workstation licenses. A user is licensed to use
the specified plug-in module if the server the user is logged into has the plug-in license installed. Since
the plug-in license is server-based, it is possible for a user to have access to the plug-in module when
logged into one server, and not have access to it when logged into another.

4.5.5 PERMISSIONS — OPEN RIGHTS, REPORT RIGHTS

Use of the PracticeBuilder 1-2-3 active-X and dedicated workstation viewers are privileged operations.
To invoke the viewer, the administrator must have assigned Open rights to your account. If you receive a
notification when attempting to open a study in the viewer informing you that you are unable to access the
viewer application, contact your system administrator and request Open privileges..

The viewer has the ability to edit reports. Note that editing a report includes changing the state, adding a
key image, saving a processed series back to the server, dictating a report, approving a report or making
notes on the report page. Report edits require Report rights. If you are unable to save changes made to
the study from the PracticeBuilder 1-2-3 viewer, contact your system administrator and request Report
privileges.

4.5.6 NETWORK TRANSFER OPTIMIZATION

The best setting for optimized data downloads across a local area network is to use no compression and
large data packets in the network transfers. Conversely, the best setting for optimized downloads across
a wide area network is compressed data and small packet sizes. PracticeBuilder 1-2-3 automatically sets
these settings based on its configuration and on measured feedback it obtains during each download
operation. Nevertheless, it is possible to override these and force a specific compression application or
network packet size.

PracticeBuilder 1-2-3 supports settings to define what address ranges constitute the local area network.
They are defined in the LAN domain field on the server’'s Server web page. Any IP address not on this
list is deemed accessible via a wide area network. PracticeBuilder 1-2-3 uses these settings to
automatically adjust the compression setting and the initial network packet sizes for data transfers
between its server and viewer.

The user can override these automatic settings from the customize settings window in the PracticeBuilder
1-2-3 viewer. The Advanced page controls the compression setting for download of the study summary
information, and the packet size for all transfers. The Server/Prefetch and Image pages control the
compression setting for the download of the image data. When set to Auto, these settings are
dynamically set based on the PracticeBuilder 1-2-3 LAN domain setting, plus the measured feedback
PracticeBuilder 1-2-3 obtains during each download operation. In almost all situations, Auto yields the
best overall download performance.
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5 Displaying Images
The primary function of the PracticeBuilder 1-2-3 viewer is to display full-fidelity images for primary

interpretation. This section contains information on how to open and manage the viewing area, load a
study, organize the images once they load, manipulate the data, and save your changes before closing.

5.1 Opening a Study

How you load a study into the PracticeBuilder 1-2-3 viewer depends on which viewer you use and where
you start. In all cases, the first step is to display a list of available studies. The tools available for
displaying the study list differ slightly among the different viewers. The sections that follow describe how
to select one or more studies to load into the PracticeBuilder 1-2-3 viewer, how to navigate to other
studies once you have one open, and what the different viewing modes mean.

5.1.1 OPENING A STUDY IN THE DEDICATED AND STANDALONE WORKSTATIONS

In both the PracticeBuilder 1-2-3 dedicated workstation and standalone viewer, you obtain a list of
available studies by displaying the Study List window, shown below. The study list contains a table of
studies that exist on the CD/DVD (standalone viewer) or in the local cache (dedicated workstation). In the
dedicated workstation, it is possible to obtain a list of all available studies on the server by clearing the
Local Only checkbox at the top of the study list window.
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To load a study, open the study list window by clicking the button, , in the Standard toolbar, or selecting
CD Contents or Study Panel from the View menu. The study list has many of the functions available on
the browser worklist, including sorting and filtering (dedicated workstation only) capabilities. Using these
functions, locate the study you want to load. Click on the patient name, or the open button, E, on the left
side of the row.

To open multiple studies at one time, use the batch open function in the study list window. Using the list
filter and sorting functions, get all the studies you want to load onto a single page in the study list. For
each study, click to put a check in the box on the far left of each row. When all the studies are marked,

click on the batch open button, E in the top left corner of the study list.

If PracticeBuilder 1-2-3 finds prior studies when attempting to open a study in the dedicated workstation, it
displays them in the study list. The study you select is indicated by the shaded row. The other studies
are relevant priors that have been prestaged from the archive. If using the PracticeBuilder 1-2-3
dedicated workstation, you can inspect the archive for other studies by selecting Archive List from the
View menu to display the archive panel. Select studies from the archive list to retrieve them an load them
on the PracticeBuilder 1-2-3 server. Note that they will not automatically route to your workstation. Clear
the Local Only setting to get the server worklist, and load the study.
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To continue loading the studies, select the ones you want to view by putting a check in the box on the far

left of each row, and click on the batch open button, E,in the top left corner of the study list. The
PracticeBuilder 1-2-3 viewer loads the studies. Note that the relevant priors may have been prestaged to
the PracticeBuilder 1-2-3 server and not auto-routed to the dedicated workstation. If this is the case, you
may notice a delay as they transfer from the server.

PracticeBuilder 1-2-3 does not support adding a new study to a list of studies already open in the viewer.
If you need to add a study to your viewer, you must save your work, close the current study, and open it
again, this time adding the additional study to your list of selected studies.

5.1.2 OPENING A STUDY IN THE ACTIVE-X VIEWER

The PracticeBuilder 1-2-3 active-X viewer is a downloadable application that displays images stored on
the PracticeBuilder 1-2-3 server. When you log onto the server, PracticeBuilder 1-2-3 checks to see if
you have permission to display images in the active-X viewer. If so, it checks the version of the viewer
currently installed on your workstation. If no PracticeBuilder 1-2-3 active-X viewer exists, or a newer one
exists on the server, the viewer automatically downloads to the workstation. Under certain
circumstances, you may be prompted before the download begins. You are advised to always download
and install the latest version of the PracticeBuilder 1-2-3 viewer. Follow the instructions in section 2.3.2 to
install the active-X viewer. When complete, you are ready to open studies.

Opening a study in the PracticeBuilder 1-2-3 active-X viewer starts with the worklist page in the web
browser. Request a study by clicking on the hyperlink in the Patient Name column, or click on the Open
button to the left of the study information on the worklist. To open multiple studies at one time, use the
worklist filter function and page size field to get all the studies listed on one worklist page, and then check
the box on the far left side of each row. At the top left corner of the worklist, click on the batch open
button. The PracticeBuilder 1-2-3 viewer loads all the selected studies.

Before opening the viewer, PracticeBuilder 1-2-3 checks the database for relevant priors that match the
selected list of studies. If it finds any, it displays the list in a new worklist. The study you selected is
identified by the shaded row. Select the studies you want to include by putting a check in the box to the
left of each line, and click on the batch Open button at the top left corner of the worklist. If you want to
open just one of the listed studies, click on the patient name hyperlink, or the Open button in the study’s
row.

For additional information on selecting a study list from the PracticeBuilder 1-2-3 worklist, refer to the
PracticeBuilder 1-2-3 Operator’'s Manual.

If the PracticeBuilder 1-2-3 active-X viewer is running in standby mode, it will appear on the screen rather
quickly. If standby mode is disabled, Windows will load the program into memory, and then it will appear
on the screen. Since this involves reading the application from disk and loading it, it may take a
considerable amount of time to launch the viewer, depending on the configuration of the workstation. To
improve the time to launch the viewer, run it in standby mode. See section 4.1.1 for information on
enabling standby mode.

There are two stages to opening a study. The first is the transfer of the study information from the server
to the viewer. This occurs regardless of the whether or not the study already exists in the viewer’s local
cache. The progress of this download is shown by a blue line progressing across the Status bar, and by
a completion percentage displayed in the far right of the Status bar. When the transfer completes, the

EE| viewer has all the information it needs to display the thumbnail
£ images, select a hanging protocol template, and start loading the
—— L images and report data.

The second stage of opening a study in the PracticeBuilder 1-2-3 viewer is the loading of the image and
report data. First, PracticeBuilder 1-2-3 checks the local cache to see if the data is already on the
workstation. If found, the data is loaded from disk. Otherwise, the viewer pulls the data across the
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network from the PracticeBuilder 1-2-3 server. If redirection is enabled, the viewer pulls the data over
from the closest server to minimize network traffic and download time. A blue progress bar
located along the bottom edge of each thumbnail image shows the progress of each image
download. To instruct PracticeBuilder 1-2-3 to download a specific image first, load that
thumbnail into a frame in the main viewer workspace. All the series loaded into the main
viewing workspace go to the front of the download queue, and the images displayed at the
top of each frame get downloaded first.

5.1.3 OPENING NEXT AND PREVIOUS STUDY

In the PracticeBuilder 1-2-3 viewer, the user can immediately open the next study in the worklist by using
the Ctrl-Alt-Down keys. Similarly, the Ctrl-Alt-Up keys open the previous study in the worklist. These

functions are also buttons available in the Standard toolbar, and .

To determine the next study, PracticeBuilder 1-2-3 first applies the current filter to the database, then
finds the study you currently have open, and finally, opens the study that immediately follows it on the
worklist. For the previous study, PracticeBuilder 1-2-3 does the same except it chooses the study that
immediately precedes the current study on the worklist. The viewer does not qualify the study, meaning it
is not possible to use the next/previous feature to open, say, the next Unviewed study. To accomplish
this, you need to apply the appropriate worklist filter prior to using the next/previous function.

When you use the next/previous function, you are required to respond to any prompts that appear before
PracticeBuilder 1-2-3 will close the open study. For example, if you have entered a report but failed to
send it to the server, the viewer prompts you to either send it or delete it. Once you have cleared all the
prompts, the current study closes and the next one opens without having to re-launch the viewer.

5.1.4 SAVE CURRENT WORKSPACE TO OPEN ANOTHER STUDY
When using the PracticeBuilder 1-2-3 viewer, a user can bookmark his or her work, and return to it later.

To bookmark the active study, click on the Bookmark button, @ or select Bookmark from the File menu.
PracticeBuilder 1-2-3 saves the study’s current state, including the image layout, selected key images,
annotations, dictations, and study state. After bookmarking a study, it is safe to close the study and open
the viewer again with another study, log out of the system, or open the same study again. To reload a
bookmarked study, close the study you opened after bookmarking the original, or click on the Restore
button, o you changed user accounts, you need to re-login in as the original user to return to the
bookmarked study state.

If the PracticeBuilder 1-2-3 viewer is open with a study that contains edits, PracticeBuilder 1-2-3
bookmarks it for the user automatically if the auto-logout timer expires. To restore the study, log in, open
the viewer from the system tray, and click on the Restore button.

5.1.5 STUuDY LOCKING AND READ-ONLY MODE

If you open a study but cannot make changes, the study is in read-only mode. This applies when you
open a study from a CD, do not have report editing privileges or some other user has the study open
already. When in read-only mode, you receive a notification informing you of this. You can continue to
look at the study, but no changes you make are recorded. Some users may be given the ability to
override the read-only privileges. If you have this ability, the

notification informs you of who currently controls the editable k] &
version of the study, and prompts you to break the lock, as seen in The stucy of Eideiman, Lori &
the screen shot shown here. If you select to break the lock, you /N hes b ocked by Admteter

have the only write-enabled copy of the study. The other user

does not receive any warning, and will not be able to save any BookLock | _Open ReadOnly |
additional changes. It is advisable to verbally notify the user listed

in the notification that you intend to break their lock before doing so. This provides the user with the only
warning, giving them an opportunity to save their work before they lose the ability to save changes.
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5.2 Organizing the Study Data

Displaying images with PracticeBuilder 1-2-3 is completely customizable. You can change the
characteristics of the display area, and specify how much of the window you want an image to occupy.
You can stack images, tile them, increase and decrease image size, flip, rotate and invert images,
change the window width and center, invert the grayscale slope, run a cine loop for a set of images,
magnify images, change image attributes, and more.

The primary tools for organizing the images are the thumbnail panel, the layout manager and the hanging
protocol assistant. The thumbnail panel contains a subsampled rendering of each image, usually
grouped into series. The thumbnail panel exists to the left of the main viewing area, and is available at all
times. The layout manager is a popup window that consolidates the entire viewing area across all
configured monitors into a manageable popup window. From the layout manager, you can define the
viewing workspace, organize the images, and save the settings as hanging protocols. The hanging
protocol assistant automates the application of hanging protocols. It interprets study characteristics and
finds an appropriate hanging protocol to apply.

5.2.1 THUMBNAIL PANEL

The thumbnail panel lists all the available series. By default, the thumbnail panel is hidden. To display
the thumbnail panel, select it from the View menu. When displayed, the thumbnail panel appears on the
right of the main viewing area. See section 3.4 for details on the thumbnail panel.

Load a series of images from the thumbnail panel into the main viewing workspace by either double-
clicking on the thumbnail image, or click and drag the thumbnail image to the viewing area using the left
mouse button. To overwrite an existing set of images, use the drag-and-drop method. When you drop
the series into a populated image frame, the new series replaces the previous one.

To concatenate multiple series into a single frame in the viewing workspace, hold down the Ctrl key while
you drag and drop the series into the desired frame. When concatenating images and series into a single
image frame, the cursor changes from the normal drag-and-drop cursor to one with a plus sign (+). This
mode indicates the series being dragged will be added to the images that already exist in the frame.

To quickly load all of the series in a study into the main viewing area, d,wfi_kL
double-click on the study’s header. This method for loading series into

the viewing workspace sets the viewer's grid across all available  Study Header
monitors to accommodate all of the series, and then loads on series into

each image frame. The maximum number of image frames
PracticeBuilder 1-2-3 creates on a single monitor is based on the monitor

size, but is somewhere around 16. If more series exist than image frames, only the first few series are
loaded. Use the drag and drop method of loading series to replace the series displayed in one of the
image frames.

Instruction Summary — Loading Images Into Image Frame
To load the thumbnail in the next open image frame:
» Position the cursor over the thumbnail image and double-click the left mouse button.

To load or overwrite the thumbnail in a specific image frame:
» Click and drag the thumbnail image using the left mouse button to the selected image
frame and release.

To concatenate multiple thumbnails to a single image frame:
» Load the first thumbnail series into an image frame.
» While holding down the Ctrl key, click and drag the second thumbnail image/series into
the same image frame.
> Repeat as necessary, until all series are loaded into the selected image frame.
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To load an entire study:
» Position the cursor over the study header and double-click the left mouse button.

5.2.2 LAYOUT MANAGER

The layout manager consolidates the entire viewing area across one or more monitors into a compact
popup window. Depending on your configuration, the layout manager may appear automatically when
you load a study. When hidden, display the layout manager by selecting it from the View menu. For
details on the layout manager, refer to section 3.6.1.

The first step in loading the images into the viewer workspace from the layout manager is to select the
grid layout. From the grid tools toolbar, select the number of image frames you want to appear on each
monitor. If you want a single grid to span across all your monitors, select the span button, &1, To
apply a different grid to each monitor, ungroup them. By default all monitors are grouped. The white
frame around each monitor in the layout manager notes this. Select each monitor independently by
clicking on the colored (blue or gray) title bar in the monitor in the

layout manager. When only one monitor is selected, assign the Colored title bar
grid layout. To regroup all the monitors together, press and hold
the CTRL key when clicking on the colored title bar. Lavout Henager ;—,emls Tocks

o= e = e e e N (T T
- Save

The layout appears on the emulated monitors in the Layout
Manager. Each time you click on a predefined grid button, the
layout will change. You can resize the frames in the default grid
by placing the cursor over the boarder lines in the emulated
monitor, clicking the left mouse button, and dragging the line to
obtain the desired size.

Loading the images into the grid is the same from the layout [ R EETERIY
manager as from the thumbnail panel. Refer to section 5.2.1 for ]
information on loading the series into the viewing workspace.

PracticeBuilder 1-2-3’s default display mode is to display the layout manager when the study loads. If
you want to prevent the layout manager from appearing each time you launch a study, set it to remain
hidden until manually activated. Open the Customize Settings window and go to the layout page. Clear
the checkmark in the box labeled Show Layout Manager to hide it. A check in the box instructs
PracticeBuilder 1-2-3 to always display the layout manager. If the checkbox is disabled, it is because the
hanging protocol assistant is enabled. In this case, temporarily disable the hanging protocol assistant by
clearing the checkbox labeled Use hanging protocol assistant. Make your changes to the other settings,
and then re-enable the hanging protocol assistant by putting a check back in the box.

5.2.3 HANGING PROTOCOLS

PracticeBuilder 1-2-3 provides hanging protocols for improving the time needed to organize the image
data in the viewer. A hanging protocol is a record of how the series and images in a particular study are
arranged in the main viewing workspace. You create hanging protocols by saving the current layout
under a defined template name. When you select the hanging protocol template, PracticeBuilder 1-2-3
applies the grid layout, and then moves the series and images into the defined image frames. It also
applies the defined linking state, window and level settings, zoom factor and frame position. See section
4.3.2 for a thorough description of hanging protocols.

Apply a hanging protocol by selecting the template from the Template toolbar. The Template toolbar can
exist in the layout manager or the main viewing workspace. Click on the arrow button to display the list of
available templates. Select the desired entry. PracticeBuilder 1-2-3 applies the template to the current
study to the best of its abilities. If one or more series defined in the template do not exist in the open
study, PracticeBuilder 1-2-3 leaves the image frame empty.
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Instruction Summary — Applying a Hanging Protocol Template
» Open a study in the PracticeBuilder 1-2-3 viewer.
» From the template toolbar (in the main viewing area or layout manager), select a predefined
template from the pull-down list.

The hanging protocol assistant is the tool that automatically checks the characteristics of the new study
against the defined hanging protocol templates, and selects one to apply. If no good match is found, the
hanging protocol assistant pops open the layout manager. Otherwise, it displays the series and images
as the template specifies. For detailed information on how the hanging protocol assistant selects a
template, refer to section 4.3.2.1.

When you end a study session, the hanging protocol assistant makes a note of the studies characteristics
and the template you have applied at that time. The assistant analyzes this information and adds it to its
rules base. Note that if you change the template before closing the study, the assistant will not learn how
to apply them correctly.

5.3 The Viewing Area

The PracticeBuilder 1-2-3 viewing workspace displays the full-fidelity diagnostic images. This area makes
up the majority of the graphical user interface, and is generally clear of any formatting or obstacles. To
render the images in a manner conducive to each user’s individual preferences, the user can apply
different tools to manipulate the area’s layout. The user can apply a predefined or custom grid layout,
display images in a stack mode or in a tiled mode, create a common or disassociated environment across
all monitors, and quickly hide all screen objects except the image to eliminate any distractions the
interface may cause.

5.3.1 GRID LAYOUTS

PracticeBuilder 1-2-3 uses a dynamic grid to display images in the main
viewing workspace. For example, a common grid layout is a 4-up
symmetrical grid, consisting of two rows and two columns, as shown here,
before adding the images. You can select from predefined grid
configurations, define custom symmetrical grids, and create asymmetrical
grids using the framing tool.

The tools for selecting and creating a grid pattern are available from both
the main viewing workspace and the layout manager. The most common
tool used for choosing a grid layout is the Grid toolbar. Click on the button showing the grid layout you
want to apply to the main viewing workspace. You can also select a grid layout from the Grid layouts
submenu on the Settings menu. On PracticeBuilder 1-2-3 workstations with multiple monitors, you can
apply a different grid layout to each one. By default, all monitors use the same layout. To set just one,
open the layout manager, and click on the colored title bar of the graphic that represents the monitor you
want to make unique. The white border appears around the selected monitor only. Click the button on
the grid toolbar to set the monitor setting. To move to another monitor, select it by clicking on the colored
title bar. To group all the monitors again, hold the CTRL button while clicking on the colored title bar. A
white border appears around all the selected monitors.

Each frame in a grid contains an independent instance of the images. This means when you place an
image or series in multiple frames, each instance has its our display characteristics, such as window and
level setting, zoom factor, orientation, and any characteristics. For example, you can render the
abdominal series of a CT study in two different frames, and apply a tissue window/level setting to one
frame and a lung setting to the other.

When you select a grid pattern, the defined frames always remain on the screen. However, you can
change the size of each to the frames by dragging the borders to enlarge or reduce their size. When you
place the mouse cursor over the line separating the grid’s individual frames, the cursor icon changes to
either a two-directional arrow or a four-directional arrow. The cursor indicates the direction in which you
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can move the border. While holding down the mouse button, drag the mouse and the grid changes size.
If you have the images displayed as Fit to Window, the image size changes in relation to the grid size.
Once you have loaded the images into the image frames, you can rearrange Frame dragging hook
them by dragging them from one frame to another. When you move the L)/
images to another frame, the images in the destination automatically move to
the original frame. Basically, you are switching the data in the two frames. |If
the destination frame is empty, the original frame clears after the move.

UIELUT LU LU ISLILLLU

Level [ 8255 —J—

To move the images from one frame to another, position the mouse over the
top left corner, over the two diagonal lines. The cursor changes to a hand.
Click and hold down the left mouse button. Drag the frame to any other frame
in the viewing workspace. Release the mouse when your cursor is situated
over the destination frame.

To clear the images from a frame, drag the frame back to the thumbnail panel (on the main viewing
workspace or in the layout manager.) You can quickly clear all the series by selecting a new grid layout
from the grid toolbar.

5.3.1.1 Customizable grid layouts
The grid toolbar offers the user a fixed set of grid layouts. These consist of 1-up, 2-up, 4-up, and other
symmetrical layouts, plus an asymmetrical 3-up. Two methods exist for creating custom grid layouts.

The custom grid button, @ on the grid toolbar enables you to create symmetrical grids that are not
already available. Click on the custom grid button. A popup window appears prompting you to enter the
number of rows and number of columns to apply to your grid layout. After entering the values, click OK.
PracticeBuilder 1-2-3 applies the defined row and column count. A limit to the number of rows and
columns does exist. The particular limit depends on the resolution of your monitor.

The second customization tool creates asymmetrical grid layouts. With the frame-splitting tool, you can
split existing frames in half. Each frame created has the same independence as any of the default grid
frames, meaning you can insert any group of images into customized frames and apply a window and
level, zoom factor, orientation, etc., to it. You can also save these customized layouts as templates.

To customize a layout, start with the best-fitting predefined grid layout from the grid toolbar, or use the
Grid layouts submenu on the Settings menu. To split any one of the available frames into two
independent frames, click to select the frame you want to split into two frames. From the Grid layouts
submenu from the Settings menu, go to Split selected cell, and choose the position of the new frame
relative the selected frame. A new, empty frame appears next to, above or below the original frame. To
remove one of the frames, repeat the procedure, except select Join selected cell from the Grid layouts
submenu.

5.3.2 TILE LAYOUTS

By default, each grid displays the series in stack mode, meaning the image at the top of the stack takes
up all the space in the frame, with the other images behind it. This is actually a 1-up tile mode. You can
expand the stack into individual image slices by selecting different tile mode. For example, if you want
the images in a frame to appear similar to a common 12-up sheet of film, you would apply a 12-up tile
mode, with four rows and three columns. PracticeBuilder 1-2-3’s tiles modes are on the Tile toolbar,
which is available in the main viewing workspace and the layout manager.

A toll exists for defining a custom tile layout. On the Tile toolbar, click the custom tile button, B, and a
popup window appears prompting you to enter the number of rows and columns to apply to your frame.
After entering your preferences, click OK, and PracticeBuilder 1-2-3 applies the tile mode to the selected
frame. Note that the number of rows and columns you can use is limited. The particular limit depends on
the resolution of your monitor.
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5.3.3 FuLL ScREeN MoDE

PracticeBuilder 1-2-3 provides a display mode that removes all screen objects, such as the toolbars,
menus, thumbnails, and Windows taskbar, and displays the selected frame as large as possible on the
monitor. This permits you to eliminate all potential distractions and extraneous light from the screen,
leaving just the pixel data in the image object.

To display an image in the full screen mode, click on the frame and then press the F5 function key. While
in full screen mode, you can apply most functions PracticeBuilder 1-2-3 makes available on the mouse,
including window and level, panning and zoom. To return to the normal display mode, press the ESC
button, or click the close button in the top left corner of the image.

5.4 Managing Series

PracticeBuilder 1-2-3 groups all images into series, usually as defined by the imaging source. In some
cases, the series is defined as sequential images acquired as a result of a single pass through a scanner.
Other times, they may be a collection of seemingly random screenshots. Generally speaking, a series is
just a collection of one or more images. Each series in a study appears on the thumbnail panel and in the
layout manager.

The sections that follow contain information on how to organize and manage series of images.

5.4.1 GROUPING AND UNGROUPING SERIES

By default, PracticeBuilder 1-2-3 uses the series grouping defined when the study was created.
Sometimes, studies contain images grouped into series that users general prefer to view individually.
PracticeBuilder 1-2-3 provides tools for automatically separating images based on their orientation,
ungrouping series into single-image series, and manually splitting a series into one or more series.

5.4.1.1 Automatic Series Splitting

Imaging modalities group images together in a number of ways. For example, one vendor's CT may
group the localizer image together with the first sequence of axial images, while another vendor's CT
separate the localizer into its own series. PracticeBuilder 1-2-3 can look at the orientation of each image
in a series, and regroup them accordingly. If configured to perform this check, the studies from both CTs
in the example appear in PracticeBuilder with the localizer image in one series and the axial images in a
second series.

Settings | View  Layout |Image To enable this check, open the Customize Settings window, and select the
Layout page. In the Automatic Settings section, check the Split Series box.

— Monitor setting

v Multiple monitor

—Automatic settings

W Find localizers
v Split zeries

This setting can be assigned to any modality, or to all modalities by selecting
the modality label in the Settings For menu.

Another automatic series splitting function addresses the situation when an
imaging device put multiple images into a series and the user prefers they be
managed independently. An example of this is when a CR acquisition system

WV Sort series puts both the AP and lateral x-ray into a single series. PracticeBuilder 1-2-3
w length: {0 can be configured to separate all images in a series into individual series. This

is most useful when the number of images in the series is fairly small. For this
reason, PracticeBuilder 1-2-3 uses a threshold to define the point at which it will separate the images into
separate series, or keep them together.

To force all images in a series into separate series, open the Customize Settings window and go to the
Layout page. Insert a non-zero value into the Series Split Length field. The value refers to the point at
which the images remain in a single series in the Layout Manager and Thumbnail Panel. For example, if
the value is 4, PracticeBuilder separates each series with 1 through 4 images into 1, 2, 3 or 4 series. For
series with more than 4 images, PracticeBuilder leaves the series intact. A value of 0 means the function
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is disabled. This setting applies to the selected modality type only. The Default setting does not apply to
this function.

5.4.1.2 Concatenating Series

When loading images into an image frame, PracticeBuilder 1-2-3 copies each series to a separate grid
location. To load two or more series into a single image frame, you must use the drag-and-drop
mechanism as described in section 3.4 while holding down the CTRL key. Series concatenation is noted
in the cursor. With the CTRL key depressed, the icon includes a ‘+’ marker, indicating you are adding the
selected series to the existing image frame, rather overriding it.

5.4.1.3 Manually Splitting and Joining Series

PracticeBuilder 1-2-3 provides the tools needed to manually split one series into two or more series. Start
by scrolling through the thumbnail images, or the images in an image frame, until you arrive at the
position where you want to insert the break. Right-click on the thumbnail image to display the popup
menu. From the Tools menu, select Series, and then Cut series. A new series appears in the thumbnail
panel or in the layout manager. The original series contains the images up to the break point. The new
series contains the images from the break point to the end. Note that any instance of the series left in the
main viewing area contains the original image series.

If you or PracticeBuilder 1-2-3 has separated a series and you want to join it together again, select the
frame. From the Tools menu, click on Series, and then choose Join series forwards or Join series
backwards. One of the two series will disappear from the thumbnail panel and layout manager. The
resulting series contains the images from both original series.

5.4.2 SORTING SERIES

By default, PracticeBuilder 1-2-3 displays images in the order in which the modality acquired them.
Unfortunately, scans frequently occur in both directions when the procedure calls for multiple series. In
these cases, the first and last images in the series are opposite each other. This makes linking series
irrelevant. To address the problem, PracticeBuilder 1-2-3 can sort the images based on slice position
(relative to the patient) so that the order of the images in each series is the same.

To set it, open the Customize Settings window from the Settings menu. Go to the Layout page, and
check the Sort Series box in the Automatic Settings section of the panel.

If you want to enable the sort for all modalities, first select Default from the Settings For: list. If you want
to override the default setting, choose the modality you want from the list and enable or disable the sort
setting in the checkbox. The setting will take effect the next time you launch a study.

5.4.3 LINKING SERIES

PracticeBuilder 1-2-3 has the ability to link together multiple series into independent groups of linked
series. For example, if you have four series rendered in the viewer, you can link two series together into
one link group, and link the remaining two together into a second link group, and have the two sets
operate independently from each other. You can create up to 8 independent linked groups
simultaneously.

To create a link group, click on the Link cursor mode button, E, or click the middle mouse button until the
Link mode appears. When in Link mode, move the cursor to the first frame you want in the link group,
drag the mouse to the second frame, and then release. You will see a link icon appear in the top left
corner of each frame. To add a third frame to the group, repeat the process, starting on either of the
currently linked frames, and ending on the new frame. To create an independent link group, perform the
same steps on two frames that do not belong to any other link group.

Instruction Summary — Linking Series
» Load two series into different image frames.
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» Select the Link cursor mode by clicking the Link button, 2,
» Position the cursor over the first series in the image viewing area.
» Click and hold down the left mouse button, drag it to the second series, and release.

By double-clicking the Link (or Link Icon) button, the Viewer automatically links together all series from
the same study, in the same image plane and tagged as spatially related to each other by the imaging
modality. While PracticeBuilder 1-2-3 still allows the user to manually link multiple series together, this
feature makes it faster by reducing the function to a single operation. When finished, you can identify
which series are linked together by matching up like-colored link icons (in the top left corner of the frame).
You can also manually add additional series to the automatically defined links, or unlink them.

To remove the link, select the frame you wish to remove from the link group, and then clear the check
from the box on the Cine toolbar, click on the Link item in the Cine menu, or click on the link icon on the
image.

PracticeBuilder only permits a frame to belong to a single link group. If you need to connect a frame to
two different groups, you need to remove the original link. If you attempt to attach the frame to another
link group, you will be prompted to acknowledge the ungrouping from the first group.

5.5 Managing Images

PracticeBuilder 1-2-3 offers a number of image manipulation tools for enhancing the data. You can
change the image’s window width and center, apply a zoom factor, flip, rotate and pan the images, and
stack them to emulate a cine playback. Many of these settings can be applied automatically through
hanging protocol templates, but they are most flexible when applied manually to individual situations. The
sections below provide detailed information on applying image enhancement tools to the images loaded
in the PracticeBuilder 1-2-3 viewer.

5.5.1 STACK MODE SCROLLING

PracticeBuilder 1-2-3 includes a 1-up, stacked frame tile mode. This tile mode can appear in any image
frame, as explained in section 5.3.2. A few methods exist for scrolling through the images in the frame:

e Using a three-button mouse with a wheel, left-click on the frame to select it, and then spin the
wheel to scroll through the images. Reverse the wheel direction to scroll in the opposite direction.

e When the image is display in Fit-to-window mode (section 4.1.4) scrolling is available from the left
mouse button. Press and hold down the left mouse button while the cursor is over the image
frame, and drag the mouse back and forth to scroll up and down the stack. Release the mouse to
end the scrolling. Note that the left mouse button controls the panning function when the image is
not in Fit-to-window mode.

e The Up and Down arrow keys advance the image stack. Select the image frame using the
mouse, and then hit the Up or Down arrow key on the keyboard to move forward or backward
through the stack. The Home and End keys just to the beginning and end of the stack,
respectively.

By default, scrolling through a series of images may skip some slices in order to keep up with the drag of
the mouse. This enables users to advance through a large series very quickly, but is problematic when
you wish to smoothly progress through every image in the series. The Continuous Image Scrolling
setting on the Customize Settings’ Settings page (section 4.1.1) toggles between skipping quickly through
the images and forcing every image slice to appear. When enabled, PracticeBuilder 1-2-3 displays every
slice in the series if you drag the mouse and continue to hold it down until it reaches the desired image
frame.

In addition to these manual scrolling tools, PracticeBuilder 1-2-3 supports a cine mode that automatically
cycles through a series of images in an image frame. The cine mode setting is available in any image
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frame that contains more than one image. You can apply the cine mode setting to one or more of the
image frames simultaneously, and to linked image frames.

The cine mode controls are available from the Cine menu (section Error! Reference source not found.)
and the Cine toolbar (section 3.1.9). The cine mode controls include play/stop playback, step one frame
forward or back, cycle/reverse mode setting, and a speed adjustment.

To activate cine mode, select the image frame using the left mouse button, and select the Play option
from the Cine menu or toolbar. The images display at a rate defined by the speed control. To activate
cine mode in another window, repeat the process on the other image frame. If the frame is linked to one
or more image frames, all of them play back the images at the same display rate. To stop the cine mode
playback, select the image frame, and then the Stop option from the Cine menu or toolbar.

The Next/Previous functions in the Cine menu are equivalent to manually scrolling the image stack, as
described earlier in the section.

When the cine playback reaches the end of the image stack, the cycle/reverse mode setting defines how
PracticeBuilder 1-2-3 continues. In Cycle mode, cine playback cycles back to the beginning and repeats
the same sequence. In Reverse mode, cine playback reverses the direction and displays the images in
the reverse order until it reaches the beginning, at which time it reverses direction again, and continues.
By default, cycle mode is selected. Find and change the applied cycle/reverse mode setting from the
Cine menu or toolbar.

You can set the relative speed of the playback by adjusting the playback speed gauge in the Cine toolbar,
or selecting Faster and Slower from the Cine menu. The playback speed is not synchronized to any
clock, so there is no quantitative value to the speed setting. Use this feature simply to increase or
decrease the rate at which images in the stack appear in the frame.

5.5.2 WINDOWING AND LEVELING

PracticeBuilder 1-2-3 provides multiple tools for adjusting an image’s window width and center values.
These include a sliding gauge, mouse control, predefined setting, explicit numeric definition, a region of
interest histogram, and greyscale inversion. The customize settings includes some configuration
parameters for assigning default values to images with not predefined window width and center, and for
overriding those assigned values.

The quickest way to adjust the window width and center values for an image is by applying a preset
setting to the image frame. On the Window/Level toolbar, click the pull-down list to display the available
presets. Select one of the entries. The settings are applied to the selected image frame. For instructions
on setting a preset window/level setting, refer to section 4.3.1.

The simplest tool for dynamically adjusting the window width and center values is the mouse control.
Place the cursor over the image. The image can be a thumbnail or one that is loaded into an image
frame in the main viewing workspace. Press and hold down the right mouse button while you drag the
mouse. Right and left movements increase and decrease the window width. Backward and forward
movements increase and decrease the window center. When you release the mouse, PracticeBuilder 1-
2-3 updates the other images in the series by applying the same offset.

The mouse window/level tool applies the offset resulting from the mouse movement to all the images in
the selected series. For example, after releasing the mouse, the new settings may have increased the
window width by 10 and the center by —-50. PracticeBuilder applies +10 and -50 to the current
window/level values of each image. If the other images in a series start with a different window/level
setting, they will be different after using the mouse tool. To quickly update all the images to the same
window and level value, first apply a preset window/level setting to the series, and then adjust it using the
mouse.
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You can assign an explicit window width and center value to an image from the Window/Level toolbar.
Click in the text field next to the appropriate label, delete the present setting, and type a new value into
the area. Press the Enter key to apply it. If you enter in a value that is out of the range of pixel values,
PracticeBuilder 1-2-3 will set it to the maximum.

The other controls for setting window and level in the Window/Level toolbar are the sliders.
PracticeBuilder 1-2-3 distributes the possible range of values across the slider. By moving the slider left
and right, you can quickly change the respective value. Start by selecting the image. Then click and hold
down the window or level slider in the toolbar. Move the mouse left and right to move the slider. When
you have come to the desired value, release the mouse.

PracticeBuilder 1-2-3 provides a window/level tool that uses the pixel distribution within a defined region
of interest to calculate a window range with a center value set to the medium value, and then apply those
settings to the entire image. This is a quick method for applying a density-specific setting to the entire
image. For example, you can apply a bone window to an MRI object by selecting a part of the bone as

the region of interest. To define the region of interest, select the ROl with window/level cursor mode, ﬂ
and position the mouse cursor over the area in the image you want to define. Click and hold down the left
mouse button while you drag the mouse to define the region of interest. As you move the mouse, lines
outlining the region appear. Release the mouse to create the region. You can resize the region by
selecting one of the edges with the mouse and dragging it. Position the mouse cursor over the middle of
the defined region, click and hold down the left mouse button, and you can move the region around the
image. As you do, the window/level within the region continues to update, using the pixels within the
region to create the curve. Each time you release the mouse, PracticeBuilder 1-2-3 applies the window
width and center values from the region to the entire image. To remove the region of interest, click on the
image anywhere outside the region of interest area.

PracticeBuilder 1-2-3 supports an automatic inversion of the slope of the curve used to apply the window
width and center. The result is an inverted greyscale image. To apply this setting, select the image in the
image frame, and click the Invert image button, ™ in the Toolbox toolbar, or select Invert from the Tools
menu.

To reset the window width and center values of the images in an image frame, click on the reset

window/level button, ﬂ in the Toolbox toolbar, or select Window/level from the Reset submenu in the
Tools menu.

For color images, PracticeBuilder 1-2-3 can apply a greyscale color map in place of the color palette. The
result is a black and white rendering of the color image. To remove all color from a color image, click on
the Color/Greyscale button, , in the Toolbox toolbar, or select Greyscale from the Tools menu. Note
that of monochrome images, this feature is disabled.

At times, the images PracticeBuilder 1-2-3 receives have improperly encoded window width and center
values, or the technologist may have inserted erroneous values into the image objects. To accommodate
these situations, PracticeBuilder 1-2-3 provides configuration settings it can use to override some default
values. On the Image page in the Customize Settings window, three settings exist for working around
problems that may exist in images.

Use W/L Range — When the image object contains no preset window and level setting,
PracticeBuilder 1-2-3 can define the default range to use for calculating the values.
When this setting is enabled, PracticeBuilder 1-2-3 uses the actual range of pixels values
to define the default window width, and positions the window center in the middle of the
pixel range. When disabled, the defined minimum and maximum values are used to
define the window width, with the window center position in the middle of the range.

Auto W/L Setting — Some image objects include unused bits in their definition of the pixel value,
resulting in a very wide window width, even though the pixel data is confined to a
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considerably smaller area. When active, this setting overrides the study/series/image
with the actual pixel range as calculated by PracticeBuilder 1-2-3. Use this setting when
a particular modality’s images define a window range that is too large.

Auto W/L Range — Some images have noise at the extreme ends of the pixel distribution curve,
which can distort the calculated window width and center values. Use this setting to
eliminate the noise by defining how much of the pixel data to image include in the
automatic calculation of the pixel distribution.

5.5.3 IMAGE Zoom

PracticeBuilder 1-2-3 offers a variety of tools to magnify images. You can apply a predefined zoom factor
to the entire image, define a region of interest and zoom that area to fit the image frame, pop up a
magnifying glass window that magnifies the data behind it, dynamically magnify an image, and with some
image and monitor calibration tools, display the image in its actual size.

Within an image frame, the image appears with some magnification factor applied, or it is automatically
sized to fit inside the frame. Then fit to the image frame (fit-to-window mode, section 4.1.4), the entire
image appears, and the zoom factor is optionally displayed as overlay text (section 6.1.) All other display
modes apply a magnification factor. When magnified, some of the image may exist outside the image
frame. When in this state, PracticeBuilder 1-2-3 activates a panning function that allows you to move the
image around within the image frame to center a particular section of the image that may otherwise fall
outside the display region.

When you apply a magnification factor to an image, the thumbnail images, if displayed, show the
viewable region. The coinciding thumbnail image contains a dotted white line indicating the selected area
of interest.

To quickly return the image to its starting point, use the reset buttons in the Toolbox toolbar. There are
buttons to reset the image size to its original display mode (fit-to-window or original size), reset the image
position after panning, plus additional reset functions to return the image orientation and window/level
settings.

5.5.3.1 Applying Magnification

PracticeBuilder provides two different cursor modes to magnifying an image. Start by loading an image
thumbnail to an image frame, and then select the image frame. Activate general magnification mode by
clicking on the magnify cursor mode button, &. The cursor turns into a magnifying glass. When in this
cursor mode, there are two ways to zoom into an image. The first is to position the cursor over the center
point of the area you wish to magnify, and press and release the left mouse mutton. The behavior differs
depending on which buttons you hold down when you click the left mouse button, as follows:

None Increase magnification factor doubled

Shift Increase magnification factor quadrupled

Ctrl Decrease magnification factor by one half
Shift+Ctrl Decrease magnification factor by one quarter

The second way to use the magnification mode is to draw a region defining what potion of the image to
display in the image frame. After setting the cursor mode to magnify, position the cursor in the center of
the region you want to define, press and hold down the right mouse button, and drag the mouse. Dotted
lines appear to define the region of interest. When you release the mouse button, PracticeBuilder 1-2-3
fits the defined region in the image frame, applying whatever zoom factor is needed. Note that the Center
Region Zoom setting on the Customize Settings’ Settings page toggles between defining the region from
the center out, as described here, or from the top left corner of the area. For details, see section 4.1.1)

After you right or left click the mouse, the cursor mode returns to the Normal cursor mode. If you want to
keep the cursor in magnification mode, hold down the ALT key as you click the left mouse button.
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A dynamic zoom mode is available from the gauge on the Toolbox toolbar. When the toolbar is available,
select the image to magnify, and drag the gauge to increase or decrease the magnification factor.

The interpolation mode on the Customize Settings window’s Image page specifies the interpolation
algorithm used when the image is resized. There are various options for determining interpolation. The
Nearest Pixel (default) option uses a pixel replication algorithm to create new pixels. The Bilinear option
performs a first order interpolation using the bordering pixel values to replicate the missing pixels. While
bilinear interpolation results in a smoother image, there are more derived pixel values than there are
when using the nearest pixel algorithm.

To display the selected image frame on the entire monitor, press the F5 key, or click on the Tools menu,
select Zoom In/Out, and click on Full Screen. When in full screen mode, all of PracticeBuilder 1-2-3’s
toolbars, menus and other graphics disappear, and the entire monitor is used to display the selected
image frame. Many of the same tools that are available in the normal mode are also available in full
screen mode, including window/level, scrolling, and panning. To return from full screen mode, press the
ESC key, or click on the close button in the top left corner.

When a frame displays images in tile mode other than 1-up, you can quickly enlarge one particular image
to the frame size by double-clicking on the image. For example, if the frame is configured to show 2 rows
and three columns, and you want to look more closely at the fourth image of the six displayed, place the
cursor over the fourth image and double click. The image will appear a large as the frame will allow,
which is equivalent to displaying it in 1-up tile mode. To revert back to the NxM tile layout, double click
again.

5.5.3.2 Magic Glass

A magnifying glass tool exists for zooming in on images. The Magic Glass feature is a floating magnifying
glass that magnifies the image behind it. To activate the Magic Glass, select the Magic Glass entry in the
View menu, click on the Magic Glass cursor button, , from the toolbar, or type Alt-M on the keyboard. A
popup window appears in the main viewing workspace. Move the popup window over the image(s) by
dragging it with the mouse. The area under the image is magnified by the zoom factor defined on the
Customize Settings’ Setting page. Be aware that while the mouse button is pressed, PracticeBuilder 1-2-
3 uses a pixel replication algorithm for magnification. When you release the button, PracticeBuilder 1-2-3
applies the configured interpolation algorithm. Only image data is magnified. To clear the magnifying
glass, left-click anywhere outside of the zoom area.

You can resize the Magic Glass window that floats over the images can by dragging the edge of the
window. Move the mouse over the edge of the window until it changes to a bi-directional arrow. Click the
left mouse button and drag to resize the window. The window size can be up to 20% of the size of your
display resolution. Note that large Magic Glass windows may result in ghosting as you drag it around. [f
this is not acceptable, reduce the size of the Magic Glass window.

5.5.3.3 Actual Size Mode

The Actual Size Zoom mode is a setting that affects the way an image is rendered when not displayed in
fit-to-window mode. The Actual Size Zoom button, B, appears in the toolbox toolbar. When depressed,
the PracticeBuilder 1-2-3 renders the images in real-world size. When not depressed, PracticeBuilder 1-
2-3 renders the images in pixel size, matching an image pixel to a monitor pixel. You can toggle the
actual size zoom mode by clicking on the button in the toolbar, or selecting it from the Tools menu, under
the Zoom submenu.

In order for actual size zoom mode to work, both the monitor and the images in the study need to be
calibrated. When you first enable actual size zoom mode, PracticeBuilder 1-2-3 automatically prompts
you to confirm the monitor calibration. If the selected image does not already contain pixel size and
spacing information, PracticeBuilder 1-2-3 automatically prompts you to define it. See sections 5.5.6 and
4.5.1. Note that if you apply the image calibration settings to the entire study, you are not prompted for
this information again, at least not until you open another study.
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5.5.3.4 Image Panning

After magnifying an image, the part you are interested in may fall outside the image frame.
PracticeBuilder 1-2-3 provides a panning tool to let you reposition the image within the image frame. To
pan a magnified image, position the mouse cursor over the image and press and hold down left mouse
button. Then, drag the mouse to move the image to the desired location. When panning an image, the
cursor changes to the panning mode. Note that in order to pan images, the images must be displayed in
some mode other than fit-to-window.

Use the reset position button, ﬂ, in the Toolbox toolbar to reset an image position to the center. Use the
reset size button, &, in the same toolbar to reset the magnification mode.

5.5.4 FLIP AND ROTATE

PracticeBuilder 1-2-3’s transform functions let you flip an image horizontally or vertically, as well as rotate
it to the right or left. This function works on thumbnail images as well as images displayed in an image
frame. Click to select the image you want to flip or rotate, and then apply the respective function from the
Orientation toolbar, from the Transform item on the Tools menu, or using the shortcuts: Ctrl-H to flip
horizontally; Ctrl-U to flip vertically; Ctrl-L to rotate left; and Ctrl-R to rotate right.

To reset the image orientation, use the reset button, £, in the Toolbox toolbar.

5.5.5 IMAGE CROPPING

Cropping an image allows the user to mask out unwanted parts of an image. To define a crop area, load

the image into an image frame. Select the Crop mode button, @, in the Toolbox toolbar, or select Crop
from the Cursor item on the Tools menu at the top of the screen. Position the cursor over the top-left
corner or the area you want to keep, press and hold down the left mouse button, and drag the cursor to
define the cropped image. When you release the mouse button, PracticeBuilder 1-2-3 hides everything
except what is within the defined area. A dotted-line frame appears around the entire image.

To resize the area, move the cursor over the edge of the dotted-line frame until the cursor changes to a
bi-directional arrow. Click and drag the mouse to position the edge of the crop area. To resize the image

to fit the frame, click on the Fit to Window button, =%, in the Toolbox tool bar.

Remove the crop area by moving a thumbnail into the frame, or double-click on the image.

5.5.6 CALIBRATION

Some imaging modalities convey enough real-world pixel size and spacing information that Practice-
Builder 1-2-3 can automatically render images using the correct aspect ratios, calculate distances and
area measurements, and display objects at their actual size. For the imaging modalities that do not
provide this information, such as frame grabbed images and scanned film, the user can have
PracticeBuilder 1-2-3 generate the information by calibrating the image that appears on the screen.

When the pixel size and spacing information is available, whether supplied by the modality or entered by
the user, PracticeBuilder 1-2-3 still needs to have information about the monitor in order to render some
images properly. For this reason, the user has the ability to calibrate the monitor. While manual
calibration for images needs to be performed for each study, monitor calibration is only needed once for
each monitor. For safety reasons, the user is prompted to confirm the monitor calibration for each study.
Since PracticeBuilder 1-2-3 records the previous monitor calibration settings, if the monitor or display
resolution has not changed, then the user simply needs to confirm the setting. Section 4.5.1 contains
instructions for calibrating the viewer monitors.

To perform image calibration, select the Calibration item on the Settings menu, and select Image. The

image calibration wizard window appears showing the current pixel sizing information. If the Use DICOM
calibration data setting is selected and contains non-zero values, it means the image object already
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= contains enough information for PracticeBuilder to use.
The Apply To section of the window allows you to assign
the calibration information to an image, a series of images,
the entire study, or to all the images loaded into the
selected image frame. The default setting is usually the
best. If you need to override the default, click the option
you want to use for these parameters.

" Don'tcalibrate
" Use DICOM calibration data Horizontaly: 0 erticaly: 0 mm / pisel
& Use manual calbration data Horizontaly: [0.41EE088  erticaly: (04188028 mm / pivel

If the image does not contain DICOM calibration data, you
need to calibrate the image manually so PracticeBuilder 1-
2-3 can determine the spacing information it needs to assign real-world dimensions to the pixel data. To
manually calibrate the image, click on Add or Change Calibration Rulers. The viewer enters image
calibration mode, and displays the image and a new set of tools.

The calibration tools lets you x
draw one or more rulers on the =

image and then assign a length to
each one. Using this information,
PracticeBuilder calculates the
pixel sizes. When you first enter
calibration mode, a full-screen
window appears with an image
display. The cursor is now a ruler
cursor, similar to the linear
measurement annotation tool.
Click, drag and release the
mouse to place a ruler over the
image. When you release the
mouse, you will be prompted to
enter in a distance, in millimeters.
The objective is for you to draw
the ruler over an object in the
image for which you know the
distance. For example, place the
ruler over a measurement graph, or a lead ruler/marker, that appears in the image. You can pan and
zoom the image to get a more accurate result by clicking on the buttons in the top left corner of the
window. The more rulers you define at various angles, the more accurate the size calculations will be.
When finished, click Done. When back at the main calibration window, chose to apply this setting to the
present image, the series, the frame or the entire study, and then click on Finish.

5.5.7 MaAcIic X PoSITION LOCATORS

When a study contains multiple series in multiple orientations (axial, coronal and traversal), it is
sometimes necessary to display the same point in all three axes simultaneously. You can do this using

PracticeBuilder 1-2-3's Magic X function. Set the Magic X cursor mode by selecting the button, &, from
the Toolbox toolbar, or from the Cursor item in the Settings menu. Your cursor will change to a fat X.
Place the cursor over the point of interest on one of the images. Left-click on the mouse, and the slices in
the other frames that also contain this point are displayed. If you have localizer lines enabled on these
other images, you will see how the entire slice intersects the other images. After clicking on the image,
the cursor mode reverts back to the normal mode. If you wish to reposition the images again, you need
to reselect the Magic X cursor mode.

The Magic X cursor changes when the icon falls outside a defined distance from the intersecting image.
The purpose of this is to provide the user with a clear indication that the referenced image displayed
when using the Magic X tool (i.e., the closest intersecting image to the primary image) is far enough away
from the primary image that the intersection is really not relevant.
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The user can define the distance from the intersection used as an indication that it is out of range by
setting the Magic X Limit values on the Hash Marks page in the Customize Settings window. The first
field, Dimmed Magic X after N millimeters, causes PracticeBuilder 1-2-3 to dim the Magic X icon in the
referenced images once the active Magic X icon moves more than N mm away from the closest slice.
This happens most often when you reach the end of the series. The second field, Disable Magic X after
M millimeters, erases the Magic X icon in the referenced image once the active Magic X icon moves more
than M mm way from the closest slice.

5.5.8 MULTIPLANAR RECONSTRUCTION

PracticeBuilder 1-2-3 supports multiplanar reconstruction as a plug-in module. Refer to section 7.1 for
complete details on the MPR plug-in.

5.6 Closing a Study

PracticeBuilder 1-2-3 uses the action of closing a study to perform a few maintenance operations. First of
all, it verifies that the user saved their work. After saving the work, PracticeBuilder 1-2-3 updates the user
profile on the main server. As a final step, PracticeBuilder 1-2-3 sees if there is a bookmarked study that
needs to be reopened.

In the event the user recorded a dictation, created a report, attached key images, or changed the study
state, and did not save those changes, PracticeBuilder 1-2-3 notifies the user. The notice asks if the user
wishes to save his or her work. The prompt permits the user to update some of the information in the
notice window. When not possible, the user must return to the specific area and save the work. One of
the fields to update is the study state. The suggested state included in the prompt is configurable from
the Settings page in the Customize Settings window. See section 4.1.1.1 for details.

You can close a study from the File menu by selecting Close Study. This leaves PracticeBuilder 1-2-3
viewer running, although there are not open studies, and therefore most of the functions are disabled.
You can also close the study by terminating the PracticeBuilder 1-2-3 viewer. The last way to close a
study is to open a new study. If you return to the worklist or the study panel and select a new study,
PracticeBuilder 1-2-3 automatically closes the open session before loading the new one.

Note: If you want to add a new study to the studies already loaded, you must return to the worklist or study
panel, and add the new study to the group of studies you want to open, and select a batch open.

5.6.1 TERMINATING THE VIEWER

To terminate PracticeBuilder 1-2-3, select Quit from the File menu. In the active-X and standalone
viewers, the conventional Windows close button in the top right corner of the application performs the
same action as the Quit function.

In the dedicated workstation, closing the viewer results in the termination of PracticeBuilder 1-2-3 and
logs the user out of the workstation. In the active-X viewer, the Quit function returns the viewer to the
standby mode, if selected, or terminates the application entirely. If standby mode is active, you can
completely terminate the viewer after quitting PracticeBuilder 1-2-3 by right-clicking on the icon in the
system tray and selecting Exit.
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6 Overlays and Annotations

PracticeBuilder 1-2-3 supports overlays and image annotations. Overlays are lines of text containing
details about the patient, the acquisition procedure, the image and other information usually defined by
the imaging modality or information system. When displayed, overlays appear in the corners of each
image frame.

Annotations are text and graphics that usually reference some detail in the image, such as a linear
measurement or an arrow pointing to some anatomical structure. When displayed, annotations appear
on top of the image. See the example of text labels and a measurement annotation in the picture below.

Overlay
Text
Measurement
Annotation
Text
Annotation

The sections that follow give details on creating, displaying, hiding and saving overlays and annotations.

6.1 Overlays

Overlays consist of textual information identifying the patient, exam type, acquisition data, and image
characteristics. Overlays appear on the image in the corners of each image frame, centered along the
edge of the image (in the case of orientation markers), and directly over the image (in the case of hash
marks). Overlay configurations are specific to each user account, and for each modality type. By default,
overlays as displayed in each image frame, but you can hide them at any time using the function keys.

6.1.1 TEXT OVERLAYS

Text overlays contain information defined by the modality and encoded in the image object along with the
pixel data, plus some calculated values. To display the text overlays in the image frame, press the F10
button, or select Show Image Info from the View menu. To hide the text overlays, repeat the action.

The default user profile includes a general overlay configuration that is applied to all image types. You
can customize these settings to your own preferences from the Customize Settings window. Open the
window from the Settings menu, and go to the DICOM Fields page. Select the modality type whose
overlay configuration you want to modify, select the location on the image, and use the Add, Remove and
arrow buttons to insert, delete and move the identifiers to the preferred location. See section 4.1.7 for
additional details. Save your settings, and they appear on the image frame.

To set the font size for text overlays, return to the DICOM Fields page of the customize settings window.
The font size is configurable for each area of the image. Again, select the modality type and the location.
Set the font size in the Character Size field by deleting the current setting and entering in a new value, or
use the up/down arrows to the right of the text box to increase/decrease the font size. When you click on
OK, the changes will take place immediately.

6.1.2 ORIENTATION MARKERS

Orientation markers indicate the position of the imaged body. There are six orientation labels plus one
label to indicate an unknown value:
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A Anterior (or front)

F Foot

H Head

L Left side

P Posterior (or back)

R Right side

? Unknown

Orientation markers appear in the center of each side of the image. Generally, one marker appears on
each side. If the gantry was tilted during the acquisition, there is a chance the direction increases in
multiple directions. When this is the case, the orientation markers are multiple values, and are listed in
the dominant order. For example, an orientation marker of LH indicates the primary direction of the
vector leading off to that side of the image is toward the patient’s left side, but also progresses toward the
patient’'s head. Usually, when this appears, the mirror side of the image would contain the opposite
orientation markers. In this example, you would likely see RF on the other side of the image.

When the orientation marker contains multiple values, it is often beneficial to have a visual representation
of the image to understand the degree of tilt in the image. To assist in this visualization, PracticeBuilder
1-2-3 provides an overlay that shows how the image slice exists in the 3-dimensional space. It appears
as a cube along the lower edge of the image. The Alt-F11 key sequence toggles the display of this
orientation overlay. In the cases where the image is square to the patient, the overlay appears as one of
the letter labels encased in a square. However, if the image orientation is angled to any degree, the
overlay appears as a 3-dimensional box with the letter identifying each respective orientation.

PracticeBuilder 1-2-3 determines the orientation markers from information encoded in the image object.
When the image object does not provide enough information for PracticeBuilder 1-2-3 to accurately
determine this information, no orientation is provided. In this case, PracticeBuilder 1-2-3 displays
question marks (?) in place of the orientation marker.

To display the orientation markers, press the F11 key, or select Show Orientation from the View menu.
To hide the orientation markers, repeat the action.

6.1.3 LOCALIZERS LINES AND HASH MARKS

Localizers lines and hash marks are overlays the show the intersection of a referenced image on an
orthogonal view. When they appear, they reference the image or images in the selected frame. If you
select a different image frame, the localizer lines and hash marks on the images change to reflect the
intersection of the newly selected image. In most cases, localizer lines and hash marks appear on
orthogonal images.

Note that localizer lines and hash marks appear only when the images are defined by the modality to be
in the same frame of reference. If the modality does not explicitly define all the image objects this way,
PracticeBuilder 1-2-3 cannot identify the relationship between the images, and therefore it cannot show
where one intersects the other. You can verify two images are in the same frame of reference by opening
the Information Panel, and comparing the value Frame of Reference UID. If the attribute is missing or the
value is different, localizer lines and hash marks are not supported.

While localizer lines and hash marks refer to the same information, PracticeBuilder 1-2-3 makes a small
distinction between the two. In PracticeBuilder 1-2-3, localizer lines refer to a single line showing the
intersection of the referenced image on the other views. Hash marks are the collection of localizer lines
showing the intersection of all the images loaded into the referenced frame on the other views. When
displaying a localizer line, a single line appears. When displaying hash marks, multiple lines appear.

If an image is encoded by the modality as a localizer, PracticeBuilder 1-2-3 automatically displays
localizer lines and hash marks on it. For all other image types, you must instruct PracticeBuilder 1-2-3 to
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display them. If you want PracticeBuilder 1-2-3 to attempt to detect which images are localizers, go to the
Settings menu and select Localizers. Then click on Auto find localizers to mark it with a check. Repeat
the process to remove the check. When enabled (checked), PracticeBuilder tries to identify images that
are orthogonal to the other images in the series or study, and separates it out as a localizer. When
identified as a localizer, PracticeBuilder 1-2-3 automatically displays the localizers lines on it.

To show localizer lines, press the F12 button, or go to the Settings menu, select Localizers and then click
on Show localizer lines on all images. To hide localizer lines, press the F12 button again, or select Hide
localizer lines on all images from the same Settings menu. You can make this setting permanent from
the Hash Marks page in the Customize Settings window. Select the modality type, and put a check in the
box to show or hide the localizer lines.

To display hash marks, press the Alt-F12 key combination, or go to the Settings menu, select Localizers
and click on Show hash marks on all images. To hide hash marks, press the Alt-F12 key combination
again, or select Hide hash marks on all images from the same Settings menu. When hash marks are
displayed, one line is highlighted. This line indicates the intersection of the image currently displayed in
the reference frame. You can make this setting permanent from the Hash Marks page in the Customize
Settings window. Select the modality type, and put a check in the box to show or hide the hash marks.

Displaying localizer lines in tiles frames takes on some of the properties of displaying hash marks. If two
image frames, each with a multiple image series in two different orientations (e.g., axial and coronal) are
displayed in stack mode, and you enable each series to show localizer lines and select one of them, the
other shows the intersection of the selected one as it intersects it. If you change the tile mode from stack
mode to two by three tile mode, you will see six localizer lines displayed on the image still rendered in
stack mode. These six lines correspond to all six images displayed in the tile frame. As you scroll
through the tile frame, the six localizer lines change to reflect the six displayed images.

In the Customize Settings window, the Hash Marks page contains some configuration parameters that
affect localizer lines and hash marks. The hash mark spacing parameter defines the space between
hash marks. If the slice thickness is too small, PracticeBuilder 1-2-3’s hash marks may run together,
resulting in a solid block of color and completely obstructing the image. To make sure there is enough
space between the hash marks so the image underneath can be identified, use the hash mark spacing
field to define the minimum distance between hash marks.

The localization criteria parameter in the Hash Marks page defines the angle PracticeBuilder 1-2-3 uses
to determine whether or not two images are in the same plane or not. If the angle between the image
planes is greater than the value defined, the two planes are considered orthogonal, and a localizer line
appears.

Section 4.1.8 contains details for setting the hash mark spacing and localization criteria parameters.

6.2 Annotations

Annotations provide you with the ability to attach text and graphics to an image. The Annotation Toolbar
contains a series of eight buttons for working with annotations. The Annotation button, ﬂ puts you in
the annotation mode, providing you with the ability to create, move, modify and delete an annotation. The
available annotations are adding text strings, linear and angular measurements, area measurements
using circular and free-form regions of interest, Hounsfield units, a pointer graphic, key image numbering
and spine labels. When a specific annotation tool is selected, the cursor changes to identify it. Set the
specific annotation tool by selecting it from the annotation toolbar, or if already in annotation cursor mode,
spin the middle mouse button to advance through the available tools.

Most annotations consist of a graphic such as a line representing a rule for linear measurement, or a ring
representing the area defining a region of interest, a value such as the measured length, or a text string,
and an annotation index number. The index number starts at one (‘1’) for each image, and increments by
one for each annotation you add to an image. When displayed, these indices can be used as references
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to the annotations in the report, or when discussing the data during a collaboration session. The value
and index components float independently from the graphic. If one is obstructing part of the image, click
on the component with the left mouse button, and while holding the button down, drag it to another
location. To move all three at the same time, move the graphic component.

You can hide all the annotations using the F9 function key, or by selecting Show annotations from the
View menu. When hidden, the annotations still exist, but do not appear on top of the image. To display
the annotations again, repeat the sequence.

To set the font size of annotations, open the Customize Settings window from the Settings menu and go
to the Advanced page. The font size is specified in the field labeled Annotation font size. To change the
setting, delete the value and type in a new size, or use the up/down arrows to the right of the edit box to
increase/decrease the font size. When you click on OK, the changes get applied to all existing and future
annotations.

To modify or remove an existing annotation, click on the Annotation button to enter — p5o=i=
annotation mode, and then click to select the annotation you want to change. When —__
selected, you can drag the annotation around, or adjust its settings. Right click on the —_ "
annotation to pop up a menu (shown here) containing annotation commands. From this v shawindex
menu, you can remove the selected or all annotations, show or hide the annotation index ¥
number, numerical value such as the length or area or the tick marks in a linear ruler, or
change the font size or color.

Font size ...

Show tick marks

Cancel

6.2.1 TEXT ANNOTATIONS

Use the Add Text button, ﬂ to create or add text to an annotation that you want subsequent viewers to
see. Click on the image where you want to insert the text string. A window appears with a field for
entering the text string. This field is also pull-down list containing the previously entered annotation
strings. If you have entered the text string before, you can select it from this list. The feature supports an
auto-completion capability such that PracticeBuilder 1-2-3 automatically fills in the value once you have
entered enough for it to find a match. By default, the history file retains the last 20 values. Enter the text
and click on OK. To remove unwanted values from the history list, select the value from the text
annotation window and click on the Delete button.

6.2.2 MEASUREMENT ANNOTATIONS

PracticeBuilder 1-2-3 supports linear measurements, ﬂ angular measurements, Q and area
calculations on oval, g, and free-form, ﬂ, regions. Linear measurement values are displayed in
millimeters. Angles are displayed in degrees. Area values are in square millimeters. If the image object
does not contain pixel size and spacing information, PracticeBuilder 1-2-3 displays measurements in
pixels. To convert pixels to real-world dimensions, you must calibrate the image. (See section 5.5.6.)

To use the linear, angular and oval ROI measurement tools, select the respective annotation button and
left-click with the mouse on the image. While holding down the left mouse button, drag the cursor to
expand the measurement ruler or region. Release the mouse button to get the measurement value. You
can adjust the measurement graphic by clicking on one of the edges and dragging it to resize.

For the angle measurement, the initial application of the graphic defines only one leg of the angle graphic.
You will have to click and drag the second leg of the graphic to set the angle properly.

The free-form region of interest tool defines a geometric area that cannot be enclosed using the other
ROl tools. To define a space, click on the free-form ROI button. Move the cursor to a starting point on
the image and click the left mouse button. While holding down the left mouse button, drag the mouse to
define the region. When you release the mouse button, PracticeBuilder 1-2-3 automatically closes the
region by connecting the end point with the start point. PracticeBuilder 1-2-3 calculates the area within
the defined space and displays it on the image. To correct the region outline, move the mouse until it
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crosses over the point to want to move. The cursor changes to either a two-directional or four-directional
arrow. Click the left mouse button and drag the mouse to move the line. If you hold the Shift key while
dragging, the line will move in an arc. Without the Shift key, you will just move the point under the cursor.
When done, release the mouse button. PracticeBuilder 1-2-3 recalculates area inside the region.

The calibration tool uses the linear measurement annotation tool to define the ruler used to calibrate the
image. Linear measurements added during image calibration appear only when in calibration mode.

6.2.3 HOUNSFIELD UNIT ANNOTATIONS

The Hounsfield annotation tool creates a region of interest and calculated the average Hounsfield unit (or
the average pixel value if the pixels are not actually in Hounsfield units) within that region. To perform
this calculation, select the Hounsfield ROI button, @, click on the image, and drag the mouse to define
the region of interest. When you release the mouse, PracticeBuilder 1-2-3 calculates the average value
and displays it. To resize the region, click on one of the edges of the graphic, and drag it.

6.2.4 REPORT IMAGE NUMBERING

When attaching key images to a report, it is useful to label each image so you can reference them in the
report. With the text annotation tool, you can manually add a textual identifier to each key image before
attaching it to the report. With the Report Image Numbering annotation tool, PracticeBuilder 1-2-3 can
drop a sequential numeric label onto each image in the report, eliminating the need to explicitly type in a
text annotation. To use the report figure numbering tool, click the button, E, open the full-size report
panel, and click on a key image. The next number in the sequence appears where you clicked. To move
the numeric label, select the annotation and drag it to another location on the same key image. To delete
the annotation, right-click on the selected annotation and select Delete.

6.2.5 POINTER GRAPHIC ANNOTATION

The pointer graphic tool draws an arrow on the image. Select the pointer annotation button, ﬂ, and click
on the image. Drag the mouse to adjust the size of the pointer. You can rotate the graphic around its
head by clicking on the end of it and dragging it around.

The pointer graphic tool can contain a text string. The advantage of adding text to the pointer graphic
over using the text annotation tool is that PracticeBuilder 1-2-3 manages the two annotations as one.
Therefore, if you move or adjust the point graphic, the text automatically follows. To assign a text string
to a specific pointer annotation, first drop the pointer annotation onto an image. Hold the Ctrl key when
you click to place the pointer annotation on the image, and the text box automatically appears.
Alternatively, right-click on the pointer to display the popup menu and select Edit text. The text list
appears. Select a text string from the pull-down list, or type a new string into the text window. Click OK.

6.2.6 SPINE LABELING ANNOTATION

The spine-labeling tool is for labeling vertebrae and disk interspaces. The result is similar to adding text
annotations to an image of a spine, except the spine-labeling tool uses predefined labels, and displays
them in their corresponding location on images in all orthogonal planes.

Select the spine-labeling tool by clicking on the spine label annotation button, 3 . When active, a spine
labeling control panel appears, listing the predefined vertebral and disk interspaces. To apply a label,
select the starting point from the control panel, and then click on the image to place the label. The label
automatically advances to the next label after you place each one, so left-click again to drop the next
label. To automatically advance in the opposite direction, check the box labeled Reverse Direction in the
spine labeling tool window. Continue until you are done. To skip a label, change the next label in the
pull-down list in the popup window. To toggle between vertebral labels and disk interspace labels, press
and hold the Alt key while clicking on the mouse. For disk interspaces, and when you drag vertebrae
labels away from their default location, a line appears. To display the line after you are done labeling the
image, check the box labeled Show Lines in the spine labeling tool window.
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To customize the spine-labeling tool, use the Spine page in the Customize Settings window. You can set
the default starting point for both disks and interspaces, and select which one is enabled initially. You can
include or exclude L6, and define the default labeling direction. You can also modify a default label used,
and the spacing between vertebral bodies when placing the spine labels on orthogonal views. See
section 4.1.11 for details.

When placing the specified labels in the orthogonal images, PracticeBuilder 1-2-3 uses the label's focus
point. If the graphic intersects the image within the defined distance from the focus point, it appears in
intersecting plane. The spine labels appear in all orthogonal images automatically, as long as the images
belong to the same Frame of Reference, as defined by the original images modality. If the Frame of
Reference is not predefined, you will have to label each of the images individually. If the focus point falls
outside the distance specified, no label appears.

The center point of the annotation is identified by the little dot next to the label. This is the focus point,
referenced when identifying the point on other images. You can add or remove a line connecting the dot
to the label by dragging the text away from its default location. To make the lines persist after exiting the
annotation mode, select Show Line in the control panel. Move the label by selecting annotation cursor
mode, and dragging the label where it needs to go. To remove a single label, select annotation cursor
mode, right-click on the label to pop up the annotation menu, and select Delete Selected. Select Delete
All from the same menu to remove the spine labels and all other annotations. To remove all spine labels,
including all the labels in intersecting planes, and leave other annotations, click Reset on the spine label
popup window.
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7 Plug-in Modules

PracticeBuilder 1-2-3 uses plug-in modules to add packages that perform specific functions. Plug-in
modules are individually licensed. When you log in and open the PracticeBuilder 1-2-3 viewer, it checks
the server to see which plug-ins are licensed. The viewer then loads the licensed modules, which may
result in the addition or modification of menus, popup windows, and toolbars. The sections below provide
all the instructions on how to use a particular plug-in module.

7.1 Multiplanar Reconstruction Plug-in

PracticeBuilder 1-2-3 supports multiplanar reconstruction (MPR) as a plug-in module. The MPR plug-in is
available for the dedicated workstation, downloadable and standalone versions of the viewer. When the
viewer starts, it obtains the plug-in licenses from the server. If the viewer finds a valid license for the MPR
plug-in module, it automatically downloads and installs the plug-in on the workstation. If the MPR plug-in
was installed using one server and the user switches to a PracticeBuilder 1-2-3 server that does not
contain a valid MPR plug-in license, the viewer does not initiate the plug-in and MPR is unavailable.

Like the general PracticeBuilder 1-2-3 viewer, if a newer version of the plug-in is available, the viewer
downloads and installs the update automatically. Since a plug-in does not require a formal installation
process, Windows administrator privileges are not necessary to install or upgrade a plug-in.

MPR allows a user to create a completely artificial view of the available image data. For example, if an
axial series exists, and you wish to view the images in a coronal orientation, MPR can create the coronal
view. Additionally, you can use MPR to create a view at an oblique angle. The MPR module creates a
volume using the available data, and allows the user to select the plane

ings Tools Cine Cullahuratiun|Raconstruction Help

that cuts through the volume. The result is a series of images that the “mr =
user can view, save to the server, archive, and attach as a key image. i pec

Insert

Remave:

To create the MPR volume, load a series into the main viewer and
select Create from the Reconstruction menu that appears at on the top
of the PracticeBuilder 1-2-3 GUI. Use the series with the most slices to
obtain the best results.

Export setup

Shaows localizer lines

When you create an MPR frame, the volume is created and the image frame separates into four smaller
frames. Each frame contains a single
orthogonal view (sagittal, coronal, and
axial) plus an oblique angle view. The
oblique image frame is the results
window, and is represented by the purple
localizer in the coronal view. The other
three frames are control windows.

If the series is particularly large, creating
the volume may take a little time. A
progress bar appears to show you how
much additional time is needed to create
the data volume.

Using the color-coordinated localizers
(i.e., the color of the line matches the
color of the frame containing the image in
that plane), move and rotate the oblique
image. You can window and level the
image using the regular window/level

Oblique (generated) view /
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tools. The other tools are unavailable in an MPR image frame.

When you have the results you want, export the series to PB by double-clicking on

the oblique image, or selecting Insert from the Reconstruction menu. Once the = Humberofsices

series is exported back to the viewer, it is available from the thumbnail panel and & [

you can perform any available function on the image. From the Reconstruction . sumeesim
menu, the Export Setup item opens the exporting control panel. From this control —F
panel, you can define the number of slices to include when you export the = o i
regenerated series (default is 9 slices) and define the spacing you want to use ~ Soormssnosnd=s
between the slices (default is the same as the original series). To change the
default, uncheck the box, and enter the number in the respective field. Cance_| o]

 Adiust spacing to series

You can attach exported regenerated images as key images, and send exported regenerated images and
series to the server to be available to other users. Key images are automatically sent from the
workstation to the server. You can manually push any image back to the server using the Send Series
and Send Image items on the File menu. Images are returned to the PracticeBuilder 1-2-3 server via
HTTP. There is no additional configuration needed on the server to accept the transfer of images from
the viewer to the server.
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8 Reports

PracticeBuilder 1-2-3 includes reporting functions that enable a user to record a text or dictated report,
and to attach selected images to a report along with their presentation state. Reports from prior studies
are available for display from the viewer. A user also can create an addendum to a report.

Two report panels exist as described in section 3.6.3. The full report panel includes the patient and
procedure information, the report text, and the key images, amongst other details that make it useful for
reviewing information about prior studies. The compact version of the report panel is better suited for
dictating a report or addendum. The compact report panel contains some basic study identification
information plus controls for recording a voice clip. You can configure PracticeBuilder 1-2-3 to default to
one report panel or the other from the Customize Settings’ Settings window.

Since the report panel is customizable, yours may appear with more or less information than this manual
describes. The default report panel contains a report state (empty, preliminary or final), patient and
procedure information such as the patient name, date of exam and the order number, report information
such as the name of the radiologist who generated the report and the date, the report text, addendums,
key images, a number of buttons and the study status. The functions assigned to the various buttons on
the report panel are as follows:

°  Button Description
[ wmpaa | FRELIMINARY REPORT Compact/Full  Toggle between the compact report panel
e Py 7 and the full report panel.
e roune o et send Report  Submit the report to the PracticeBuilder 1-2-
Restore saved report T '. - . 3 Server_
e e i e Reload Report Erase all the changes and restore the
STATUS OBSERVATION original report.
P S Restore saved If you previously saved a report to your local
 Viewed report workstation (using the Save fo hard disk
£/Resd option in the Report menu), read it from disk
— and load it in this report panel.
 Tinal i Dictation/Listen Play back the dictation for this report
—— component. A Listen button exists for the
B main report and for each addendum.
E Status buttons Set the study status to the selected state. In

. . a Final report, only the last addendum has
2olx| Y———r 7 an active Status button section.

The following sections contains information on opening prior reports, creating text and recorded reports,
attaching key images, and submitting the changes to the PracticeBuilder 1-2-3 server.

8.1 Displaying Prior Reports

When PracticeBuilder 1-2-3 loads a study into the viewer, it includes the report if the server has a copy.
Reports for prior exams could come from one of many sources. A user can enter it directly from the
PracticeBuilder 1-2-3 viewer. The report could be transcribed into PracticeBuilder 1-2-3 from the report
editing web page. Reports created from third-party devices such as a Radiology Information System
(RIS) can be imported into PracticeBuilder 1-2-3 as well. Once the server has the report data, it makes it
available in the viewer’s report panel.

To display the prior report, open the full report panel by clicking the report button, €, from the toolbox
toolbar. If you have more than one study loaded into the viewer, the report panel displays that
corresponds to the selected image frame or thumbnail image. If no images are loaded into the main
viewing area and no image frame is selected, the report panel displays the report of the first study listed
in the thumbnail panel.
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8.2 Creating A Report

Before you can create a report in PracticeBuilder 1-2-3, you must possess reporting privileges. Creating
a report includes entering text or a recording, plus attaching a key image or even changing the study
state. If the report panel does not contain editable fields, you are not entitled to save change to the report
or key images to the PracticeBuilder 1-2-3 server. Speak with your system administrator if you need to
change the settings on your account.

When you want to create a report, start by selecting an image in the study. Click on an image frame or a
thumbnail image. This informs PracticeBuilder 1-2-3 which study you want to edit. To create the report,
open the report panel by clicking on the Report button, €, in the toolbox toolbar. If you press the Record
button on a Philips Speechmike, you will open the compact report panel.

A report can consist of the observation and impression, addendums, key images, and the voice
recordings. Only one of these components is needed to make up a report, although a report can consist
of all of them. Creating an observation, impression, addendum and a dictation are described in the
following sections. Attaching key images is described in section 8.3.

8.2.1 TEXT REPORTS

The fields available for entering a text report exist only on the full report panel. The default report format
consists of an observation section and an impression section. PracticeBuilder 1-2-3 does apply any
restrictions to the use of these fields other than they will remain separate, both in the viewer, and from the
PracticeBuilder 1-2-3 web page report. To enter text into either of these fields, click in the window and
type your report. While there is limited formatting capabilities available, white spaces such as spaces and
carriage returns, are preserved.

8.2.2 DICTATION

PracticeBuilder 1-2-3 records dictations in the viewer using any Windows compatible microphone and
sound card. Follow the manufacturer’s installation instructions for these components before attempting to
record a report in PracticeBuilder 1-2-3.

The recording controls are located in the Audio toolbar, which you can attach to the report panel by
selecting Audio Controls from the View menu in the report panel. The recording controls contain a
play/stop button, and record button and a delete button. There is also a progress gauge showing you
where in the current recording you are.

Start recording a dictation by selecting the Record button on the Audio Toolbar, or from the Audio menu.
When you are finished with the recording, click on the Stop button. Play back the dictation by rewinding it
to the beginning of the recording and pressing the Play button.

You can remove part of a recording by positioning the locator at the start of the unwanted section and
clicking on the Delete button in the Audio Toolbar. The entire recording from the present location to the
end will be deleted. PracticeBuilder does not support removing just a section in the middle of a recording.
Deleting removes everything to the end of the report. Modifying a middle section must be done through
inserting verbal instructions into the voice stream, indicating the start and end of the section to purge. Itis
not possible to delete any part if the report component (observation, impression or addendum) has been
approved and is in the Final state.

The PracticeBuilder 1-2-3 viewer supports tighter integration with the Philips SpeechMike than it does for
other microphones. No setup is necessary. Install the SpeechMike device according to its instructions,
and then restart the Viewer. When installed, you can use the SpeechMike for recording dictations. To
record, click on the Record button on the SpeechMike. The compact report window appears. To start
recording, press the Play button and speak. To stop recording, press the Play button again. To add
additional data, press the Play button to append the voice to the existing recording. If you select Rewind
or Fast Forward, you can reposition the starting point for recording more data.
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8.2.3 ADDENDUMS

You can correct or modify uneditable (Final) reports from the report panel by attaching an addendum to
the report. If a report or an addendum is unapproved, you can modify the report. When a study is in the
Final state, the approved text and dictation are not editable and a new addendum section appears at the
bottom of the report panel, after the original observation and impression text and other addendums, if
present. Enter the addendum as you would for the initial report. Click on the Record button to dictate an
addendum, or enter text into the editable text field on the full report panel to type an addendum.

To play back an addendum’s dictation, open the full report panel, scroll down to the addendum section,
and click on the Listen button.

8.2.4 RESTORING A REPORT

PracticeBuilder 1-2-3 provides two methods for restoring a report. The first method is to restore the report
with the version that is presently stored on the PracticeBuilder 1-2-3 server. Provided you have not saved
any changes, click on the Reload Report button in the full report panel. PracticeBuilder 1-2-3 retrieves
the last stored report from the server.

After creating a report, it is possible to encounter problems when you attempt to save it to the
PracticeBuilder 1-2-3 server. For example, while reading the study and creating a report, the network
between your workstation and the server may have gone away. Another example is when another user
forced PracticeBuilder 1-2-3 to remove the write permissions from your session, and your were not
notified. To save your work, you can make a temporary copy of the report on your local workstation’s
disk, and restore it at a later time so you can submit it to the PracticeBuilder 1-2-3 server. To save a
report to your workstation, select Save to hard disk from the report panel's Report menu. To restore it,
open the study from the worklist at a later time, open the full report panel, and click on Restore saved
report. The text, dictation, key images and study state you previously saved are loaded into the report
panel. You can now submit it to the server using Send report.

8.3 Key images

In PracticeBuilder 1-2-3, you save the presentation state of a rendered image by making it a key image
and attaching it to a report. Key images selected for a particular study are displayed in the full report
panel. To display the full report panel, select Report Panel from the View menu, or press the F8 function
key. The key images, rendered in their saved window/level settings and with the saved annotations,
appear at the bottom of the report.

PracticeBuilder 1-2-3 indicates an image has been marked as a key image by displaying a key image
icon in the top left corner of the image when it is displayed in an image frame. Clicking on the icon opens
the report panel and display the image attached to the report.

The viewer contains two key image icons: a paper clip and a key. A paper clip icon, i denotes that a
particular image is attached to the report and viewable on the report panel. The key icon, T, indicates
that the marked image is rendered using the same display characteristics (window/level, annotation, etc.)
as the image attached to the report. These icons allow the user to discriminate between multiple
instances of the same images attached to a report, each with a different set of parameters.

8.3.1 ATTACHING KEY IMAGES
To save the presentation state of an image in the main viewing area, select the image when the cursor is

in key image mode. To select the cursor mode, click on the key image button, E, in the toolbox toolbar.
The cursor changes to a paper clip. Position the cursor over the image you want to save, and click the
left mouse button. The key icon appears in the top left corner.

If you want to save the image as a key image again, make the necessary changes to the image — the key
image icon in the top left corner changes to a paper clip, indicating the image in the frame no longer
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appears like it does in the report panel — set the cursor to key image mode and click on the image again.
In the report panel, two images appear, each with their individual display characteristics.

To select multiple images without having to reset the cursor mode between each click, hold down the Alt
key while you click on mouse button. The cursor mode will remain in key image mode after each mouse
click.

Instruction Summary — Saving a Key Image
» Load an image into an image frame, and set the display characteristics (window, level,
annotation, etc.)

» Select the key image cursor mode button, ﬂ, from the toolbox toolbar.
» Click on the image.

In the full report panel, the number of key images attached to each report segment (main report and
each addendum) is listed in each segment’s header.

When attaching key images to a report, it is useful to label each image so you can reference them in the
report. With the text annotation tool, you can manually add an identifier to each key image before
attaching it to the report. With the report figure numbering annotation tool, PracticeBuilder 1-2-3 can
automatically drop a sequential numeric label onto each image in the report, eliminating the need to
explicitly type in a text annotation. To use the report figure numbering tool, see section 6.2.4.

8.3.2 MODIFYING KEY IMAGES

Images in the full report panel are editable, as if they were in an image frame. Open the full report panel,
select the image, and change the window or level, add an annotation, change the zoom factor, etc. When
modifying the image in the report panel, there is no need to reassign it as a key image.

Additionally, you can drag and drop the key image from the full report panel into any image frame to
manipulate its settings. Note that changed settings from an image frame do not get save unless you
reselect the image as a key image and resubmit the report. To drag an image, position the cursor over
the diagonal lines in the top left corner of the image until the cursor changes to a hand. Press and hold
down the left mouse button, and drag the image to its destination. When the cursor is over the
destination image frame, release the mouse button.

Once a report is approved, i.e., the study state becomes Final, the images attached to that report
segment cannot be modified. To make a change, you must add an additional key image reflecting the
updated settings.

8.3.3 REMOVING KEY IMAGES

To remove a key image, it must be display in an image frame in the main viewing workspace. The image
in the image frame must appear exactly as it does in the report panel as well. If the key image icon
appears as a key icon, T, then the image is ready for deleting. If this icon is not displayed on the image,
you must move it from the full report panel to an image frame. To do this, open the full report panel, and
find the key image you want to remove. Click on the diagonal lines in the top left corner of the image, and
drag it to an available image frame in the main viewing workspace.

To complete the remove process, put the cursor into key image mode by selecting the key image cursor

mode button, 0], Move the cursor over the image frame of the image you want to remove. The cursor
changes to a key with an ‘X’ through it. When in this mode, click on the image. You are prompted to
confirm the delete request. Click on Yes to remove the key image. You can also remove the key image
when in Normal cursor mode by placing the cursor over the key image icon in the top left corner of the
image. The cursor changes to a key with an ‘X’ through it. Click on the icon, the confirmation prompt
appears. Confirm the removal as before.
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Instruction Summary — Removing a Key Image

» Click on the report button, '| to open the full report panel.

» Scroll to the key images, and find the one you want to remove.

» Click on the top left corner of the key image and drag it to an image frame in the main
viewing workspace.

» Select the key image cursor mode, ),

» Click on the image.

» At the popup notice, confirm the removal by selecting Yes.

It is not possible to remove a key image attached to a report segment that has been approved and is in
the Final state.

Removing one key image has no affect on any other key image, or any other instance of the selected
image that may be saved as a key image. To remove multiple key images based on a single image, you
must remove them individually using the procedure defined above.

8.4 Submitting Reports

After you create any report component, including recording a dictation, adding text to the report
impression, attaching a key image, amending a report or just changing the report state, submit the report
by selecting the Send Report button on the report panel.

If you create a report and decide to continue working on the study before submitting it, you can close the
report panel at any time by clicking on the OK Button. When you close the study, PracticeBuilder 1-2-3
checks to see that you saved your work. If the report is not submitted, PracticeBuilder 1-2-3 prompts you
to send the report.

When you attempt to save a report, and the viewer encounters a network problem, you can save the
report on your local hard disk so you can submit it at a later time. From the full report panel, select the
Save to hard disk option from the Report menu. Be aware that this is not the equivalent to submitting the
report to the PracticeBuilder 1-2-3 server. It simply saves your work on your local machine so you can
come back to it at another time. When the network problems are resolved, open the same study.
PracticeBuilder 1-2-3 detects the saved report, and notifies you that you have a copy of a report on your
machine. From the notice, click on Yes to import the saved report. Everything you saved is not returned
to the viewer, and can be saved to the PracticeBuilder 1-2-3 server.
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9 User collaboration

When multiple users need to consult with each other while viewing a study, PracticeBuilder 1-2-3 allows
them to share a common instance of the Viewer. When a user initiates a collaboration session, his/her
viewer appears on the workstation of the invited participants, and the actions applied by any one of the
users is rendered on the other's workstation. There is dual-cursor support so that each user can see
what the other is doing, and what they are highlighting. When used in combination with a telephone, the
participants can communicate and review the same study as though they were sitting together at the
same workstation.

Collaboration requires that the other participant(s) have the PracticeBuilder 1-2-3 viewer installed on their
workstation and running in standby mode (see section 4.1.1), and are presently logged into the same
PracticeBuilder 1-2-3 server under his or her own account.

x| To establish a collaboration session, select the Connect option on
Enter session name: the Collaboration menu. A window appears, with a list of users

| connected to PracticeBuilder 1-2-3. At this point, there are two
options. If all the intended participants are directly accessible from
Create new session_ | the network by the server, meaning they are on the same local area
o _ network, or the network does not consist of NAT devices or other
Join existing session . . . . . . ..
—I redirection devices, the collaboration host can invite users to join. If
Ivite: user fram list | Disconnest | the server cannot reach one or more of the participants, the host
must explicitly create a collaboration session and the participants

59 [E¥ e ) U9 =T must individually join it.
Lois Laine

In the case were the server can address the workstation of each
participant, select the user you want to add to the collaboration
session and click on Invite User From List. The other user will
receive a prompt notifying him that you wish to establish a
collaboration session. If they accept the session, PracticeBuilder 1-
2-3 launches itself on the other user's workstation, and displays
what is presently displayed on your workstation.

In the case were the server cannot address the workstation, or when
the invite request fails with a message indicating the server could
not connect to the workstation, the host will have to create a session
and each user will have to join it. Start by having the host create a session name and click on Create
New Session. Then have each participant type in the same session name and click on Join existing
session. When everyone has joined the session, the workstation screens will contain the information
displayed on the host’s screen.

When the connection is accepted, you will see a second cursor appear on your workstation. The white
cursor is yours. The red cursor is the cursor on the other user’s workstation. As each of you moves your
cursor, the other will see it move on his own workstation. Any action you take to change the image
display, including window/level settings, scrolling, series selection, zooming, annotations, etc., will appear
on the other workstation. The collaboration session only affects the main viewing workspace. The popup
windows, including the report panel, settings windows, notices, layout manager, and print panel, are not
shared on other participant’s workstations.

At all times during a collaboration setting, one of the users is the master, meaning they have control of the
session. By default, the host is the master. For security purposes, none of the other users can obtain
control of the session without the master granting it to him. To request control, the other user simply
clicks their mouse on the workstation. A notice appears on the master's workstation indicating that the
other user requested control of the session. The master user can either turn over control to the other
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user, or deny the request. If control is passed over, then the original master must request it back using
the same technique.

When the session is over, either user can request to terminate the session by selecting the Disconnect
option from the Collaboration menu, or the user who established the session can close the viewer. Once
the session is terminated, the users resort back to the same access to the studies as they had prior to the
collaboration session.
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10 Saving data

The PracticeBuilder 1-2-3 viewer allows the user to save the image data to files on the local workstation
using a limited number of standard formats.

10.1 Saving JPEG images

Users can save a copy of an image or series of images to the local file system in a JPEG formatted file by
using the Save function. Under the File menu, select Save Image, which saves the selected image, or
Save Series, which saves all the images in the selected series to individual JPEG files. After requesting
one of these options, PracticeBuilder 1-2-3 pops up a window from which the user can select a
destination directory and a file name. If saving a series of images, PracticeBuilder 1-2-3 automatically
appends a numeric increment to the base file name and place one image in each file. The resulting file
contains the annotations, zoom factor, window/level setting, and all other display characteristics as they
appear on the screen.

A user can also copy the selected image into the system clipboard so the image can be pasted into
another application. Select the image and choose the Copy option from File menu. To paste the image,
open the other application and select the paste option as defined by that application.

10.2 Saving DICOM images

To save a copy of the original DICOM image, you must use the browser interface. The PracticeBuilder 1-
2-3 viewer cannot save DICOM objects. From the browser interface, you can create a DICOM-
conformant media by using the Export function, downloading the resulting ISO file to your workstation,
and then writing this to a CD or DVD using the CD/DVD writing software installed on your PC.
PracticeBuilder 1-2-3 does not provide an application to write the data to the CD/DVD media. Refer to
the PracticeBuilder 1-2-3 Operator’'s Manual for additional information.
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11 Printing

From the PracticeBuilder 1-2-3 viewer, you can print full-resolution images to DICOM conformant
imagers, or to ordinary printers supported by your Microsoft Windows operating system. The printing
procedure starts by selecting one or more images that are currently loaded into the PracticeBuilder 1-2-3
viewer, and arranging them in the print panel. For information on the print panel, see section 3.6.4 and
the section below.

You can print or hide the image overlays when you print images to either a Windows printer or a DICOM
printer. If the overlays are displayed on the screen when you request the print job, the resulting images
will display them as well. If the overlays do not appear on the images, they will not appear on the film or
paper. To display the overlays, select Show Image Information from the View menu, or hit the F10 key.

When printing images from the PracticeBuilder 1-2-3 viewer, if hash marks are displayed on the image,
they will appear on the printout.

If the user has defined a print header for Windows printouts, it also appears on DICOM printouts.

11.1 Print panel
To display the print panel, select Print =

from thfe File menu. If you have an & Windows © Dicom Drop image: Single ' Seres © Study © Prompt
image frame selected when the print : , = -
panel pops up, PracticeBuilder 1-2-3 e | [HONEOFE =] o] oo B 5
automatically loaded it into the print = Dok | [Seara | 5] Rows 2 Cancel |
the Drop Image setting. PracticeBuilder

1-2-3 either loads the selected image,

range. If no image frame or series is

selected, the print panel opens with no

panel. The number of images
v .y T p7
“ .'E I':“ Rty : h‘ L '
the entire series, the entire study, or s ' |
images automatically loaded.

PracticeBuilder 1-2-3 loads depends on
prompts the user to select an image _ ,

To load additional images into the print
panel, position the cursor over the
diagonal lines in top left corner of the
image in the image frame. The cursor
changes to a hand. While holding down
the left mouse button, drag the image
over the print panel and release the
mouse button. The images in the print
panel appear in a tile mode, meaning they are not stack. Use the scroll bar on the right of the window to
see all of the images.

To remove any or all images in the Print window, click to select the image and then click on the Delete
button. If you want to clear all the images, click on the Clear All button. It is not possible to delete more
than one image at a time with the exception of deleting all the images.

If you need to reorganize the images in the Print window, click on the image’s top left corner and drag it
from its current location and drop it into the destination position.

The remaining fields on the print panel are specific to the print device’s protocol. See the following
sections for additional information.
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11.2 DICOM Printing

When printing to a DICOM printer, select DICOM in the print panel. This enables all of the DICOM
printing options. The pull-down menu lists all of the available DICOM printers. Select the printer you
want to send the print job to, and the Layout. The Layout shows the number of columns and rows on a
printed sheet of film. The options are represented as column, row.

To review the default printer parameters as defined in the printer configuration file on the server, click on
the Settings button. In most cases, the default settings are defined to work with the selected printer and
changes should not be necessary. However, there are times when you may want to change a setting for
a single print job. Modifying the parameters from this window changes them for the current print job. If
you wish to make the change permanent, you must have the system administrator change the setting on
the server.

The DICOM print settings consist of three tabbed pages. The Film page contains the settings that apply
to the film itself. The Session page contains the settings that apply to the entire print job. The Others
page contains miscellaneous settings. Each of these settings is described in the table below.

Many of the settings contain an option to use the default. The default is a value defined in the DICOM
printer configuration file. This file is created by the systems administrator, and is available from the
Server page in the browser interface. The default settings are usually the best option. Only override the
default when you know how it will affect your results.

Page Setting Parameters Description
Film Film Orientation  Portrait, Landscape Specifies the orientation of the film. Default is usually portrait.
Trim Trim, No Trim Specifies whether the film sheet is to contain trim. The default
is usually no trim.
Decimate/Crop Request crop, Request Specified what happens to the image when it does not fit
behavior decimate, Request fail  within the defined boundaries of the image box.
Presentation LUT lllumination and Use these values to define the presentation LUT applied to
reflection values the images. Default is to set lllumination to 2000 and
Reflection to 10.
Session Film session Copies The number of copies to request.
options Destination If the DICOM printer supports multiple destinations, indicate
which one to request.
Priority Specify the print priority, if supported.
Owner Indicate the owner of the print job.
Annotation Annotation Submit this value to the printer to use as annotation. The
options application of this string depends on the printer.
Prepend date Prepend the date to the annotation added by the printer.
Prepend printer name  Prepend the printer name to the annotation added by the
printer.
Prepend illumination Prepend the illumination information to the annotation added
by the printer.
Medium type Blue film, Clear film, Specifies the type of medium to use in the print request. The
paper application of this value depends on the capabilities of the
printer.
Film session Print this value as a header to each sheet printed. By default,
label this contains the information specified in the print header
defined on the Customize Settings’ DICOM field page.
Others  Film size ID Printer specific Specify the default film size.

Magnification

Printer specific

Specify the default zoom factor applied. This is in addition to
any zoom factor already applied to the image when it is
loaded into the print panel.

Smoothing type

Printer specific

Specify the smoothing algorithm to use when interpolating the
data.
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Description

Border density

Printer specific

Specify the density of the border. Usually a value of BLACK
or WHITE is sufficient.

Resolution ID

Printer specific

Specify the resolution identifier.

Config info Printer specific Printer-specific configuration parameter to send to the printer.
Empty image Printer specific Optical density to use in areas where no image exists.
density

Max density Printer specific Maximum density to use when printing.

Min density Printer specific Minimum density to use when printing.

Image box Printer specific Override the default magnification for a specific image.
magnification

type

Image box Printer specific Override the default smoothing type for a specific image.

smoothing type

Image box config Printer specific Override the default printer-specific configuration parameter
info for a specific image.

The one notable print setting is the header used on the printed sheet. The default print header is defined
on the Customize Settings panel, under the DICOM Fields tab. You can change the default string by
editing it in the print panel. Whatever appears in this field will appear at the top of each sheet of film. In
order to appear on the film, the DICOM printer must support the Field Session Label feature.

After selecting the printer, the layout and confirming the printer settings, if necessary, click on Print to
initiate the print job. A popup window appears notifying you that the print request is in process.
Depending on the type of printer, a print request may take a long time. When the printer confirms it has
received all the information and can proceed with the print job, PracticeBuilder 1-2-3 pops up a notice
indicating the request is complete. If any errors occurred, an error message appears.

It is possible to obtain detailed information exchanged between the PracticeBuilder 1-2-3 viewer and the
printer during a DICOM print session. This is only necessary when some anomaly occurs, and the print
request failed. To enable print logging, open the Customize Settings window from the Settings menu,
and go to the Advanced page. Make certain the value in the Keep the last N DICOM print log files is
greater than zero. Print logs are stored in the c:\Program Files\PracticeBuilder\dicomprint\logs directory.
If print problems exist, a customer support representative may request these files.

11.3 Window Printing

When all the images you want to print are present in the Print window, select the number or rows and
columns you want to appear on the printed sheet. Note that the images displayed in the print panel do
not necessary conform to this setting. To preview the print results, click on the Preview button. In the
popup window, select the printer and click on OK. A new popup appears showing you what the results
should be on the selected Windows printer. You can either select to continue the print from this point, or
cancel out to return to the PracticeBuilder 1-2-3 print panel and click on Print to execute the print job.

11.4 Printing Reports

PracticeBuilder can print a copy of the report directly from the Viewer to a printer connected to your PC.
To print the report, open the full report panel. From the top of the report panel window, select Report and
then click on Print. Your standard print window will appear. Click on OK to send the report and the
attached key images to the printer.
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12 Online Help

PracticeBuilder 1-2-3 provides an online help system that provides assistance to users while they are
using the interface. The online help contains a searchable database containing information on many
topics and features, plus a summary of the latest features available in the viewer. From the online help,
you can also obtain details on the version of the PracticeBuilder 1-2-3 viewer you are running, which can
be requested if you need to contact support for assistance.

In the event the online help does not provide enough information on the requested topic, please consult
the written documentation.

To display the release news, select News from the Help menu. A window appears containing links to a
number of subjects, arranged in functional groups. To obtain details on any particular topic, click on the
link.

To display the complete help system, select Contents from the Help menu. A window appears consisting
of some tabbed pages. The Contents section is an organized collection of the help subjects. This
information is useful if you need to obtain an overview of some area of PracticeBuilder 1-2-3. For
information on a single topic, select the Index tab, and type the subject in the field provided. When you
find the specific, double click to open the detailed information on the topic. To get back to the Index,
select Help Topics from the details page.

To obtain details about the specific version of the PracticeBuilder 1-2-3 viewer installed on your
workstation, select About PracticeBuilder 1-2-3 from the Help menu. If asked by a customer support
representative which version of the PracticeBuilder 1-2-3 viewer you have installed on your machine,
provide the version number (and the build revision if specified) listed in the popup window.
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